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Copyrights and Trademark Notices
Copyright © 2013 Telestream, Inc. All rights reserved. No part of this publication may be 
reproduced, transmitted, transcribed, altered, or translated into any languages without 
the written permission of Telestream. Information and specifications in this document 
are subject to change without notice and do not represent a commitment on the part 
of Telestream.

Telestream, Vantage, Flip4Mac, FlipFactory, Episode, ScreenFlow, Wirecast, 
GraphicsFactory, MetaFlip, MotionResolve, and Split-and-Stitch are registered 
trademarks and Pipeline, Launch, and Videocue are trademarks of Telestream, Inc. All 
other trademarks are the property of their respective owners.

QuickTime, Mac OS X, and Safari are trademarks of Apple, Inc. Bonjour, the Bonjour 
logo, and the Bonjour symbol are trademarks of Apple, Inc.

MainConcept is a registered trademark of MainConcept LLC and MainConcept AG. 
Copyright 2004 MainConcept Multimedia Technologies.

Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008, Windows 7, 
Media Player, Media Encoder, .Net, Internet Explorer, SQL Server 2005, and Windows 
Media Technologies are trademarks of Microsoft Corporation.

This product is manufactured by Telestream under license from Avid to pending patent 
applications.

This product is manufactured by Telestream under license from VoiceAge Corporation.

Dolby and the double-D symbol are registered trademarks of Dolby Laboratories.

SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. Redistribution and 
use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
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WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Other brands, product names, and company names are trademarks of their respective 
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT 
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR 
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE 
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM 
MPEG LA, LLC, 6312 S. Fiddlers Green circle, Suite 400E, Greenwood Village, Colorado 
80111 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING 
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL 
AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE 
HTTP://WWW.MPEGLA.COM.
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MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL USE OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD 
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR 
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE 
FOR ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT 
AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR 
ENCODING IN CONNECTION WITH (i) DATA STORED OR REPLICATED IN PHYSICAL MEDIA 
WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) DATA WHICH IS PAID FOR ON 
A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR PERMANENT 
STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, Inc. (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of 
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment 
supplied but not manufactured by the Company but NOT including any third party 
equipment that has been substituted by the Distributor for such equipment (the 
“Hardware”), will be free from defects in materials and workmanship under normal 
operating conditions and use.

Software—If software is supplied as part of the product, the software will operate in 
substantial conformance with specifications set forth in its product user's guide. The 
Company does not warrant that the software will operate uninterrupted or error-free, 
will meet your requirements, or that software errors will be corrected.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new 
Hardware components or Software Media. Components may not be necessarily the 
same, but will be of equivalent operation and quality. 
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Software—If software is supplied as part of the product and it fails to substantially 
confirm to its specifications as stated in the product user's guide, the Company shall, at 
its own expense, use its best efforts to correct (with due allowance made for the nature 
and complexity of the problem) such defect, error or nonconformity. 

Software Updates
If software is supplied as part of the product, the Company will supply the registered 
purchaser/licensee with maintenance releases of the Company’s proprietary Software 
Version Release in manufacture at the time of license for a period of one year from the 
date of license or until such time as the Company issues a new Version Release of the 
Software, whichever first occurs. To clarify the difference between a Software Version 
Release and a maintenance release, a maintenance release generally corrects minor 
operational deficiencies (previously non-implemented features and software errors) 
contained in the Software, whereas a Software Version Release adds new features and 
functionality. The Company shall have no obligation to supply you with any new 
Software Version Release of Telestream software or third party software during the 
warranty period, other than maintenance releases.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, 
neglect, or shipping, or as a result of service or modification by a party other than the 
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral 
or written information or advice given by the Company, its distributors, dealers or 
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF 
TELESTREAM, INC. WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS 
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any 
Limited Warranty by the Company shall be the recovery of reasonable damages which, 
in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 
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Damages
TELESTREAM, INC. SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY 
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF 
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS 
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, Inc.
848 Gold Flat Road
Nevada City, CA 95959

You can call Telestream, Inc. via telephone at (530) 470-1300.

Part number: 99243



Vantage User’s Guide8



9

Contents
Vantage Media Processing Overview 19
Introduction to Vantage 19
Vantage Domain Configurations 21
Vantage Domain Components 21
Vantage Programs 23

Vantage Workflow Designer 24
Vantage Workflow Portal Client Application 25
Vantage Workflow Portal Web Application 26
Vantage Job Status Views 26
Vantage Management Console 26
Vantage Web Dashboard 26

Topics in this Guide 27

Vantage Program Management 29
Windows Client Program Management 29

Starting and Stopping Vantage Client Programs 30
Starting Vantage Workflow Designer 30
Starting Workflow Portal 30
Stopping Workflow Designer or Workflow Portal 31

Logging into or Changing Vantage Domains in Windows Client Programs 31
Selecting the Domain 32
Logging On 34
Creating a Category in Workflow Designer 35
Selecting a Configuration in Workflow Portal 35

Changing Vantage Users in Windows Client Programs 36
Changing Passwords in Windows Client Programs 37
Adding/Updating a License in Workflow Designer 37
Selecting A Configuration in Workflow Portal 38
Accessing Vantage Documentation from Workflow Designer 38

Using the Help Menu to Display Vantage Documentation 38
Displaying Context-Sensitive Help 39
Displaying Man Pages 39

Web Client Program Management 40



Contents10
Understanding Web App Browser Requirements 40
Starting & Stopping Vantage Web Apps 41

Starting Web Apps 41
Stopping Web Applications 42

Logging into or Changing Domains from Web Apps 42
Selecting the Domain 42
Logging On 45

Returning to the Vantage Web Apps Menu 46
Logging Out of a Vantage Domain 46
Changing Vantage Users in Web Apps 47
Changing Passwords in Web Apps 47
Displaying Version Information 48
Accessing Vantage Documentation from Web Apps 48

Understanding Path Specifications for Vantage Storage 49

Vantage Workflow Designer Tours 51
Tour 1: Creating and Configuring Workflows 52

Starting Vantage Workflow Designer and Logging In 52
Creating a Workflow Category 53
Creating a Workflow 54
Adding Actions to Your Workflow 55

Connecting Your Actions Together 57
Configuring the Watch Action 58
Configuring the Flip Action 61
Conclusion 63

Tour 2: Starting and Monitoring Workflows, and Viewing the Results 63
Activating a Workflow 63
Monitoring your Workflow Status 65
Playing Your New File 67
Deactivating a Workflow 68
Conclusion 68

Tour 3: Managing Workflows and the Workflow Design Space 69
Zooming In and Out on a Workflow 69
Moving the Workflow Around in the Design Space 69
Centering the Workflow 70
Conclusion 70

Tour 4: Transcoding Files Using Settings You Want 70
Duplicating Your Workflow 70
Adding a Branch to the Workflow 71
Moving Output Files to Custom Destinations 72
Changing a Flip Action 75
Conclusion 78

Tour 5: Using Binders, Nicknames, & Attachments 79
Nicknames 79
Adding a Delete Action 79
Attachment Files and the Associate Action 81
Conclusion 81
Vantage User’s Guide



Contents 11
Tour 6: Controlling Workflow Processing with Variables 82
Starting the Vantage Management Console 83
Creating Variables 83
Using the Priority Variable 84
Setting Variable Values in a Workflow 84
Conclusion 87

Tour 7: Decision Making in Workflows 88
Action States 88
The Decide Action 89
Processing New Files 89
Filtering Old Files 90
Conclusion 91

Tour 8: Analyzing and Modifying Media Files 92
Automatically Detecting and Cropping Curtains 92
Conclusion 93

Constructing and Configuring Workflows 95
Understanding Workflows 96

Workflow Basics 96
Typical Workflow Construction and Configuration Process 97

Using the Workflow Design Tab 98
Design Panel Overview 98
Specifying Workflow Details 99
Displaying Nicknames or Variables on Actions 100
Displaying Action Summary Information 102
Showing and Hiding Grid Lines 102
Moving the Workflow Around in the Design Space 102
Centering a Workflow 103
Zooming In and Out on a Workflow 103
Automatically Arranging Workflow Actions 104
Action Toolbar Display Options 104
Using Context Menus in the Workflows Pane 105
Controlling Workflow Status 105

Managing Workflow Categories 106
Creating a Workflow Category 106
Renaming a Workflow Category 107
Deleting a Workflow Category 107

Managing Workflows 107
Creating a Workflow 108
Renaming a Workflow 108
Deleting a Workflow 109
Moving Workflows Between Categories 109
Duplicating a Workflow 109
Exporting Workflows 109
Importing Workflows 110
Printing Workflows 110
Performing Batch Workflow Operations 110
Vantage User’s Guide



Contents12
Constructing Workflows 111
Adding Actions 111
Copying Actions 112
Deleting Actions 112
Controlling the Order of Execution 112
Removing Line Crossings 115
Re-ordering Actions 115

 Creating Action Templates 115
Configuring Actions 116

Using the Action Inspector 117
Changing Action Descriptions 118
Setting Conditional Task Execution 118
Understanding Variables 118
Adding Variables to an Action 119
Creating New Variables 120
Binding Settings to a Variable 121
Configuring an Action’s Run On Rules 123
Specifying Retry Rule Settings 124

Overriding Retry Rules 125
Modifying Resource Costs for Cost-Based Load Balancing 126
Using the Filename Pattern Editor 127
Action States 128
Implementing Logic and Conditional Execution in Workflows 129

Managing Vantage Folders 130
Vantage Workflow Actions 132

Agility Actions 132
Job Profile Action 133
Job XML Action 133
Process MMF Action 133

Analysis Actions 133
Examine Action 134
Compare Action 134
Identify Action 134

Catalog Actions 134
Register Action 134
Exist Action 134

Common Actions 134
Compute Action 135
Construct Action 135
Decide Action 135
Forward Action 136
Receive Action 136
Synchronize Action 136

Communicate Actions 136
Message Action 137
Notify Action 137

MediaMate Action 137
Metadata Actions 137
Vantage User’s Guide



Contents 13
Populate Action 137
Transform Action 137

Monitor Actions 138
Watch Action 138
Associate Action 138

Multiscreen Actions 138
Staging Actions 139

Archive Action 139
Gather Action 139

Transcode Actions 139
Transport Actions 139

Copy Action 139
Move Action 140
Delete Action 140
Deploy Action 140

Monitoring Jobs with Vantage Workflow Designer 141
Using the Monitor Status Tab 141
Using the Toolbar 142
Viewing Origin Action Details 142

Managing Jobs with Vantage Workflow Designer 145
Using the Job Status & Domain Job Status Tabs 145

Viewing the Detailed Action View 147
Using the Jobs Table 147
Using the Jobs Table Toolbar 147

Submitting Jobs Manually 148
Creating Job Reports 150

Creating a Job Report 151
Managing Job Report Formats 152

Displaying the Job Report Manager Dialog 152
Creating a New Job Report Format 153
Including and Excluding the Header Row 154
Choosing the Report Columns 154
Duplicating a Job Report 155
Deleting a Job Report 155

Viewing Binders 155
Pausing and Resuming Flip Actions 156
Pause for Priority in Flip Actions 157
Setting an Action’s Execution Priority 157
Viewing Action Status 157

Using Workflow Analytics 159
Understanding Workflow Analytics 159
Using the Workflow Analytics Panel 160
Vantage User’s Guide



Contents14
Using the Jobs Table Toolbar 161
Using the Jobs Table 161

Performing Bottleneck Analysis 161
Performing Execution Analysis 162

Using Workflow Portal 163
Vantage Workflow Portal Overview 164
Understanding Workflow Portal Configurations 166

Understanding Workflow-Based Configurations 166
Understanding Binders and Catalogs 166
Understanding the Copy Binder and Forward Binder Configurations 167
Understanding the Create EDL Configuration 168

Understanding the Browse Network Configuration 169
Workflow Design Guidelines 170

Ingest Workflow Guidelines 171
Target Workflow Guidelines 172

Starting a Workflow Portal Session 172
Starting a Session with the Windows Client 172
Starting a Session with the Web Client 173

Using Vantage Workflow Portal Controls 173
Using Workflow Portal Windows Client Controls 174

Controlling the Binder Display 175
Windows Client Menus 175

Using Vantage Workflow Web Client Controls 177
Web Client Menus 178

Managing Jobs with Workflow Portal 178
Opening Binders In Workflow Portal 179

Opening a Binder in the Windows Client 179
Opening a Binder in the Web Client 180

Reviewing Binder Assets 181
Reviewing Proxy Media Files 181
Reviewing Nonproxy Media 184
Reviewing Metadata Labels 184

Creating an EDL 185
Adding Clips to an EDL 186
Evaluating Clip Content 186
Editing the Clip Start and End Times 187
Deleting Clips from the EDL 187
Reordering Clips in the EDL 187

Submitting Media to Workflows 188
Initiating Binder Submission with the Windows Client 188
Initiating Binder Submission with the Web Client 189
Initiating Windows File Submission with the Windows Client 190
Configuring Metadata Labels 192
Configuring Variables 194

Changing or Reloading a Configuration 195
Deleting Binders from a Catalog 196
Vantage User’s Guide



Contents 15
Troubleshooting Workflow Portal 196

Using the Job Status Views Web Application 199
About the Job Status Views Web Application 199
Job Status Views Web Application Overview 200
Displaying and Hiding the Title Panel and View Panels 201
Using Public and Private Views 201

About Public and Private Views 201
About View Definitions 202

Displaying Items in Views 202
Controls in Views 203

Sorting Jobs by Column 203
Paging Through Job Tables & Setting Page Size 203
Filtering the Job Table 203

Setting the Job Name Filter 204
Specifying a Job Name Filter 204
Clearing the Job Name Filter 205

Setting the Job State Filter 205
Setting the Total Progress Filter 205

Specifying a Total Progress Filter 206
Clearing the Total Progress Filter 206

Setting the Date and Time Filters 206
Specifying a Date and Time Filter 206
Clearing a Date and Time Filter 207

Highlighting Job States Row by Row 207
Managing Jobs 207

Stopping Jobs 207
Restarting Jobs 208
Deleting Jobs 208

Troubleshooting 208

Glossary 211
Vantage User’s Guide



Contents16
Vantage User’s Guide



17
Preface
To obtain product information, technical support, or provide comments on this guide, 
contact us using our Web site, email, or phone number as listed in Table 1.

Table 1. Telestream Contact Information

Resource Contact Information

Vantage Technical 
Support

Web Site: http://www.telestream.net/telestream-
support/vantage/support.htm

Support Email. support@telestream.net

Terms and times of support services vary, per the terms of 
your current service contract with Telestream.

Vantage Information, 
Assistance, FAQs, 
Forums, & Upgrades

Web Site: http://www.telestream.net/telestream-
support/vantage/support.htm

Support Email. support@telestream.net

Telestream, Inc. Web Site: www.telestream.net

Sales and Marketing Email: info@telestream.net

Telestream, Inc. 
848 Gold Flat Road, Suite 1
Nevada City, CA USA 95959

International 
Distributor Support

Web Site: www.telestream.net

See the Telestream Web site for your regional authorized 
Telestream distributor.

Telestream Technical 
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving 
this document, or other Telestream documents—or if 
you've discovered an error or omission, please email us.

http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
http://www.telestream.net/telestream-support/vantage/support.htm
mailto:support@telestream.net
http://www.telestream.net
mailto:info@telestream.net
http://www.telestream.net
mailto:techwriter@telestream.net
mailto:support@telestream.net
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Vantage Media
Processing Overview
This guide is intended for those who use Vantage for transcoding and processing 
digital media. This involves creating, configuring, and executing workflows in Vantage.

Note: Features for which you do not have a license may be disabled, or work only in 
demo mode. Topics that require a license indicate that you need a license to use them.

The following topics introduce Vantage, and the Vantage programs that you’ll utilize in 
the course of processing your media in Vantage:

 Introduction to Vantage

 Vantage Domain Components

 Vantage Domain Configurations

 Vantage Programs

Introduction to Vantage
At the simplest level, Vantage is a collection of software programs that automate media 
workflows. A Vantage media workflow is a collection of actions, designed to process 
media files in a specific manner.

The actions you can utilize in a Vantage workflow are controlled by the Vantage 
product licenses you select. Table 2 lists some typical media processing objectives and 
the Vantage licenses that support those objectives.

Note: The license information in Table 2 is provided for reference only. For more 
information, see Vantage Licenses in the Vantage Domain Management Guide.
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With the proper product licenses, Vantage workflows can incorporate some or all of the 
objectives listed in Table 2, as well as other workflow design and management features, 
which include the following:

• Workflow visualization—Vantage offers a highly flexible process design interface, 
with visual components that help you see what the workflow will accomplish

• Notifications—Vantage can send emails or notify external systems when media is 
available

Table 2. Vantage Media Processing Objectives

Workflow Objective 
(Vantage License) Description

File-to-file transcoding 
(Vantage Transcode or 
Transcode Pro)

Transcoding workflows automate the process of 
converting a video file from one media format to another. 
Vantage can open most video files, regardless of the 
encoding and packaging format, and create one or more 
new video files using one or more selections from an 
extensive list of encoder and packaging formats.

To perform a simple transcode with Vantage, you create a 
workflow, which defines what you want to do and what 
the output format should be. (Vantage automatically 
detects the input format.)

Adaptive streaming 
encoding (Vantage 
Multiscreen)

Adaptive streaming workflows, when run on a Lightspeed 
Server, can automate multi-rate H.264 encoding and 
preparation of on-demand media for adaptive streaming 
playout on mobile devices. The Lightspeed Server 
accelerates this type of workflow, and Vantage also 
automates the packaging and delivery of media to 
Content Delivery Networks (CDNs) or HTTP origin servers.

Moving media between 
devices (Vantage 
Transcode Pro Connect)

Media transport workflows use Vantage native 
connections to move media between a wide variety of 
broadcast servers, edit systems, and other professional 
video devices. Using these integrations, Vantage can 
automate the process of receiving media into, or moving 
media between, different devices—ensuring the right file 
format at any of many possible destinations.

Media analysis and 
media-dependent 
processing (Vantage 
Analysis)

Media analysis workflows use Vantage features to analyze 
media, compare the results to configured values, and 
make decisions about how media should be routed or 
processed.

Third-party analysis, and 
media processing (Third-
party licenses)

Some workflows communicate with third-party products 
(such as MediaMate Screen and Aurora Digimetrics) to 
analyze or process media.
Vantage User’s Guide



Vantage Media Processing Overview
Vantage Domain Configurations

21
• Intelligent branching—Vantage workflows can be configured to evaluate variables, 
metadata, and the results of other workflow tasks, and select the appropriate work-
flow branch for further processing.

• Workflow monitoring and control—Vantage programs allow you to view the status 
of jobs that have been submitted to a workflow, and you can stop, cancel, or restart 
jobs.

• Operator control—Vantage provides tools for enabling operator management. 
Operators can submit files to workflows, view the results of workflow, and submit 
the results to yet another workflow. Operators can also view the status of workflow 
jobs and, if granted permission by a Vantage administrator, stop, cancel or restart 
jobs.

• Scalability and Redundancy—Vantage scales to thousands of jobs and dozens of 
servers in an enterprise environment.

Vantage also provides many system management features, allowing you to scale a 
Vantage system to many servers, manage user access, and optimize system 
performance and reliability. The system management features are described in topics 
throughout this guide.

Vantage Domain Configurations
While Vantage supports many different physical configurations, there are two primary 
domain configurations, the all-in-one domain and the distributed domain.

An all-in-one domain is a Vantage domain in which all the basic Vantage components 
shown in Figure 1 are installed on a single server. An all-in-one domain is simpler to 
install and manage, but it has performance limitations which are described in Before 
You Install.

A distributed domain (also referred to as a Vantage array) is one in which the basic 
Vantage components are distributed among multiple servers. For example, you might 
install the Vantage domain database on one server, and install all Vantage services on 
each of two additional servers. This three-server Vantage domain separates database 
processing from Vantage service processing, which increases processing capacity for 
both the Vantage domain database and the Vantage services. Having Vantage services 
on two servers also increases capacity and supports load-balancing, which leads to 
better throughput, and redundancy, which enables failover protection for the Vantage 
domain.

Vantage Domain Components
Vantage supports the installation of multiple Vantage domains within a business or 
other organization. A Vantage domain is a collection of Vantage software components 
that are linked together as a single Vantage installation. For example, you might install 
a Vantage domain for the Sports Department and another for the News Department. 
Each Vantage domain maintains its own database, and automates its own workflows, 
independently of other Vantage domains.
Vantage User’s Guide
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Figure 1. Simplified View of the Basic Vantage Domain Components

The work that you want Vantage to perform is defined in a workflow, which is created 
using the Vantage Workflow Designer program. The workflow is made up of individual 
tasks called actions, which specify what needs to be done with the input files. A typical 
workflow contains actions to do some or all of the following:

• Discover media that is ready for processing at an input storage location

• Analyze and transcode input media

• Store temporary media files in the Vantage store

• Deliver finished media files to an output storage location.

Many other actions are provided in the Vantage Workflow Designer. You can create and 
save many different workflows in a Vantage domain, and you can use them over and 
over with different files. Automation features allow you to initiate workflow processing 
whenever a new file appears in a hot folder. For more information on the available 
actions and workflow design, see the Constructing and Configuring Workflows.

Vantage workflows are stored in the Vantage domain database, which is the control 
center of a Vantage domain. All configuration for the domain is stored in the Vantage 
domain database, as are statistics and status information about the workflows 
processed by the domain. Vantage domain administrators configure Vantage using the 
Vantage Management Console.

Working with the Vantage domain database, Vantage services execute workflow 
actions in a Vantage domain. Each service executes specific action types. For example, 
the Transcode service executes the Flip workflow action, which transcodes an input 
media file. 

The input and output storage locations shown in Figure 1 are not Vantage components, 
although they can reside on Vantage servers. When Vantage workflows contain actions 
to access input files or publish output files, these actions must access available storage 
Vantage User’s Guide
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locations. These storage locations can be folders that reside on a network server or 
workstation, a Network-Attached Server (NAS), or a Storage Area Network (SAN).

The Vantage store is a storage location that stores temporary files that are created 
during workflow processing, and it can store output files. Typically, temporary files are 
deleted after a job expires or is deleted, however, Vantage controls allow you to change 
this to retain files for a period of time or indefinitely.

Vantage Programs
Vantage programs allow you to manage the components in the Vantage domain. 
Table 3 lists the Vantage programs according to the Vantage management area they 
serve and the type of program.

From a management point of view, each Vantage program can be classified as a 
workflow management program or a domain management program. Workflow 
management programs allow you to design workflows, evaluate and forward the 
results of a workflow, and track the status of workflows. Domain management 
programs allow you to configure the Vantage domain, view status and statistics for the 
domain, and control domain operation.

Each Vantage program can also be classified by application type, which is either as a 
client program or a Web application. Client programs run on Microsoft Windows 
servers and workstations. Web applications are hosted by a Microsoft Internet 
Information Services (IIS 7) server and can be accessed from any computer with a 
compatible browser and a network or Internet connection to the IIS 7 server hosting 
the Web applications.

Figure 2 illustrates how the additional Vantage programs not shown in Figure 1 fit into 
a Vantage domain.

Table 3. Vantage Programs

Management Area

Program Type

Client Applications Web Applications

Workflow Management Vantage Workflow Designer

Vantage Workflow Portal

Vantage Job Status Views

Vantage Workflow Portal

Domain Management Vantage Management Console Vantage Dashboard
Vantage User’s Guide
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Figure 2. Vantage Domain Showing All Vantage Programs

The following topics introduce each of the Vantage programs:

 Vantage Workflow Designer

 Vantage Workflow Portal Client Application

 Vantage Workflow Portal Web Application

 Vantage Job Status Views

 Vantage Management Console

 Vantage Web Dashboard

Vantage Workflow Designer
Vantage Workflow Designer enables you to design and automate workflows to meet 
your organization's transcoding and workflow automation requirements. With Vantage 
Workflow Designer, you can design workflows that do the following:

• Detect media files and related files that are ready for processing

• Evaluate the contents of source media files and set variables that describe those 
contents

• Create actions that choose different workflow branches based on variable values

• Generate email and system messages in response to workflow events
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• Incorporate related metadata content files or add metadata to the workflow or final 
output

• Transcode media files to other formats, including new package formats such as 
Apple HLS and Adobe HDS

• Save media output files and delete source files

• Combine any or all of the above features in hundreds of possible workflows.

A typical workflow design session requires that you pick the actions you want to take, 
configure the sequence and settings of those actions, and then activate the workflow. 
When you activate the workflow, the Vantage domain database and Vantage services 
work together to process any source material that is submitted to the workflow. Each 
time source material is submitted, a Vantage job is started. A job represents a single 
instance of a workflow. If 10 unrelated media files are submitted to a workflow, 10 jobs 
are started.

Vantage Workflow Designer also includes tools that allow you to monitor the status of 
workflows and jobs in the domain.

For more information on the Vantage workflow design, see Constructing and 
Configuring Workflows.

Vantage Workflow Portal Client Application
Vantage Workflow Portal allows workflow operators to manage jobs. Workflow 
designers create the workflows, and workflow operators use Vantage Workflow Portal 
to do some or all of the following:

• Submit media files to workflows

• Review media processed by workflows

• Attach metadata to media for workflow submission

• Stitch multiple files together

• View metadata labels generated by a workflow

• Make changes to metadata labels and variables in preparation for submission to a 
target workflow.

Vantage Workflow Portal cannot operate until it is installed on a Windows server or 
workstation and configured within Vantage using the Vantage Management Console. 
To view media in Vantage Workflow Portal, you must also create a workflow to 
preprocess the media. For information on configuring support for Vantage Workflow 
Portal, see Configuring Workflow Portal Operation.

For information on using the Vantage Workflow Portal, see Using Workflow Portal.
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Vantage Workflow Portal Web Application
The Vantage Workflow Portal Web application is a Web version of the Workflow Portal 
Windows program. For information on using the Vantage Workflow Portal Web 
application, see the Using Workflow Portal.

Vantage Job Status Views
Vantage Job Status Views is a Web application that provides Vantage operators and 
managers with job status information. Using the Vantage Management Console, 
Vantage administrators can configure custom views, which define what information an 
operator sees when opening a view. When there is a large volume of jobs or when 
security policies dictate, you might want to create custom views for individual 
operators or departments.

For information on using the Vantage Job Status Views, see the Using the Job Status 
Views Web Application.

Vantage Management Console
The Vantage Management Console enables you to configure and manage a Vantage 
domain. The following is a partial list of Vantage features that you can control with 
Vantage Management Console:

• Vantage stores

• Vantage users

• Vantage licenses

• Load balancing

• Vantage services

• Import and export of Vantage configuration components, such as workflows

• Vantage Job Status Views

• Vantage Workflow Portal

• Vantage domain database backup and restore.

Vantage Management Console also allows you to view some domain status 
information.

Vantage Web Dashboard
Vantage Dashboard is designed to help domain administrators track the status and 
system health for the entire Vantage domain, as opposed to other tools which enable 
management of domain components.

The Vantage Dashboard pages are designed to help you quickly assess the health of the 
domain and progressively dig into deeper detail as needed. For example, the Summary 
Status page allows you to quickly see the workflow completion success rate and the 
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error rate on domain servers. The information on the Summary Status page can help 
you determine if it is more appropriate to look for problems in a workflow or in a 
particular server.

Other Vantage Dashboard pages allow you to view the status of servers, services, and 
jobs. When troubleshooting, it can be very helpful to determine if problems are system 
wide or confined to a server, a service, or a particular workflow. Vantage Dashboard 
provides the Web pages that allow you to quickly assess your domain from any Web 
client that has connectivity to your domain.

For information on using Vantage Dashboard, see Monitoring the Domain with 
Vantage Dashboard in the Vantage Domain Management Guide.

Topics in this Guide
The major topics in this guide include:

• The Vantage Workflow Designer Tours topic provides several tours, which are 
designed to help you understand how to create, configure, and manage workflows 
in Vantage Workflow Designer. You’ll also learn how to submit media to workflows 
for processing. As you take these tours, you’ll also become familiar with important 
Vantage concepts and how you can use them to design workflows to meet your 
processing requirements. As you gain hands-on experience creating workflows and 
processing media in Vantage—which leads to a working knowledge of Vantage 
and its components and architecture—you’ll gain proficiency in using Vantage to 
solve your organization’s media processing problems.

• The Constructing and Configuring Workflows topic discusses how to design, con-
struct and configure workflows to perform specific media tasks in your organiza-
tion. Vantage Workflow Designer is the primary client program in Vantage and 
combines a wide range of workflow design and media processing capabilities into 
a single program, enabling you to create workflows to solve a broad set of opera-
tional media processing problems.

• The Monitoring Jobs with Vantage Workflow Designer topic discusses how to man-
age monitors. Monitors are processes executed by a Vantage Monitor service to 
continually poll specified directories for new media to process, and automatically 
submit jobs to their workflow.

• The Managing Jobs with Vantage Workflow Designer topic discusses how to monitor 
and manage jobs in Vantage. For each new media file submitted to Vantage for pro-
cessing, a job is created.

• The Using Workflow Analytics topic discusses how to analyze workflows and job his-
tory to identify problems and improve overall system performance.

• The Using Workflow Portal topic discusses how to use Workflow Portal for browsing 
video media assets, entering metadata, creating Edit Decision Lists (EDLs), and pro-
cessing media via pre-defined workflows. Workflow Portal is an optional, licensed 
feature in Vantage.
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• The Using the Job Status Views Web Application topic discusses how to use Job Sta-
tus Views to access ob information and manage jobs in your Vantage domain from 
anywhere on the LAN, or via the Internet when you establish a VPN connection.

• The Glossary topic defines terms used in Vantage product documentation.
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Vantage Program
Management

Vantage user programs are organized as follows:

• Vantage Windows client programs

– Vantage Workflow Designer

– Vantage Workflow Portal

• Vantage Web applications

– Vantage Workflow Portal

– Vantage Job Status Views

The following topics provide procedures to help you start using Vantage user 
programs:

 Windows Client Program Management

 Web Client Program Management

 Understanding Path Specifications for Vantage Storage

Note: When using Vantage Workflow Designer on Windows Server 2008, you might 
have problems minimizing windows you’ve maximized by dragging them to the top 
of your monitor. To disable the Windows AeroSnap feature, open the Control Panel > 
Ease of Access Center > Change how your mouse works and check Prevent windows 
from being automatically arranged when moved to the edge of the monitor.

In addition, for Workflow Designer to display as designed, the Windows theme on 
Server 2008 R2 should be set to Windows 7 Basic. This theme is only available when 
Desktop Experience is installed. If Remote Desktop Connection is used to connect to 
the server, then the Remote Desktop Services > Remote Desktop Session Host > 
Desktop Composition role feature must be installed in order for the Windows 7 Basic 
theme to be available.

Windows Client Program Management
The following topics describe Windows client management tasks:

 Starting and Stopping Vantage Client Programs

 Logging into or Changing Vantage Domains in Windows Client Programs
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 Changing Vantage Users in Windows Client Programs

 Changing Passwords in Windows Client Programs

 Adding/Updating a License in Workflow Designer

 Selecting A Configuration in Workflow Portal

 Accessing Vantage Documentation from Workflow Designer

Starting and Stopping Vantage Client Programs
Vantage Workflow Designer and Vantage Workflow Portal connect directly to the 
Vantage domain database, and can only be used on a computer that has access to the 
database.

You start and stop Vantage Windows programs like most other Windows programs. 
After starting Vantage Workflow Designer or Vantage Workflow Portal, you’ll select and 
log into a Vantage domain so you can begin work.

 Starting Vantage Workflow Designer

 Starting Workflow Portal

 Stopping Workflow Designer or Workflow Portal

Starting Vantage Workflow Designer
To start Vantage Workflow Designer, use one of these methods:

• Select start > Programs > Telestream > Vantage > Vantage Workflow Designer

• Double-click the Vantage Workflow Designer shortcut on your desktop.

Figure 3. Vantage Workflow Designer Shortcut

Note: If you are launching Workflow Designer for the first time, you may be prompted 
to select and log into a Vantage domain. See Logging into or Changing Vantage 
Domains in Windows Client Programs for details.

Starting Workflow Portal
Vantage Workflow Portal is an optional, licensed Vantage client program. When you 
start Workflow Portal, if no license is available, it advises you, and operates in demo 
mode. When operating in demo mode, you cannot submit jobs or edit metadata labels.

You can run multiple instances of Workflow Portal on one computer (and one license), 
so that you can use multiple configurations at the same time. For example, you may be 
reviewing and submitting assets in one, and setting trim points in another. 
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User authentication is used to control user access to Workflow Portal configurations. 
Administrators can choose which Vantage users can utilize a specific configuration. 
Administrators can also make certain configurations available to everyone. User 
authentication is available with the Team Management, Enterprise Control and Master 
Control licenses.

To start Vantage Workflow Portal, do one of the following:

• Select start > Programs > Telestream > Vantage > Vantage Workflow Portal

• Double-click the Vantage Workflow Portal shortcut on your desktop.

Note: If you encounter an error when launching the Workflow Portal, please see 
Troubleshooting Workflow Portal for assistance.

Figure 4. Vantage Workflow Portal Desktop Shortcut

Note: If you are launching Workflow Portal for the first time, you’ll be prompted to 
select and log into a Vantage domain and choose a Workflow Portal configuration. See 
Logging into or Changing Vantage Domains in Windows Client Programs for details.

Stopping Workflow Designer or Workflow Portal
To stop Vantage Workflow Designer or Vantage Workflow Portal, select File > Exit 
(Control+Q). You do not need to save work you have performed, because all 
information is stored in the Vantage domain database, and updated automatically as 
you make changes.

Logging into or Changing Vantage Domains in Windows 
Client Programs

Note: This topic applies to both of Vantage’s Windows client programs—Vantage 
Workflow Designer and Vantage Workflow Portal.

Vantage provides many features that can be managed by your Vantage domain 
administrator. After you start Vantage Workflow Designer or Vantage Workflow Portal, 
you may need to complete additional tasks before you can begin working. If additional 
tasks are required, Vantage will prompt you to complete those tasks, which are 
described in the following topics:

 Selecting the Domain

 Logging On
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 Creating a Category in Workflow Designer

 Selecting a Configuration in Workflow Portal

Selecting the Domain
Vantage supports multiple Vantage domains. A Vantage domain is a separate Vantage 
system. Your company might create separate Vantage domains for different 
departments or geographical locations. As a Vantage user, you might need to select a 
domain for the following reasons:

• You are starting Vantage Workflow Designer or Vantage Workflow Portal for the first 
time on a given computer.

• Your work requires that you connect to different Vantage domains.

After you select a Vantage domain in Workflow Designer or Workflow Portal, the 
program remembers the last domain used and connects automatically to that domain 
each time you restart the program. You can change the selected domain at any time.

To select a domain, do the following:

1. If the program has already started and you want to change Vantage domains, select 
File > Change Vantage Domain (in Workflow Designer, you can also right-click in 
the workflows panel away from any buttons).

The program displays the Select Vantage Domain panel.

Figure 5. Select Vantage Domain Dialog

2. To select a listed domain, select a domain in the domain list, and click OK.

When you change domains, your Web application closes its connection to the cur-
rent domain and connects to the selected domain.

If your domain is not listed, or your connection attempt is unsuccessful, contact your 
Vantage domain administrator and refer to the following topics:

 Connecting to an Unlisted Domain

 Connecting with Custom Login Settings

Vantage 
domain list
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Connecting to an Unlisted Domain

If the domain you want to connect to is not in the list, click My Vantage Domain isn’t 
Listed.

Figure 6. Select Vantage Domain Panel

The program displays a dialog in which you can specify the domain using a computer 
name, host name, or IP address.

Figure 7. Dialog to Select an Unlisted Domain

Enter the Vantage server name (for example, VantageServer203) or IP address and click 
OK to connect. If you do not know what to enter, contact your Vantage domain 
administrator.

If domain connection is not successful or if your administrator provided custom 
settings to configure, see Connecting with Custom Login Settings.

If domain connection is successful and you are prompted to enter a user name and 
password, see Logging On.
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Connecting with Custom Login Settings

If the Vantage domain is using a SQL database where the default settings for the MS 
SQL server account were changed during installation, open Connection Settings to 
display the SQL Server login and password settings.

Figure 8. Select Vantage Domain Panel

The program displays the SQL Server login and password settings.

Figure 9. Changing SQL Server Login Settings

Enter the Vantage database SQL server account username and password (obtained 
from your Vantage administrator), and click OK to connect.

Logging On

If you are accessing a Vantage domain with a Team Management license and User 
Administration is enabled, you need to provide your Vantage user information to log in. 
(The default Vantage username is Administrator, with no password assigned).

Note: If you do not have a Vantage user name, ask your Vantage administrator to 
create one for you.

Click Connection Settings.

Enter the login name and 
password for the SQL 
database and click OK to 
connect.
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If Vantage log in is required, the Vantage Domain Login dialog displays.

Figure 10. Vantage Domain Login Dialog

Enter your Vantage user name, and password if required, and click OK to connect.

Creating a Category in Workflow Designer
The first person that logs in to a Vantage domain via Vantage Workflow Designer—or, 
when Team Management is licensed and User Administration is enabled, the first time 
you log in to your account—you are prompted to create a new workflow category in 
which to store workflows.

When you log in, the only categories that display are those that your Vantage user 
name is authorized to access. (If your user name has administrative privileges, all 
workflows in the domain are displayed.) Access to workflow categories by user is 
controlled in the Vantage Management Console.

If you are prompted to create a new category, click OK to display the Create New 
Category dialog.

Figure 11. Create New Category Dialog

Enter the name for this category, and click OK. 

Selecting a Configuration in Workflow Portal
If a Workflow Portal configuration has been previously selected, it is used automatically. 
Otherwise the Select Configuration window displays, enabling you to select a 
configuration to use during this session. 

Note: The configurations that Workflow Portal displays are public configurations plus 
those that your Vantage user account is authorized to use. User access to Workflow 
Portal configurations is controlled by the Vantage domain administrator.
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Figure 12. Select Configuration Dialog

Select a configuration from the list and click OK.

Changing Vantage Users in Windows Client Programs

Note: This topic applies to both Vantage client programs—Vantage Workflow 
Designer and Vantage Workflow Portal.

When you are logged in to a Vantage domain that has a Team Management (or higher 
level) license and User Administration is enabled, you can change to another Vantage 
user name. 

Select File > Change Vantage User to display the Vantage Domain Login dialog.

Figure 13. Vantage Domain Login Dialog

Enter the Vantage user name, and password if required, and click OK to log in with the 
new Vantage user name.
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Changing Passwords in Windows Client Programs

Note: This topic applies to both Vantage client programs—Vantage Workflow 
Designer and Vantage Workflow Portal.

When you are logged in to a Vantage domain that has a Team Management (or higher 
level) license and User Administration is enabled, you can change the password of 
Vantage user name currently logged in.

Select File > Change Password to display the Set Password window.

Figure 14. Set Password

Enter your new Vantage password, confirm the password, and click OK to update the 
password for this user.

The next time you log in to the Vantage domain with this user, you’ll need to use your 
new password.

Adding/Updating a License in Workflow Designer
To add a license to your Vantage domain in Vantage Workflow Designer, follow these 
steps.

1. Select File > Add/Update License. 

Vantage Workflow Designer displays a File System dialog. 

2. Navigate to and select the license XML file.

3. Click Add.

You can also manage licenses in the Vantage Management Console. For more 
information, see the Vantage Domain Management Guide.
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Selecting A Configuration in Workflow Portal
To select another configuration when you need to perform other tasks in the same 
domain, follow these steps:

1. Select File > Change Application Configuration.

Workflow Portal displays a list of configurations for this domain.

Figure 15. List of Workflow Portal Configurations

2. Select the configuration you want to use, and click OK.

Workflow Portal opens the configuration, and displays the appropriate user interface 
for this configuration.

Accessing Vantage Documentation from Workflow Designer
The following topics describe how to access Vantage documentation while using 
Vantage Workflow Designer:

 Using the Help Menu to Display Vantage Documentation

 Displaying Context-Sensitive Help

 Displaying Man Pages

Using the Help Menu to Display Vantage Documentation
There are multiple ways to access the Vantage User’s Guide in Vantage Workflow 
Designer:

• Select Help > Getting Started to display the Tours topic in the Vantage User’s Guide. 
The tours introduce you to Vantage Workflow Designer and describe how to create 
and configure workflows, submit jobs, and monitor jobs.

• Select Help > Contents to display the Vantage User’s Guide table of contents.

• Select Help > Index to display the Vantage User’s Guide index.

• Select Help > Search to display the Vantage User’s Guide search tab, where you can 
enter search criteria to locate topics you want to read.
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• If you have access to the Internet, select Help > Online Help to display the Vantage 
Online Help section of the Telestream Web site, where you can access all Vantage 
documentation.

Displaying Context-Sensitive Help
In Vantage Workflow Designer, you can click the help button  (see Figure 16) to 
display the user guide topic that relates to the active program feature or controls. 

Figure 16. Workflow Design Tab, Showing Help Button

If the topic is not available, you can search the entire User’s Guide for information.

Displaying Man Pages
In Vantage Workflow Designer, man pages are a special kind of context-sensitive help 
that typically provide detailed information for action configuration options. This 
information is more detailed than that provided in this guide.

To open the man page for an action configuration dialog, click the  button.

Help 
button
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Figure 17. Watch Action Inspector Dialog, Showing Man Page Button

When the man page window is open as you proceed through a series of inspector 
panels, the man page changes as you display each panel.

Web Client Program Management
The following topics describe Web application management tasks:

 Understanding Web App Browser Requirements

 Starting & Stopping Vantage Web Apps

 Logging into or Changing Domains from Web Apps

 Returning to the Vantage Web Apps Menu

 Logging Out of a Vantage Domain

 Changing Vantage Users in Web Apps

 Changing Passwords in Web Apps

 Displaying Version Information

 Accessing Vantage Documentation from Web Apps

Understanding Web App Browser Requirements
Vantage Web applications are implemented for execution in Microsoft IIS. JavaScript 
and cookies must be enabled to use Vantage Web applications.

Telestream recommends the following Web browsers for use with Vantage Web 
applications: 

• Internet Explorer 9 64-bit (Windows only)

• Internet Explorer 9 32-bit (Windows only)

• Current version of Chrome (Mac OS X & Windows)

• Current version of Firefox (Mac OS X & Windows)

• Safari 5 (Mac OS X only). You cannot use Safari with Silverlight on operating systems 
other than Mac OS X.

Man 
page 
button
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Note: To use Vantage Dashboard with Internet Explorer 9, you must configure 
Internet Explorer as described below.

To configure Internet Explorer for use with Vantage Web applications, do the following:

• Enable Active Scripting—Open Internet Explorer, select Tools > Internet options, 
select the Security tab, click Custom level, scroll down to Scripting, click Enable 
under Active scripting, click OK, and click OK to close the Internet Options dialog.

• Disable Compatibility View—Open Internet Explorer, select Tools > Compatibility 
View and uncheck Display intranet sites in Compatibility View and Display all Web 
sites in Compatibility View, then click Close.

• If you are using Internet Explorer on a Windows Server operating system that does 
not include the IIS Web host, disable Enhanced Security Configuration (ESC) using 
the Windows Server Manager.

• If you are using Internet Explorer on a Windows Server operating system that does 
include the IIS Web host, disable Enhanced Security Configuration (ESC) using the 
Windows Server Manager, or use localhost instead of the domain name or IP 
address (http://localhost/Vantage/Portal/ConfigSelect.aspx).

Starting & Stopping Vantage Web Apps

Note: Workflow Portal is an optional, licensed program in Vantage. When you start 
Workflow Portal, if no license is available, it advises you, and operates in demo mode. 
When operating in demo mode, you cannot submit jobs or edit metadata labels.
You can run multiple instances of Workflow Portal on a single computer, so that you 
can use more than one configuration at a time (and each running instance requires its 
own Workflow license). For example, you may be reviewing and submitting assets in 
one configuration, and setting trim points in another.

User authentication may be used to control user access to Workflow Portal 
configurations. Administrators can choose which Vantage users can utilize a specific 
configuration. Administrators can also make certain configurations available to 
everyone.

For information on starting and stopping Web applications, see the following topics:

 Starting Web Apps

 Stopping Web Applications

Starting Web Apps
To start any Vantage Web application, open a Web browser and enter the Vantage 
home page URL: http://<ServerName>/Vantage.

This URL displays the Vantage home page, with links for all Vantage Web applications, 

You can also launch each Vantage Web application directly, by using its own URL:
Vantage User’s Guide



Vantage Program Management
Web Client Program Management

42
• Workflow Portal URL—http://<ServerName>/Vantage/Portal

• Dashboard URL—http://<ServerName>/Vantage/Dashboard

• Job Status Viewer URL—http://<ServerName>/Vantage/JobStatusViewer

Use these URLs to directly start the target Web application. 

Replace <ServerName> with the name of the Vantage IIS server (or its IP address)—by 
default, the same as the Vantage server. Or, use localhost when running Web 
applications directly on the Web server:

 If you do not know the name of the Vantage IIS server (by default, the same server 
where the Vantage domain database is hosted), contact your Vantage administrator or 
IT department.

Stopping Web Applications
To stop a Web application, quit the Web browser, or simply go to another Web site.

Logging into or Changing Domains from Web Apps
Vantage provides many features that can be managed by your Vantage domain 
administrator. When you start Vantage Job Status Views or Vantage Workflow Portal, 
you may need to complete additional tasks before you can begin working. If additional 
tasks are required, Vantage will prompt you to complete those tasks, which are 
described in the following topics:

 Selecting the Domain

 Logging On

Selecting the Domain
A Vantage domain is a separate, independent Vantage system. Your company might 
create separate Vantage domains for different departments or geographical locations. 
As a Vantage user, you might need to select a domain for the following reasons:

• You are starting Vantage Job Status Views or Vantage Workflow Portal for the first 
time on a given computer.

• Your work requires that you connect to different Vantage domains.

After you select a Vantage domain in a Vantage Web application, the program 
remembers the last domain used and connects automatically to that domain each time 
you restart the program. You can change the selected domain at any time.

To select a domain, do the following:

1. If the program has already started and you want to change Vantage domains, select 
Change Domain in the application title panel.

The program displays the Select Vantage Domain dialog.
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Figure 18. Select Vantage Domain Dialog

2. To select a listed domain, select a domain in the domain list, and click OK.

When you change domains, your Web application closes its connection to the cur-
rent domain and connects to the selected domain.

If your domain is not listed, or your connection attempt is unsuccessful, contact your 
Vantage domain administrator and refer to the following topics:

 Connecting to an Unlisted Domain

 Connecting with Custom Login Settings

Connecting to an Unlisted Domain

To connect to an unlisted domain, do the following:

1. In the Select Vantage Domain dialog (see Figure 18), click Advanced.

2. If the domain you want to connect to is not in the list, click My Vantage Domain is 
not Listed to display the Vantage domain server field.

3. In the Select Vantage Domain dialog (see Figure 19), enter the domain database 
server’s computer name (for example, VantageServer203) or its IP address and click 
OK to connect.

Vantage domain 
list
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Figure 19. Select Vantage Domain Dialog

Connecting with Custom Login Settings

If the Vantage domain is installed on a SQL database where the default settings for the 
MS SQL server account were changed during installation, open Connection Settings to 
display the SQL Server login and password settings.

Figure 20. Manually Entering the Vantage Domain Server Name

Enter the Vantage database SQL server account username and password (obtained 
from your Vantage administrator), and click OK to connect.

SQL Server 
database login 
settings
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Logging On
If you are accessing a Vantage domain for which user login is required, Vantage displays 
the Vantage Login dialog shown in Figure 21.

Figure 21. Vantage Login Dialog

Note: If you do not have a Vantage user name, contact your Vantage domain 
administrator.

To log in to the Vantage domain, do the following:

1. Enter your Vantage user name and password (if required) and click OK to connect.

2. If you are prompted to select a domain, select the domain name, and click OK.

The first time you connect to a Vantage domain from this computer (or after you 
delete browser cookies), select a domain from the list, and click OK to continue. 
Refer to Logging into or Changing Domains from Web Apps for more information.

3. Enter the Vantage user name and password assigned by your Vantage 
Administrator, then click Log In.

The default user name and password are:

– User Name: Administrator

– Password: <none> (no characters entered)

Note: All user passwords are encrypted in the Vantage domain database. All users 
have the option of changing their password (see Changing Passwords in Web Apps).

4. Check Remember me next time to store the authentication token in a persistent 
cookie in the browser. This keeps you authenticated if you close your browser and 
reopen it again.

If you entered the Vantage URL, Vantage displays the Vantage Web application home 
page (see Figure 22), so you can select any Vantage Web application. Otherwise, your 
Web application displays.
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Returning to the Vantage Web Apps Menu
To return to the main Web applications menu (see Figure 22) so that you can run 
another Vantage Web application, click on the home button in the title panel.

If the title panel is hidden, click the show/hide control.

Figure 22. Vantage Web Applications Home Page

Logging Out of a Vantage Domain
If you are viewing information that is sensitive, or viewing an operational application 
(vs. a view-only application), you might want to log out when you leave your computer 
on and unattended. You must log out when you want to change domains.

To log out of the Web application, click Logout in the title panel.
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Changing Vantage Users in Web Apps

Note: This topic applies to all Vantage Web applications.

When you are logged in to a Vantage domain that has a Team Management (or higher 
level) license and User Administration is enabled, you can change to another Vantage 
user name. To log in with a different user name, do the following:

1. Select File > Change Vantage User to display the Vantage Domain Login dialog (see 
Figure 23).

Figure 23. Vantage Domain Login Dialog

2. Enter the Vantage user name, and password if required, and click OK to log in with 
the new Vantage user name.

Changing Passwords in Web Apps

Note: This topic applies to all Vantage Web applications.

When you are logged in to a Vantage domain that has a Team Management (or higher 
level) license and User Administration is enabled, you can change the password of 
Vantage user name currently logged in. To change your password, do the following:

1. Select File > Change Password to display the Set Password dialog.

Figure 24. Set Password Dialog
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2. Enter your new Vantage password, confirm the password, and click OK to update 
your password.

The next time you log in to the Vantage domain, use your new password.

Displaying Version Information
To display version information in a Web application, click About in the Help menu.

Figure 25. Job Status Views About Dialog

Accessing Vantage Documentation from Web Apps

Note: This topic applies to both Vantage client programs—Vantage Workflow 
Designer and Vantage Workflow Portal.

The Help menu selections in the Web applications provide access to the following 
Vantage documentation:

• About—Displays the application version number.

• User Guide—Displays the Vantage User’s Guide (which is this guide) in PDF format. 
The PDF version contains bookmarks, and you can use the PDF search option to 
search for one or all occurrences of a term.

• Web Help—Displays the Vantage User’s Guide (which is this guide) in HTML format. 
Web Help features include Contents, Index, Search, and Favorites pages. You can 
use the Favorites page to save links that you can use to quickly return to a location 
in this guide.

Version 
Information
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To open the User’s Guide PDF or the Web library, do the following:

1. Locate the Help menu in the left pane of the Web application.

Figure 26. Web Applications Help Menu

2. If no entries display under the Help menu, click the control to the right of the title to 
display the list.

3. To open the PDF version of this guide, click User Guide.

4. To open the Web library, click Web Help.

Understanding Path Specifications for Vantage 
Storage

Vantage stores and locations on Windows platforms can be specified using the 
following path forms:

• UNC form: \\ComputerName\Sharename

• Drive-letter form: C:\folder\folder

If all your Vantage services, clients, Vantage stores and folders are on the same server, 
you can use either path form. However, Telestream recommends that you always use 
the UNC path form. It is a requirement when you are operating in a distributed Vantage 
domain.

The problem with using the drive-letter path form is that the drive letter is defined on 
the local machine, and the drive letter does not identify the computer that hosts the 
drive. 

For example, if you specify a Vantage store on drive C: using the drive-letter path form 
and a Workflow Portal operator on a different computer tries to view files in that store, 
Workflow Portal will search for those files on drive C: on the operator’s computer, not on 
the Vantage server.

In another example, you create a workflow in Vantage Workflow Designer running on 
Computer A. It includes a Watch action, which will be executed by a Monitor service, 
running on Computer B. You specify a hot folder on drive C: (because you have created 
it on your computer). Now, when the service runs the Watch action it tries to locate the 
hot folder on the C: drive of Computer B, which does not exist.

When any Vantage service or client program needs to access and use Vantage storage 
or a directory on a different computer, you must specify the path using the UNC form. 
You should also use the UNC form if you think you might ever support Vantage services 
or clients on another computer—a distributed domain. You can change the path form 
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later, but it is easier to use the UNC path form now, and it can prevent troubleshooting 
issues in the future.

Note: When services or clients will access Vantage storage from another computer, 
the Vantage storage location or directory must be published as a share, and access 
must be granted to the appropriate Windows users. For more information, see 
Windows Authentication Guidelines in the Vantage Domain Management Guide.

When you want to use a SAN system, be aware that some SAN systems expose the 
shared drive as a letter (mapped) drive (for example, X:) that is visible on any client of 
the SAN. You can utilize SAN drives via a letter drive reference, provided that each 
Vantage server is a client of the SAN and that all mount points use the same letter.

Note: If you are creating a store to hold proxy files viewed in the Vantage Workflow 
Portal, Telestream recommends that you reference the store with a UNC path. Some 
SAN clients do not allow frame-accurate representation of proxies when using shared 
drives.
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Vantage Workflow
Designer Tours
These tours are designed to help you understand how to create, configure, and manage 
workflows in Vantage Workflow Designer. You’ll also learn how to submit media to 
workflows for processing.

As you take these tours, you’ll also become familiar with important Vantage concepts 
and how you can use them to design workflows to meet your processing requirements. 
The more you know about Vantage, the better it will serve your automated media 
transcoding requirements.

Because each tour builds on the skills and knowledge you learn in the previous tours, 
we recommend that you take the tours in succession.

As you gain hands-on experience creating workflows and processing media in 
Vantage—which leads to a working knowledge of Vantage and its components and 
architecture—you’ll gain proficiency in using Vantage to solve your organization’s 
media processing problems.

Note: Sample video files are provided for use in these workflows: <Install_Drive>:/
Program Files/Telestream/Vantage/Store. Files: FlipDemo.wmv (48 seconds), 
FlipDemo_short.wmv (15 seconds), and FlipDemo.mss.

Tours
 Tour 1: Creating and Configuring Workflows

 Tour 2: Starting and Monitoring Workflows, and Viewing the Results

 Tour 3: Managing Workflows and the Workflow Design Space

 Tour 4: Transcoding Files Using Settings You Want

 Tour 5: Using Binders, Nicknames, & Attachments

 Tour 6: Controlling Workflow Processing with Variables

 Tour 7: Decision Making in Workflows

 Tour 8: Analyzing and Modifying Media Files
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Note: You can take tours 1 through 4 without a license. For tours 5 and beyond, you’ll 
need a trial license to execute the workflows. Also, without a license, you can only 
input WMV files and transcode them. For a trial license, contact sales@telestream.net.

Tour 1: Creating and Configuring Workflows
This tour is designed to provide your first hands-on experience with Vantage Workflow 
Designer. This tour takes about fifteen to twenty minutes to complete, and introduces 
you to the concept and process of creating a typical Vantage transcoding workflow. In 
the next tour, you’ll submit media to transcode, monitor your job as it executes, and 
play your new media.

A workflow in Vantage is a series of actions arranged to automate a specific media-
related task: transcoding a file from one format to another, for example. Workflows in 
Vantage are organized by category.

Vantage provides several types of actions (the smallest amount of work you can specify 
in Vantage) which you can use to build a specific workflow. For example, a Watch action 
continually polls a hot folder (such as a media server directory or a local or network 
folder) for incoming media to process—which Vantage performs by automatically 
submitting a job to the workflow you've created. 

The task specified by each type of action (Flip, Copy, etc.) is actually executed by a 
Vantage service—for example, the Watch action is executed by the Vantage Monitor 
service.

In this tour, you’ll log on to your Vantage domain using Workflow Designer, and create 
and configure a workflow to encode QuickTime files.

Starting Vantage Workflow Designer and Logging In
You can run Vantage Workflow Designer directly on the Vantage server or on another 
Windows workstation on the LAN.

Note: If Team Management | Enterprise | Master Control is enabled, Vantage user 
accounts should be established before you log in and use Vantage. Vantage user 
accounts are controlled in the Vantage Management Console, typically by the Vantage 
administrator. If you do not have a Vantage user account, obtain one from the 
administrator or create one yourself using the Vantage Management Console. For 
assistance, run the console and select Help > Online Help. 
The default Vantage user is Administrator, with no password assigned.

1. Double-click the Vantage Workflow Designer shortcut on your desktop or select 
start > Programs > Telestream > Vantage > Vantage Workflow Designer.

2. First Time—Select a Vantage domain. If this is the first time you’ve started Workflow 
Designer on this computer, you have to manually select the domain. (A Vantage 
domain is identified by the computer that hosts the Vantage domain database—
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you are connecting Workflow Designer to the Vantage domain’s database. For 
example, if your Vantage domain database is on a server named Vantage_01, then 
you select that name to connect.) After connecting the first time, Workflow 
Designer remembers the last domain you used, and connects automatically.

Figure 27. Using the Select Vantage Domain Panel to Connect to a Vantage Domain

3. Select the domain you want to use, and click OK.

If you are having problems connecting to the domain, see Connecting to an Unlisted 
Domain or Connecting with Custom Login Settings, or contact your IT department or 
Vantage administrator for assistance.

If you are accessing a Vantage domain where Team Management is enabled, you 
need to provide your Vantage username to log in to a Vantage domain. 

4. Enter your Vantage username and password in the login dialog to proceed.

Figure 28. Vantage Domain Login Dialog

The Vantage Domain Login dialog identifies the name of the domain you’re logging 
in to. If Vantage Workflow Designer cannot locate the domain or the domain name is 
not correct, contact your Vantage administrator or your IT organization for assistance.

Once you’re logged in, Workflow Designer displays the main window.

Creating a Workflow Category
When Vantage is installed, there are no categories or workflows stored in the domain 
database. So, the first person that logs in to a new domain via Vantage Workflow 
Designer is prompted to create a new category in which to store workflows.

This is the list of domains 
running on your network.
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Note: Even if categories are present, you may want to make your own so that your 
workflows do not interfere with the work of others, or so that your tutorial workflows 
are organized in their own category, separate from production workflows.

If you’re prompted to create a new category, click OK. Otherwise, select File > Create 
New Category.

Vantage Workflow Designer displays the Create New Category dialog.

Figure 29. Create New Category Dialog

Note: Enter <Your Name> Tutorial Workflows and click OK. 
For these tours, the category is referenced generically, as Tutorial Workflows. Vantage 
displays help tips as you use it, to help you become familiar with its features. If you do 
not want Vantage to display them, check Don’t show me this again.

Creating a Workflow
Now, lets create your first workflow to convert files to a small-frame (proxy) QuickTime 
file for preview purposes. 

1. If you’re prompted to create a new workflow, click OK. Otherwise, select File > 
Create New Workflow. Vantage Workflow Designer displays the Create New 
Workflow dialog.
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Figure 30. Create New Workflow Dialog

2. Select the category you just created, from the list at the top of the dialog.

3. Enter the name Simple Transcode (in your Tutorial Workflows category), and click 
OK. (There’s no need to change the expiration policy settings now.)

Your new workflow is automatically added to the list in the workflows panel under 
the category you created earlier.

When you create a workflow, it is automatically placed in edit mode, so you can begin 
adding actions.

You do not need to explicitly save workflows you create or modify. The changes you 
make as you create (or modify) a workflow are saved automatically. 

Adding Actions to Your Workflow
You add actions and connect them together to form a workflow. Every workflow starts 
from an origin action (such as a Watch action watching a hot folder) and any connected 
downstream actions will execute subsequently.

When building a workflow, you may have multiple Watch actions, or other origin 
actions. For this tour, we will only create one.

Note: In the Workflow Design tab, notice that actions are displayed by group in the 
actions toolbar at the top of the workspace. To re-arrange them, right-click in the 
toolbar and select Sort by Name or Sort by Behavior.

1. Open the Monitor group in the actions toolbar by clicking the arrow in the upper 
left corner of the group to display its Watch and Associate actions.
Vantage User’s Guide



Vantage Workflow Designer Tours
Tour 1: Creating and Configuring Workflows

56
Figure 31. Action Toolbar, Showing Monitor Group Open

2. Click and drag a Watch action into the workspace to add your first action to the 
workflow. (Notice that it automatically centers itself—Vantage visually optimizes 
workflow actions automatically.) The Watch action polls a hot folder for new media 
files placed in the folder, and starts a job to execute the workflow (each of its 
actions) using that file.

Figure 32. Vantage Workflow Designer Window, Showing Watch Action

3. Open the Transcode action group and, rather than dragging an unconfigured Flip 
action onto to the workflow, click the Flip action one time to display a 
comprehensive list of pre-set Flip actions.
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Figure 33. Flip Action Templates

4. Select Web > QuickTime > QuickTime H.264 with AAC. The (pre-configured) action 
is added to the workflow and is arranged just to the right of the Watch action.

Note: Actions are automatically re-arranged as you make design changes.To suspend 
auto arrange, click the Auto Arrange button at the bottom of the panel (note the 
button highlights yellow) until you’ve connect all of your actions. Then, click it to re-
enable auto arrange again.

Connecting Your Actions Together
To create a chain of actions, you connect them together. There are two ways to connect 
actions:

• Click and drag a connecting line from one connector pin to another

• Click and drag an action and bump into another action.

1. Click and drag a connector line from the yellow connector pin on the right side of 
the Watch action to the yellow connector pin on the left side of the Flip action. 
(Connector pins display in yellow until they’re connected.)

2. Next, open the Transport action group and drag the Copy action so that your cursor 
is directly over the right side pin of the Flip action (a connector bar highlights pale 
blue, as shown below). 
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Figure 34. Workflow Design Area, Showing Bumping to Connect Actions

3. When the pale blue bar displays, release the mouse—the Copy action 
automatically connects to the Flip action.

Figure 35. Workflow Design Area, Showing Complete Connections

4. Now, delete the Copy action, because it is not required for this workflow. Select it 
(by clicking on it) and press Delete—or click the X button in the upper right corner 
and confirm the Delete dialog.

Note: Recall that Vantage Workflow Designer automatically saves your work in the 
database as you add and re-arrange actions. You do not have to save workflows 
explicitly.

Configuring the Watch Action
Each action in a workflow performs a specific function—and must be configured to 
perform the task specifically the way you want for a given workflow.

Each action displays a yellow i (for inspector) button  in the top left corner, the color 
yellow indicates that it has not yet been configured (it displays blue when configured).

Vantage can process a broad array of media types and formats, and access all major file 
systems. In addition to standard file systems including Windows and FTP, Vantage 
intelligently works with several complex media types such as Avid reference movies, 
and P2 cameras.

You’ll configure this watch action to poll for any type of media file placed in a specified 
folder on a Windows server.
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1. Click on the  button of the Watch action to open the inspector.

Figure 36. Watch Action—First Inspector Panel

2. Select Any Media to poll for any type of new media file and click Next to continue. 
Vantage displays the next panel in the inspector.

Note: Entries in these lists are disabled features that are not licensed.

Figure 37. Watch Action—Second Inspector Panel

3. Select Windows, and click Next to display the next panel.

Figure 38. Watch Action—Third Inspector Panel

File formats supported by 
Vantage—those in gray 
are not licensed.

Click Browse to navigate to 
and select your hot folder or 
manually enter the path.
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Note: If your Vantage domain was installed on a single server (an All-In-One domain), 
you can specify a local folder using drive-letter format (for example, 
C:\VantageTourOneIn). 
If your domain is a multi-server array (a distributed Vantage domain) or you are 
running Vantage Workflow Designer on another computer, the path must be a share 
with proper permissions (for example, \\MyDomainServer\VantageTourOneIn) and you 
must use the UNC path form (the C drive on your computer is not the same as the C 
drive on the Vantage server where the workflow executes).
For a detailed discussion, see Understanding Path Specifications for Vantage Storage.

4. Open Windows Explorer and create a folder directly on the Vantage domain server 
for this workflow and name it TourOneIn. If you plan to reference it as a share, 
display Properties and enable sharing.

5. Return to Vantage Workflow Designer and click Browse to navigate and select the 
fully-qualified path in this field. Or, enter the share path manually. 
This is now the hot folder for this workflow.

6. Click Next to continue. Workflow Designer displays the final dialog, the file system 
detector panel.

Figure 39. Watch Action Inspector—File System Detector Dialog

7. Take a moment to review these watch action settings. (You can place your mouse 
cursor over the controls to display tooltips which describe each setting.)

You must select or enter a 
nickname in every action 
that acts on or creates a file, 
to uniquely identify and 
track this file instance 
throughout the workflow.
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Note: You must select a nickname for every file in a workflow. When you create, 
operate on, move, copy, or delete a file —you provide a nickname—so that 
downstream actions can operate on the correct file, just by knowing its nickname. A 
file’s nickname is completely separate from a file’s actual (file) name. For example, in 
this Watch action, each incoming file is assigned and tracked with the nickname 
Original —regardless of its file name (for example, SnowBird_007.wmv). Similarly, you 
will configure the subsequent Flip action to use the same file—by using the same 
nickname Original as its source. In this way, regardless of the actual file names, you can 
indicate exactly which file each action in the workflow should be using.

8. Select a nickname to identify the incoming file—in this case, Original is already 
selected, so you do not need to change it. 

9. Click the  button at the top right of the panel to open context-sensitive help (a 
man page) with detailed information about configuring this inspector. Wherever 
you see the context-sensitive help button, you can click it to display details about 
the part of Vantage Workflow Designer you’re focused on. (Click the ? to display the 
User’s Guide—the document you’re reading.)

10. Click Next and then click Finish to save this configuration of the Watch action.

Now that you’ve configured the action, notice that the inspector button is hidden to let 
you know that it has been configured. Move your mouse back over the action—
Vantage displays the inspector button again—in blue. You can always re-open the 
action inspector to review or change its settings.

Configuring the Flip Action
The Inspector button on the Flip action is yellow as well—so it also must be configured. 
Why does it need to be configured, given that you selected a pre-configured action? 
Because the output file nickname has not been specified.

1. Click the Inspector button to open the Flip inspector and note the red asterisk by 
the Output media file nickname dropdown field, indicating that a nickname is 
required.
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Figure 40. Flip Action Inspector

2. Click the dropdown to view the list of Vantage-supplied nicknames for output files. 
Select Vantage Proxy as the nickname for this proxy file the workflow creates. Now, 
any subsequent actions in the workflow can reference the output from this Flip 
action, simply by referring to the nickname Vantage Proxy. (You could also type in 
your own nicknames, instead of using Vantage-supplied nicknames.)

Note: The nickname has no affect on the output filename (which will be the same as 
the input filename). For example, if you submit test.mpg, this Flip action will create 
test.mov. The MPG file is always referenced by the nickname Original and the MOV file 
is always referenced by the nickname Vantage Proxy in this workflow. 

3. Take a moment to select the video stream, audio stream, and H.264 and AAC codec 
components, as well as the QuickTime Movie container component in turn, and 
review the details panel for each component as it displays its details below the 
video stream building blocks.

4. Click Next and then click Finish to save this configuration of the Flip action, and 
note that the yellow inspector button does not display anymore.

You must select or 
enter a nickname in 
every action that acts 
on or creates a file, to 
uniquely identify and 
track this file instance 
throughout the 
workflow.
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Conclusion
Congratulations! You’ve just learned how to create a workflow, and learned the basics 
of configuring actions using Vantage Workflow Designer’s Inspector. You’ve created a 
complete workflow which can detect new media files placed in a hot folder, and 
convert them to QuickTime format.

In the next tutorial, you’ll learn how to activate workflows, submit jobs, and monitor 
them.

Tour 2: Starting and Monitoring Workflows, and 
Viewing the Results

This tour takes about 15 minutes, and shows you how to activate your workflow, submit 
media to transcode, monitor your job as it executes, and view your new media.

You can start a job in various ways:

• Place a media file in the hot folder to submit a job automatically

• Assign a hot folder to the Watch action which already has one or more media 
files—and check Process Existing Media in the Watch inspector. This causes Van-
tage to process all existing media in the directory, rather than ignore it.

• Click the Submit Job button (at the bottom of the window) and select the file to 
submit a job manually. Just follow the steps in each panel.

In this tour, we’ll start a job automatically.

Activating a Workflow
To activate a workflow, follow these steps:

1. If you closed Vantage Workflow Designer, open it again.

2. Select your Simple Transcode workflow in the Workflow Design tab on the left.

3. Click the Activate button at the bottom of the window. 
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Figure 41. Activating a Workflow to Process Jobs

Vantage Workflow Designer releases it from edit mode and the Vantage Monitor service 
starts the Watch action in your workflow, polling the hot folder you specified, searching 
for new media files to process. A job is started for each new file placed in this folder.

Click Activate to release the workflow from editing, save 
it, and activate it to start the Watch action.
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Monitoring your Workflow Status
When you activate a workflow, Vantage Workflow Designer displays the Monitor Status 
tab to display the status of all Watch actions.

Figure 42. Monitor Status Tab

Notice that the Watch action state is listed as In Process, which indicates it has started 
executing, and it is polling for new files. When a new file is discovered, a job is created 
that executes the Simple Transcode workflow. Actions may also be Waiting—the state 
that the transaction enters while Vantage is determining which service should process 
it. A transaction remains in Waiting state until it is accepted by a service for processing.

You can double-click the Watch action entry in the table to display more detailed 
information. You can confirm that it is polling the directory that you specified, and that 
no new files are detected.

Figure 43. Monitor Status/History Dialog
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When jobs are started, each action is executed by a specific Vantage service, and can be 
optimized for execution if multiple services (for example, multiple Vantage Transcode 
services) are in your domain.

Now, submit a job by following these steps:

1. Drag a file to your hot folder to submit a job. We suggest that you use one of the 
sample WMV media files provided, which are located at <InstallDrive>:\Program 
Files (x86)\Telestream\Vantage\Store\.

2. Click the Job Status tab to display the status of running jobs.

Figure 44. Job Status Tab—Each Action Displays a Color-coded Status

3. Click on the new job entry in the table, and observe each action change color as the 
entire job executes each task specified by the actions in the workflow. 

Workflows display specific border colors to identify each action’s state. Blue indi-
cates the action has completed without errors, and yellow indicates the action 
hasn't started executing yet. For a complete list, see (Using the Jobs Table).

4. Move your mouse over actions in the Monitor Status tab to display the i (inspector) 
button in the top left corner. 

5. Click the inspector button to display runtime information about the action in the 
Status/History window.
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Figure 45. Status/History Window Displays Action Execution Details

6. Click on each succeeding status line in the Status/History window to display details 
about the action. Close this window when you’re done.

When all actions are outlined in blue, the job has completed successfully.

Playing Your New File
Now that the job has completed, Vantage has created a newly-encoded QuickTime file.

Note: You did not configure the Flip action to tell it where to save new files. So, where 
are the new files saved? The short answer: unless otherwise specified, new files are 
written to a local store—a pre-defined Vantage directory created for storing files.

1. In the Job Status tab, make sure your job entry is selected in the Jobs table at the 
bottom.

2. Click on the Binders  button to display the binder for this job. 

A binder keeps track of the location of media files associated with a job, plus meta-
data labels and other attachments (files).

Figure 46. Binder Window Displays Assets—Media, Metadata, and Attachments
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3.  Right-click the output file which your workflow transcoded into QuickTime to open 
the containing Windows folder, then double-click it to play it!

Deactivating a Workflow
In an upcoming tour, you’ll use a copy of this same workflow. You should deactivate this 
workflow so that you can use the same hot folder in the next workflow, without the 
Simple Transcode workflow ingesting new media you add to the hot folder. 

Select the Simple Transcode workflow in the workflows panel, and click Deactivate at 
the bottom of the window.

Figure 47. Vantage Workflow Designer Window, Showing Deactivate Button

If you want to edit the workflow again, select File > Edit Workflow or click Edit at the 
bottom of the window. When you’re done editing a workflow, you should click Release 
so that it can be edited or executed by others in the organization.

Conclusion
Congratulations! You’ve just learned how to automatically submit media to a workflow, 
monitor its execution, and view the transcoded media file.

In the next tour, you will explore how to use Vantage Workflow Designer’s design space 
effectively.
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Tour 3: Managing Workflows and the Workflow 
Design Space

Lets take a moment to learn some techniques for using the workflow design space, 
before we continue to make changes. This tour takes about 5 minutes.

Some workflows—like Simple Transcode—have only a few actions in them; others may 
have dozens of actions. Sometimes you’re working on the big picture of a workflow—
laying out actions and connecting them together. Other times, you’re working on 
action details—configuring the details of a transcode task, for example. 

In each case, you may want to zoom in or out, scroll around, or center the work area, to 
help you focus directly on the work you’re performing at the moment.

Zooming In and Out on a Workflow
There are three ways to zoom in and out on a workflow:

• Drag the zoom slider bar at the bottom left of the workflow

• Repeatedly press Control-+/- (the plus and minus keys)

• Use the scroll wheel on your mouse while pressing the control key.

To zoom a workflow, do the following:

1. If you closed Vantage Workflow Designer, open it again, and select the Simple 
Transcoding workflow from your category in the Workflows panel on the left.

2. With your Simple Transcode workflow selected and displayed in your Workflow 
Design tab, click Edit at the bottom of the window.

3. Use the zoom slider bar at the bottom left corner to zoom in and out to suit your 
viewing and editing needs.

Figure 48. Vantage Workflow Designer Zoom Control

Moving the Workflow Around in the Design Space
A workflow with many actions may be larger than you can view effectively in your 
workspace, when viewed at the zoom level you’re currently using. 

To move the workflow around in the workspace, click and hold anywhere on the 
workflow canvas itself (do not click on an action). When the cursor changes to a 

Use the zoom slider bar to zoom 
your workflow in and out.
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compass, continue to hold down the mouse button and drag the workflow in the 
appropriate direction.

Centering the Workflow
To center the workflow in your workspace, right-click in the workspace and select 
Recenter Workflow from the context menu. Alternatively, you can press Control-R on 
the keyboard.

Before you continue, take a few moments to practice zooming, moving, and centering 
the workflow—you’ll use these features frequently, especially as you create larger and 
more complex workflows. Becoming familiar with them now will make it easier to focus 
on the design process.

Conclusion
Congratulations! You’ve just learned how to navigate the Workflow Design canvas. In 
the next tour, you will learn how to set up transcoding sessions to use the settings that 
you want.

Tour 4: Transcoding Files Using Settings You Want
This hands-on tour takes about 20 minutes. This tour is designed to add to your 
workflow management and creation skills, and provide an in-depth look at how 
effectively Vantage deals with the complexities of media transcoding. 

Duplicating Your Workflow
To duplicate a workflow, do the following:

1. If you quit Vantage Workflow Designer after the last tour, start it again. In the 
Workflows list (left), open (click) the Vantage Tours category. 

Figure 49. Vantage Workflow Designer Window, Showing Workflows List
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2. Select the Simple Transcode workflow by clicking on it.

3. Select File > Duplicate Workflow (or right-click and select Duplicate Workflow). 
Vantage displays the Duplicate Workflow dialog.

Figure 50. Duplicate Workflow Dialog

4. Enter the name of the new workflow: Complex Transcode. Click OK to save the 
workflow with the new name and dismiss the dialog.

Vantage automatically selects the new workflow, places it in edit mode and displays it 
in the Workflow Design tab.

Adding a Branch to the Workflow
Now, let’s add a second, pre-configured Flip action to your new workflow. Vantage 
provides many pre-configured actions for most types of actions, to make it easier to 
build custom workflows.

Let’s add the second Flip action in a manner that enables Vantage to encode two 
separate output files simultaneously, from a single workflow—by creating a branch, 
with parallel actions. Each of these actions are executed independently of each other, 
as soon as the resources are available, making this workflow more time-efficient.

Creating branches for multiple, parallel encoding is an important part of Vantage 
scalability and high-volume transcoding. To add a branch, do the following:

1. Open the transcode action group on the action toolbar.

2. Click on the Flip action and select Mobile > 3GPP 300KB H.264 with AAC preset 
from the popup menu to add it to the workflow (see Figure 51).
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Figure 51. Selecting a Pre-configured Action to Add

3. Connect the new Flip action to the Watch action—click and drag a connector line 
from the out connect pin on the right side of the Watch action to the in connect pin 
(left side) to connect the new Flip action—creating a new branch in the workflow.

When a workflow has multiple branches, actions in those branches can execute 
simultaneously. In this case, once a file has been discovered and a job has been cre-
ated (or a job has been manually submitted), both encodes will execute at approxi-
mately the same time, resulting in faster throughput.

4. Open the inspector and specify an output file nickname to identify the new file 
you’re encoding—this time you need to type a custom name: enter Mobile 3GPP. 

5. Click Save to update the workflow and close the inspector.

Moving Output Files to Custom Destinations
As this workflow is currently designed, newly-encoded media is saved in a local 
Vantage store, because you have not explicitly specified that the workflow should place 
the media in a folder. Lets add a Move action to each branch, so that the workflow saves 
the new media in a specific, user-accessible folder.

Move actions are file system actions. They utilize a special feature called the Vantage 
folder address book, which enables you to create a fully-qualified path (server and 
directory) with a unique name, making it easier to specify destination paths for files.
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For a detailed discussion of using UNC paths, see Understanding Path Specifications for 
Vantage Storage.

To move files:

1. Open the Transport action group on the action toolbar. Drag a Move action onto 
the QuickTime branch, and another onto the 3GPP branch, connecting each to the 
Flip action, so that each Move executes after the Flip action.

2. Open the QuickTime branch’s Move action inspector.

Figure 52. Move Action Inspector (Prior to Configuration)

3. Select the Vantage Proxy file by nickname as the file to move.

4. Click on the browse  button to the right of the Destination field. Vantage displays 
the Vantage Folder Address Book.

Figure 53. Vantage Folder Address Book

Vantage folders are similar to addresses, which you create (and name) to identify 
specific paths you use frequently. Vantage folders simplify directory referencing by 
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allowing you to specify a fully-qualified path by a simple name. They also allow you 
to update a path or credentials centrally, and automatically update all actions using 
that Vantage folder.

For example, you might have a folder on a given server for HD MPEG2 content: 
\\Voyager\SunupCampaign\Darwin\WaitingApproval\HDMPEG2. You can create a 
Vantage folder in the address book for this path, and name it SunupHDWaitingAp-
proval.   If you need to change the path or any password associated with the 
address later, you can simply change it in the address book and all actions will auto-
matically be updated.

5. Create a new Vantage folder—click the Add Folder toolbar button (the new folder 
button at far left):

Figure 54. Add New Folder Dialog

6. Enter the folder name in the Name text box: VantageOut.

7. Click Modify to specify the directory that this Vantage folder address points to.

8. Vantage folders can be defined for any supported file system. For this tour, choose 
Windows File System and click Next.

9. Click Browse to select a directory of your choice (for example, in Windows Explorer 
make a folder named C:\VantageOut) for the output media file to be copied, and 
click OK. (Do not use letter drive formats on a distributed domain or distributed 
clients—they will not work.)

10. Click Finish to close the Folder Location Editor dialog. (You may have to click OK on 
the local folder warning dialog.)

11. Click OK to add this new Vantage folder to the domain and close the Add New 
Folder dialog.

12. Now, click Select to specify the folder you just created, as the destination for the 
Move action.
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Figure 55. Move Action Inspector—After Configuration

13. Finally, click Save to save these settings and close the inspector.

14. Repeat these steps for the 3GPP action, selecting Mobile 3GPP nickname of the file 
you’re moving, and select the same destination.

When you’re done, your workflow should look like this:

Figure 56. Completed Complex Transcode Workflow

15. Activate this workflow.

16. Automatically submit a media file to this workflow, using one of the sample media 
files in <InstallDrive>:\Program Files\Telestream\Vantage\Store\. If you do not 
remember how to submit a job by dropping the file in a hot folder, refer to Tour 2: 
Starting and Monitoring Workflows, and Viewing the Results.

As the job executes, notice in the Job Status window the simultaneous execution of 
both Flip actions, resulting in two new media files.

Changing a Flip Action
Now, let’s look at the original QuickTime Flip action that you added in Tour 2 in more 
detail, and learn how to change these settings.
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To change settings, do the following:

1. Click Edit to deactivate the workflow and enter editing mode.

2. Display the inspector of the QuickTime Flip action.

Figure 57. Flip Action Inspector Dialog

3. Click the Encoder dropdown menu to display the list of codecs you can use in the 
Flip action.

4. Click on the Video Stream to display the Processor dropdown in the details panel 
below, where you select which video processor to use: Legacy 8-bit RGB, 4:4:4, 
Multi-core 16-bit YCbCr 4:4:4:4, or Lightspeed Accelerated 16-bit YCbCr 4:4:4:4. The 
Lightspeed video processor only operates on a Lightspeed Vantage server.

5. To the right of the video stream, click the Video Codec dropdown menu to display 
the video codecs that are available.

6. To the right of the audio stream, click the Audio Codec dropdown menu to display 
the audio codecs that are available.

7. At the far right of the video and audio streams, click the Container dropdown menu 
to display the containers that are available (notice that the QuickTime encoder only 
provides a QuickTime container).

Note: As you click on the video codec, audio codec, and container buttons to select 
them, configuration details display in the configuration panel at the bottom of the 

Encoder menu 
displays all 
encoders in the 
domain.

Video button & 
codec menu.

Audio button & 
codec menu.

Container button 
and menu.

Video and Audio 
stream buttons.

Video Processor 
selector.
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window. For example, the Video Codec configuration panel enables you to set frame 
width, height, and bitrate for the video in the QuickTime file.

When you select a stream (by clicking the audio or video stream buttons, far left), 
you can also add processing filters.

8. Select the video stream button in the toolbar and then click on the Video Filter 
dropdown menu to display a list of video filters.

Figure 58. Flip Action Inspector Dialog, Showing Video Filters

9. Select the Contrast filter. Vantage Workflow Designer enables it in the video stream.

Figure 59. Video Stream Configuration, Showing Contrast Filter

These filters are applied during a transcode, and provide you a great deal of control 
over how the transcode functions.

10. Click on the Video Codec at the far right to display the codec settings at the bottom 
of the window:
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Figure 60. Flip Action Inspector Dialog, Showing the Video Codec Button

11. Open Frame Size/Frame Rate and change the frame size to 640x360.

12. Finally, click the Encoder dropdown menu at the top to display the encoders that 
you can select. When configuring a given encoder, you can select it and configure it 
from scratch, or you can select and use a pre-existing template for this encoder 
(which you did earlier when you added the 3GPP Flip action).

13. Click Cancel to close the inspector without making any changes.

Note: By default, Flip actions name the files they create using the same root name as 
the original media file’s name, with an appropriate extension, based on the encoder. 
For example, a new QuickTime movie from FlipDemo.MSS is named FlipDemo.mov.

Conclusion
In this tour, you’ve learned how to duplicate an existing workflow, how Vantage 
performs multiple simultaneous encodes, and how to create and use Vantage folder 
addresses. You’ve also been introduced to the basics of configuring Flip actions to 
perform encoding tasks the way you want them to.

Video codec 
button
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Tour 5: Using Binders, Nicknames, & Attachments
This hands-on tour takes about 30 minutes and introduces you to the concept of 
binders, nicknames, and attachments in Vantage and how they enable you to easily 
track and manage multiple files during a workflow, simplifying workflow design, and 
organizing all of the assets for a given version of media in a centrally-accessible manner.

A binder is a collection of media files, attachment files, metadata tracks, and metadata 
labels. Binders are not actual physical locations; rather, they are a collection of 
references to files and metadata labels. Binders provide Vantage with the mechanism 
for tracking multiple assets as a workflow executes, allowing you to design complex 
workflows—that can deal with dozens of files simultaneously—and separate your 
workflow design from the underlying files themselves.

Nicknames
A key feature of Vantage is the notion of nicknames. A nickname in Vantage is a 
convenient means of referencing a file, using only a word or phrase—such as Original 
or Vantage Proxy. In the context of a workflow, all files are referenced by a nickname 
which you assign as you configure the workflow. 

Nicknames are used in every action that creates—or operates on—a file. It is simply a 
way to tell the action which file (referenced by the nickname) it should be using for the 
task at hand. Nicknames are far easier to use and remember than fully-qualified paths 
to files—Vantage automatically tracks the physical location of the actual files.

Vantage provides some pre-set, special nicknames, and you can assign your own 
nicknames to be more meaningful in the context of your workflow. Nicknames are 
stored in the database, and they can be re-used over and over again in multiple 
workflows—they’re only attached to files during the execution of the workflow.

Note: For some complex media types—such as Omneon reference files or P2 camera 
files—a media item is actually a collection of files, all of which are necessary to make 
the media work. In this case, the nickname refers to the entire collection of media files; 
Vantage tracks the underlying video and audio files automatically.

Adding a Delete Action
The Delete action allows you to delete a file that is no longer needed, using the 
nickname of the file. Let’s use it to delete the original file at the end of the workflow.

1. Select the Complex Transcode workflow—duplicate it as Complex Transcode Tour 5.

2. In Complex Transcode Tour 5, open the transport action group, and click and drag a 
Delete action into the workflow. Notice that no nicknames display on this action.

3. Now, connect the Delete action after the top Move action so that it executes when 
the Move action is complete. 
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Note: Notice that the nicknames now display on this action. The list on the left are 
files available before execution; the list on the right are files available after execution. 
(After configuration, the files used in this action are highlighted.)

Figure 61. Nicknames Display Directly on an Action

4. Open the Delete action inspector (click the yellow i in the top left corner). 

Figure 62. Delete Action Inspector Lists Files by Nickname

The Delete action accepts one parameter: The nickname of the file that you want to 
delete. This Delete action displays the nicknames of all files in the workflow—Origi-
nal (from Watch) and Vantage Proxy (from the connected Flip action). 

5. Select Original (which identifies the input file) and click Save to close the inspector.

Vantage highlights the other Flip action’s Original nickname in red, indicating an 
error—this file has been deleted. By using nicknames, Vantage can discover many 
workflow design issues automatically—in this case, you’re attempting to delete a 
file while it is simultaneously being transcoded by a peer Flip action in the other 
branch!

6. Connect the Move action to the Delete action to merge the branches, as shown in 
Figure 63.

Nicknames of files 
in this workflow 
before execution of 
this action.

Nicknames of files 
in this workflow 
after execution of 
this action.
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Figure 63. Merged Branches Synchronize Actions

When the workflow branches are merged, the workflow is now valid and the Flip 
actions are synchronized. In this case, the workflow waits for all upstream workflow 
branches to complete before executing the first step in the merged branch. When the 
branches are merged, the Delete action will not execute until both Flip actions have 
completed.

Attachment Files and the Associate Action
In addition to creating and working with media files, Vantage workflows can also 
handle and use non-media files, called attachments. An attachment file might be an 
XML file, an SCC caption file, an STL subtitle file, a PDF, or any other type of file which 
does not contain video or audio media.

A binder may contain more than one media file; it may also contain more than one 
attachment file. This capability allows you to copy and move not only the media, but 
any supporting files that are necessary in the workflow.

Vantage also allows you to watch hot folders for attachment files as well as media files. 

Open the Watch action inspector, and on the first panel, note that you can specify 
whether to submit jobs when a media file is identified or an attachment file is 
identified. (Select the Attachments option at the top of the panel).

This feature is useful in several situations. For example, suppose that you have a set of 
media files and you are receiving SCC caption files that need to be matched to those 
files, and applied during a transcode. You can set up a Watch action to wait for 
incoming SCC files; but how will you apply them to media?

The answer lies in the Associate action, which allows you to add files to a binder 
midway through a workflow. It accomplishes this by matching the filename of an 
existing binder file, to discover new files that will be added. For example, in this 
workflow, the filename of the SCC file can be used to match with the appropriate media 
file; now both files are in the binder and they can be used in the workflow.

Conclusion
In this tour, you learned about file nicknames. You also learned how to manage 
multiple assets in a workflow, and how to spot error indicators in a workflow.
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Tour 6: Controlling Workflow Processing with 
Variables

This hands-on tour takes about 30 minutes and introduces you to the use of variables in 
workflows. This tour also provides you a first look at the Vantage Management Console.

In this tour, you’ll learn how to manage and publish variables. In subsequent tours you’ll 
also learn how to use variables for decision-making. This tour focuses on the role that 
variables play in Vantage workflows: passing important job information between 
actions, controlling execution flow, changing action priority, and controlling job 
routing.

Variables are temporary job metadata; information that only lasts as long as the job. A 
variable is simply a type, a name, and a value—for example, a number named Lines of 
Black at Top, set to 50.

Variables can be used in several ways in Vantage:

• To allow information to be passed between actions in a workflow

• For job routing to specialized hardware

• For decision-making to determine which branch of actions execute

• To determine the priority of a particular action.

Variables are generally available to any action downstream from where they were set. In 
the case of File Modification Date, that variable’s value is available to all subsequent 
actions. In contrast, setting a variable in an action on one branch of a workflow does 
not affect the value of a variable with the same name on the other—because these are 
actually two different variables with the same name in two different branches.

In cases where workflow branches merge, variables are passed from the branch which 
actually completes last. Because which branch finishes last on a job-by-job basis is 
indeterminate from the perspective of workflow design, Telestream recommends that 
merged branches have actions which explicitly set variables which collide in this 
manner, and must be used downstream. In this case, you could reset the variable on the 
merge action to ensure that no matter which upstream branch completed first, the 
correct value is passed downstream. If you need both variable values past the merge, 
then you should start with 2 different variables; one on each branch.

If a variable is assigned to an action—but its value is not set explicitly—then the 
variable’s default value (which is set in the Management Console) is used. For example, 
in the above workflow, you set Priority to 100 (higher priority) for one of the Flip 
actions; the other uses the default value of 0 (lower priority).

You can create variables directly in Vantage Workflow Designer when you are adding a 
variable to an action. Your Vantage Domain Administrator can also add variables.
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Starting the Vantage Management Console
The Vantage Management Console is the program you use to configure and administer 
your Vantage domain—including Vantage services, licenses, workflow design items, 
and the workflows themselves.

1. Double-click the Vantage Management Console shortcut to launch it.

2. If you have not previously launched the console, you’ll be prompted to select a 
Vantage domain. Select your Vantage domain to continue. (If you’re using Team 
Management, you’ll log in using a Vantage user, also created in the console.)

Creating Variables
1. Select Workflow Design Items > Variables to display the Variables panel.

Figure 64. Managing Variables in the Management Console

The Variables panel displays a list of variables. Many of these are included with Van-
tage for use in the domain. You can use these default variables in workflows as-is, or 
you can create your own.

2. Select the Curtained variable to display its details at the bottom of the panel. Rather 
than using a default variable, let’s create a new one now.

3. Click the Create a New Variable button in the toolbar (far left button).

New button in the Variable Toolbar
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Figure 65. Creating a New Variable

4. In the details panel, enter the name File Modification Date, set the value type 
to Date, and leave the default value unchanged.

5. Click the Save button  to save your variable.

Note: There is nothing special about the name File Modification Date—you can create 
variables with any name that is not already in use. In this workflow, we will use this 
specific variable to store the modification date of the file, so we’ll name it descriptively.

Using the Priority Variable
There is one special variable that cannot be changed—Priority. This variable has special 
meaning in Vantage, because it sets the priority of any actions that receive it when 
determining job load balancing.

However, aside from this special meaning, Priority acts like any other variable. Its value 
can be set just like other variables, and it can be used for all the same purposes. 

Setting Variable Values in a Workflow
The power of variables is that their value can change dynamically during execution of a 
workflow. There are several ways that a value changes:

• As the result of an action executing. For example, analysis (and many other) actions 
can publish their results as variables—such as determining the number of pixels 
that compose a letterbox. Similarly, Watch and Associate actions can publish infor-
mation about files that they detect, using variables.

• From external metadata. Specifically, the Populate action can set variables based 
upon metadata label values found in external files 

• From a Compute action, which can create variables from other variables. For exam-
ple, Compute can add two number variables to create a new variable.
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• As a pre-step to an action executing; any action can set the value of any variable 
prior to execution.

• As a pre-step to a server executing an action; any service on any server can be con-
figured to set a variable before executing an action.

Let’s experiment with two of these. First, lets modify one Flip action in the Complex 
Transcode workflow, so that Vantage processes it with a higher priority than the other.

1. Open Vantage Workflow Designer, and duplicate Complex Transcode Tour 5 as 
Complex Transcode Tour 6.

Figure 66. Adding Variables to an Action in a Workflow

2. Right-click the QuickTime Flip action and select Add Variables from the context 
menu to display the Add Variables dialog.

Figure 67. Add Variables Dialog

3. Click the Add Variable(s) button in the toolbar to display the Select Variables dialog.
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Figure 68. Selecting Variables Dialog

4. Scroll through the list (or press the first letter of the variable—in this case P) and 
select the Priority variable—click OK to add it to this action.

Now, the Priority variable is attached to the workflow and its default value is 5. You 
can change the value of the variable at the bottom of the panel—higher numbers 
indicate higher priority, lower numbers indicate lower priority. 

Figure 69. Add Variable Dialog

5. Enter a large number (for example, 100) and click OK to make this variable setting 
permanent.

Next, let’s configure the Watch action to set the value of the File Modification Date 
variable that you created earlier, each time it picks up a file and submits a job.

6. Open the Watch action inspector and click Next three times, to display the 
Configure Settings panel.
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Figure 70. Watch Action Inspector Dialog

7. Under Generate Variables, check the File Modified Date checkbox.

8. Use the dropdown list to the right to select File Modification Date, the variable that 
you created in the Management Console earlier in the tour.   Note that you could 
also add the new variable right here in the dialog.

9. Click Next, then click Finish.

Now, your Watch action will assign the file modified date value of each file that it 
submits for processing into the variable File Modification Date, for use in this workflow. 
You’ll use this variable in the next tour.

Conclusion
In this tour, you learned about managing and creating variables, as well as how to set 
variable values in a workflow. In the next two tours, you’ll learn about how to use 
variables for decision-making, and how to use them to pass information between 
actions in a workflow.
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Tour 7: Decision Making in Workflows
This hands-on tour takes about 20 to 30 minutes and introduces you to the concept of 
decision-making using variables to control the logical flow of media through a 
workflow.

Action States
As most actions are processed in a workflow, they are passed an action state from the 
previous action or actions, and if they execute, they also set another action state. 
Monitor actions represent an exception—as an origin action, they do not inherit an 
action state. Actions then set one of three action states to indicate the union of any 
input actions plus any execution action: Success, Ignore, or Fail. Some actions allow you 
to specify the emitting state: Decide, Examine, Compare, and Identify, for example. 
However, most actions’ emitting state is set by the service that executes the action.

This state is automatically passed to the next action or actions (in the case of a branch) 
in the workflow; these actions in turn may determine whether or not to execute based 
upon the incoming state. This process-passing-and-setting pattern repeats throughout 
the entire workflow during its lifetime.

Action states enable decision-making—causing actions (or entire branches of the 
workflow) to not execute.

To understand how to implement and utilize action states for decision-making and 
logic, its important to understand their precedence, whether an action receives states 
from one or multiple incoming actions (a merge of multiple branches):

• If at least one incoming action state is Fail, regardless of other incoming states, the 
action inherits Fail and must pass it on whether the action executes or not—Fail has 
precedence over all action states. Most actions will not execute if they inherit Fail. If 
one action fails, the entire job fails.

• If there is no Fail state, but at least one Success state, then the action inherits Suc-
cess—which has precedence over Ignore. Usually, actions execute when they 
inherit Success. After execution, the action may emit Success, Fail, or Ignore.

• If all incoming states are Ignore, the action inherits Ignore. Ignore has lowest prece-
dence of the three states. An action may or may not execute when inheriting an 
Ignore, based on its state execution setting. If an action receives an Ignore state and 
does not explicitly fail, then it emits a Success state. Otherwise, it emits a Fail state 
unless it is an action which can emit Ignore, and you have configured it to do so.

Generally speaking, actions only execute if (1) none of their predecessors set the Fail 
state, and (2) at least one of the predecessors set the Success or Ignore state. Most 
actions allow you to set the execution state.

Similarly, if an action sets Ignore, the next action will also likely not execute. Most 
actions, excluding Watch and Receive (since they are origin actions), can be configured 
to perform on certain states—this allows workflows to send an email for example, if 
they detect a failure.
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Note: Actions can be configured to execute upon Fail or Ignore—for example, to 
send an email when an action failure is detected. To configure an action’s execution 
based on the incoming action state, right-click and select Perform On.
You can also set an action to execute regardless of the state: Right-click and select 
Perform On > Any.

The Decide Action
The Decide action analyzes selected incoming variables and sets the action state based 
upon the results of its analysis. Decide effectively acts as a gatekeeper to a branch in a 
workflow, determining whether to generate a Success, Ignore, or Fail action, which is 
passed on to subsequent actions, which can be set to conditionally execute, based on 
the incoming action state.

Because variable values are usually determined at run-time, Decide allows you to 
perform the analysis, and set its state at run-time as well—and may behave differently 
for every job through a workflow. This action is a powerful action allowing you to build 
complex decision-making into a workflow.

Note that if you want to have multiple branches in a workflow, and only execute 
specific branches for each job, then you’ll need multiple decides—one acting as a 
gatekeeper for each branch in the workflow.

Processing New Files
Let’s look at an example (start Vantage Workflow Designer if it is not already open).

1. Open the Complex Transcode Tour 6 workflow and duplicate it as Complex Transcode 
Tour 7. We’ll update this workflow to only process new files that are in the hot folder. 

Recall that the Watch action was configured to publish a variable named File Modifi-
cation Date. We’ll use this variable to only process files created or modified after 
January 1st, 2010.

2. In the actions toolbar, open the Common category and drag a Decide action onto 
the workflow.

3. Modify the workflow so that the Decide action follows Watch, and all remaining 
actions follow the Decide action, as shown in the following figure.
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Figure 71. Vantage Workflow Design Space, Showing Decide Action

4. To break action connections, roll over the connector between them and click the 
red X button. In this case, delete the connectors between the Watch and both Flip 
actions. Then, reconnect the actions the way you want them to execute.

5. Open the Decide action inspector. 

6. The Decide action is designed to perform evaluations upon variables, and set a 
state if they meet all the conditions that you specify. 

7. In the top left, click Select Variables and add the File Modification Date variable.

8. Select the > (Greater) operator and set the test value to January 1, 2010, 12:00:00 
AM. 

9. Verify that the state selection is Success—meaning that if the date is later than 
January 1st, this action will emit a Success—and that the Otherwise state is Ignore. 

10. Click Finish to close the inspector and update the workflow.

Now—because actions by default operate only when the incoming action state is 
Success, your workflow will process files created after January 1st, but will not process 
files created on or before this date. 

Filtering Old Files
But what if you wanted to simply delete old files?

Let’s modify the workflow to delete old files. To do that, you’ll create a new branch off of 
Watch, with a Decide and Delete action (shown in Figure 72).
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Figure 72. Delete Actions in a Workflow—Example

1. Add the Decide action, connected to the Watch on a separate branch. 

2. Now, open the Decide action inspector, and configure similarly to the previous 
one—add the File Modification Date variable, select the reverse operator <= (Less 
Than or Equal), and set the date to January 1, 2010 AM. If this is true, Success is set; if 
false, Ignore is set. 

3. Click Finish to close the inspector.

4. After the Decide action, add a Delete action and configure it to delete the Original 
file. It executes by default only on Success states.

This workflow now has two branches, each controlled by a Decide action—one will 
process only new files, the other will process only old files. Because of the way we 
configured the Decide actions, each file submitted will only be processed in one branch 
in this workflow.

Conclusion
In this tour, you’ve learned how to assign values to variables, to test those values, set 
action states, and use the Decide action to make run-time decisions—all features 
designed to enable you to add control to your workflows, based on information you’ve 
gleaned from your input file.
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Tour 8: Analyzing and Modifying Media Files
This hands-on tour takes about 15 minutes and introduces you to the concept of 
dynamic parameters in Vantage, and how they can be used to pass information 
between actions in a workflow.

Note: To execute workflows you create in this tour, you’ll need a license—certain 
features (the Examine action, for example) will not execute without one. For a trial 
license, contact sales@telestream.net.

Thus far, when we have configured our actions in a workflow, parameters have been set 
at a fixed value. For example, the frame size of a transcode output is 320x240. 
Obviously, by using fixed values the action performs the task the same way each 
time—creating an output file that is 320x240—every time this action executes.

How would workflow processing improve, if we could change these settings and 
parameters job-by-job, on the basis of the media being processed?

Vantage supports this capability to dynamically change the value of parameters and 
settings by binding parameters to variables. Recall that variables are metadata that is 
only known at run-time, and this metadata may be different for every single file. In 
Vantage workflows, you can configure almost any parameter, in almost any action, to 
use a variable (and its current value) as its input.

Automatically Detecting and Cropping Curtains
Let's build a real-world example. In this example, we know that some of our content has 
black on the left and right—curtains—that we want to crop. However, the amount of 
black is likely to be slightly different for every file being processed in Vantage. Instead 
of creating many workflows to deal with each situation—and manually measuring the 
black before processing, we'll build a workflow to crop the curtains automatically, as 
appropriate for each incoming media file, by combining an Examine action with a 
transcode with filters implemented.

1. Open the Complex Transcode Tour 4 workflow again, and duplicate it as Complex 
Transcode Tour 6. 

2. Open the Analysis group and add an Examine action—connect it between the 
Watch action and the QuickTime H.264/AAC Flip action. (You can place the action 
directly on the connector line and it will automatically connect to both, replacing 
the line.)

3. Open the Examine action inspector.

4. Click the Analyzer dropdown menu and select Curtain Detection. Vantage 
Workflow Designer displays the configuration setting for this analysis tool.

5. Open Generate Variables and configure this action to publish two variables (by 
checking them): Suggested Crop Left (select the Curtained Left Pixels variable) and 
Suggested Crop Right (select Curtained Right Pixels). 
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Note: Vantage provides many predefined variables for use in your actions. While this 
is convenient, you’re certainly free—and often will need to—create your own 
variables—they behave just like the ones Vantage provides.

6. Under Input Media File Nickname, select Original as the file to analyze. 

7. Click Save to update the action and close the inspector.

8. Open the inspector of the Flip action immediately after Examine.

9. Click on the Video Stream button, then click the triangle in the Video Filter button 
(2nd from the right) to display the video filters you can use. Add a Crop video filter 
to the transcode. 

10. Select the Crop filter to display its parameters at the bottom of the window.

11. On the Left value, click the green bind variable button to display a list of available 
variables, and select the Left parameter to bind to the Curtained Left Pixels variable.

12. Perform these steps to do the same for the Right parameter and the Curtained Right 
Pixels variable.

13. Click Save when you’re done. 

You've now created a dynamic transcode, which will automatically adjust crop settings 
based upon incoming curtain data from the curtain detection Examine action. Every 
media file that is processed will have its own, custom transcode setting appropriate for 
that file!

Take a moment to explore the rest of the transcode settings in this inspector, and notice 
the bind buttons on many parameters. You’ll find the bind button in other actions as 
well—for example, the Web Service notification action allows you to send variables to 
external Web Services, and the Email Message action allows you to include variables as 
part of an email.

If you have curtained material, submit a job for processing and view the results.

Conclusion
In this tour, you learned how to create dynamic parameters that use variables as their 
inputs. This feature enables you to create powerful, dynamic workflows that adaptively 
change what they do based upon the metrics of the media being processed.
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Constructing and
Configuring Workflows
Vantage Workflow Designer is the primary client program in Vantage: you use it to 
design and configure workflows to meet your media transcoding requirements. 
Vantage Workflow Designer combines a wide range of workflow design and media 
processing capabilities into a single program, enabling you to create workflows to solve 
a broad set of operational media processing problems.

Workflow Designer allows you to activate and deactivate workflows, and allows you to 
submit media, and monitor the jobs that are created as workflows perform transactions 
on media you've submitted for processing.

Use this chapter to learn how to design, construct, and configure workflows to perform 
specific media tasks in your organization.

Note: For basic information on starting and stopping Workflow Designer, and 
changing domains, user names and passwords, see relevant topics in Vantage Program 
Management.

Telestream recommends that you also take the Vantage Workflow Designer Tours to help 
you become familiar with creating and configuring a wide variety of workflows.

 Understanding Workflows

 Using the Workflow Design Tab

 Managing Workflow Categories

 Managing Workflows

 Constructing Workflows

 Creating Action Templates

 Configuring Actions

 Managing Vantage Folders

 Vantage Workflow Actions

Note: Features in editions for which you do not have a license are disabled, and 
indicate that you need a license to use them.
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Understanding Workflows
These topics provide information about workflows you’ll find helpful before starting 
the construction and configuration process.

 Workflow Basics

 Typical Workflow Construction and Configuration Process

 Specifying Workflow Details

 Controlling Workflow Status

Workflow Basics
A workflow in Vantage is at least one set of connected set of actions (each of which 
performs a specific task). Vantage provides over two dozen actions, which you use as 
the building blocks of workflows. Workflows can be designed and configured to 
perform a controlled, automated media processing application. Vantage Workflow 
Designer organizes its actions by category (and incidentally, by the service which 
executes them), for ease of use.

You construct and configure Vantage workflows in Workflow Designer, using the 
workspace in the Workflow Design tab, by adding various types of actions (Watch 
action, Flip action, Copy action, etc.) and connecting them together to form a logical 
chain of successive tasks. Workflows are stored in the Vantage domain database, and 
actions in the workflow are executed by Vantage services.

A valid workflow must start with an origin action (a Watch action or Receive action), and 
consists of at least two actions, which must be connected. Actions that are not 
connected to another action do not execute—a single, disconnected action invalidates 
a workflow, which prevents it from being activated for use.

Workflows may have more than one origin action, but each origin action will function 
independently of the others, and is not a common design model. Each origin action 
must have its own workflow branch with following actions that are unique to that 
origin action. 

Workflows are not required to end with a terminating action—an action without an 
output pin. The only terminating action is the Forward action. The Forward action 
permits you to pass control directly to another workflow, which must have a 
corresponding Receive origin action. This enables you to create simpler, general 
purpose workflows, and chain them together to provide more automation.

Workflows are executed by jobs, which are created and submitted automatically, 
whenever a new file is discovered by the workflow’s Watch action, or when you submit 
a job manually.
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Figure 73. Workflow Design Tab

Generally, you construct a workflow in stages: first, conceptualize and design the 
workflow and then add the actions, connecting them together to control execution. 
Finally, configure each action in the workflow to perform exactly the way you want. Test 
your workflow, and fine tune it as necessary. 

Once you have constructed and configured a workflow, you click Activate so it can be 
utilized. To edit it again—or just disable it—you just deactivate it. Then, click Edit, and 
when you’re done, you click Release. When you are editing a workflow, others using 
Vantage Workflow Designer can view—but not edit—the workflow. These buttons are 
all displayed at the bottom of the main window.

Typical Workflow Construction and Configuration Process
Before constructing a workflow, it is helpful to have a solid understanding of its 
objective or application—what you want to accomplish with it, You’ll have to 
determine what actions (tasks or steps) are necessary to implement the objective; 
where the media (and optionally, metadata and associated files) originate; what 
transcoding and metadata processing is required; where any new copies of media, 
metadata, and associated files should be stored or deployed, etc.

You should also know in advance what external systems these jobs will interact with, 
and whether you want to register and track the output files and related metadata in a 
Vantage catalog for future use. 

Armed with these details, you can construct the workflow, and configure each action to 
correctly perform its assigned task. Of course, if you don't have all this information at 
the start, you can configure the workflow later. 

Once you have tested a workflow, you have to click Activate so it can be utilized. To edit 
it again—or just disable it—you just deactivate it. Then, click Edit, and when you’re 
done, you click Release. These buttons are all displayed at the bottom of the main 
window.
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Using the Workflow Design Tab
This topic provides general information about using the Workflow Design tab.

 Design Panel Overview

 Specifying Workflow Details

 Displaying Nicknames or Variables on Actions

 Displaying Action Summary Information

 Showing and Hiding Grid Lines

 Moving the Workflow Around in the Design Space

 Centering a Workflow

 Zooming In and Out on a Workflow

 Automatically Arranging Workflow Actions

 Action Toolbar Display Options

 Using Context Menus in the Workflows Pane

 Controlling Workflow Status

Design Panel Overview
You use the Workflow Design tab (click the tab or select File > Workflow Design) to 
view, construct, and configure workflows, and activate workflows for job processing. 

The figure below illustrates the layout and main components of this panel (the 
Workflows panel (left) is not part of the panel, but is shown here for clarity).
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Figure 74. Vantage Workflow Designer Window

At the top of the Workflow Design tab is the actions toolbar, categorized in groups by 
action type. To sort them, right-click in the toolbar and select Sort by Name or Sort by 
Behavior.

Click the arrow to open each action group and display the set of actions in this group.

Specifying Workflow Details
To display or hide the selected workflow’s details panel, do one of the following:

• Select File > Workflow Details Panel 

• Click in the Workflow Design title bar

Vantage obscures the tabbed panels and displays details about the selected workflow 
as shown in Figure 75.

Workflows panel—displays all 
workflows in the database.

Use the Workflow Design tab to construct and 
configure workflows.

Nicknames | Variables View

Actions toolbar—
drag actions onto 
design area to add to 
workflow.

Zoom control

Workflow actions
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Figure 75. Workflow Details Panel, Showing Workflow Title Bar

When the workflow details panel displays, use the following controls to manage the 
workflow information:

• Name text box—Edit the workflow name.

• Description text box—Edit an optional description for the workflow.

• Expiration controls—Modify to configure the job expiration time.

• Apply—Click Apply to save your configuration changes.

• Close—Click Close to hide the workflow details panel.

The information that displays below the Apply button is informational and cannot be 
changed. The Expected Variables list indicates which variables are being utilized by 
actions in this workflow. If an action parameter in the workflow binds to a variable, it 
displays here.

Displaying Nicknames or Variables on Actions
Binder file nicknames, metadata labels, and attachments, or variables can be displayed 
directly on all actions (in detailed action view) for quick reference.

Workflow title bar
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Figure 76. Copy Action, Showing Nicknames

Nickname View—To display nicknames, select View > Action Details > Binder File 
Nicknames. In binder file nickname view, each action displays a list of file nicknames 
and metadata labels, plus attachments, that are available to the action before it 
executes (on the left), and the nicknames and labels that are available downstream 
when the action completes (on the right).

Items on an action change color based upon the validity of the workflow. Highlighted 
nicknames have been utilized/created in this workflow. Nicknames displayed in red 
represent an error.

Note: Nicknames and labels that are used or affected by the action are highlighted. 
Nicknames and labels also change color indicating whether or not the workflow is 
valid.

For example, if you configure an action to utilize nickname Copy7 provided by an earlier 
action and then delete the action that created Copy7, then Copy7 displays in red on the 
now-invalid action.

Variable View—To display variables, select View > Action Details > Variables. The 
variable view displays variables that are used to bind parameters in this action. 

Input nicknames

Output nicknames
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Displaying Action Summary Information
To display action summary data, hover over the inspector button as shown in Figure 77. 

Figure 77. Action Summary Text

The summary displays the action type, description (editable), and a high level 
description of how the action is configured.

Showing and Hiding Grid Lines
To toggle the grid lines, do one of the following:

• Select View > Show Grid Lines (Control-G).

• Right-click in the workspace (but not on an action) and select Show Grid Lines to 
display horizontal and vertical grid lines.

Repeat to hide the grid lines.

Moving the Workflow Around in the Design Space
A workflow with lots of actions may be larger than your workspace when viewed at the 
zoom level you’re using. 

To move the workflow around in the workspace, click and hold anywhere on the design 
area other than directly on an action. The cursor displays as a compass, you can drag 
the workflow in the appropriate direction, and you can release when done.

Inspector 
button
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Centering a Workflow
To center a workflow in your workspace, do one of the following:

• Right-click in the workspace and select Recenter Workflow (Control-R)

• Select View > Recenter diagram) to recenter the diagram on the work area.

Zooming In and Out on a Workflow
You can zoom the design space based on the current position of actions, or you can 
select an action and center the design space on that action as you zoom.

Figure 78. Zooming In and Out to View your Workflow Better

Zooming In—To zoom in on a workflow so you can better view details, do one of these 
actions:

• Drag the zoom slider bar to the right

• Select an action, press Shift, and drag the zoom slider bar to the right to zoom in on 
the selected action

• Repeatedly press Control-+ (the Plus key)

• Press Control and move the mouse scroll wheel up

Zooming Out—To zoom out on a workflow so you can see more actions, do one of these 
actions:

• Drag the zoom slider bar to the left

• Select an action, press Shift, and drag the zoom slider bar to the left to zoom out on 
the selected action

• Repeatedly press Control-- (the Minus key)

• Press Control and move the mouse scroll wheel down

Zoom in or out to get a better view 
of your workflow and actions.
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Automatically Arranging Workflow Actions
Use the Auto Arrange feature to assist you in visually optimizing and organizing the 
layout of actions in your workflow.

Figure 79. Enabling Auto Arrange

To disable automatic arrangement of actions while you're adjusting actions in a 
workflow, click the Auto Arrange button, located at the bottom of the Workflow Design 
tab, to toggle it off. While Auto Arrange is off, the Auto Arrange button displays Auto 
Arrange SUSPENDED in yellow. 

Click the button again to toggle auto arrangement back into effect.

Action Toolbar Display Options
Use the context menu to configure the Action toolbar to suit your preferences.

Figure 80. Action Toolbar Context Menu

Toolbar Display Size—To reduce the size of the Action toolbar at the top of the design 
area, select Icons only. To display the action names (making the toolbar a bit larger), 
select Icons and Text.

Action Group Display Order—To display the action groups in alphabetic order, select 
Sort By Name. To display the action groups by functionality and (generally) in order of 
utilization in a workflow, select Sort By Behavior.

Enable or disable Auto Arrange to 
suit your construction style.
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Using Context Menus in the Workflows Pane
Right-click in the workflows panel to display the following context menus:

In the panel title or empty space—Use the context menu to change the Vantage domain, 
or to create a new workflow category or workflow, import a workflow, or open a 
workflow you’ve used recently.

On a category—Use this context menu to create a new workflow or to rename or delete 
the category.

CAUTION: When you delete a workflow category, all workflows in this category are 
permanently removed from the domain database.

On a workflow—Use this context menu to change the status of the target workflow. You 
can also perform a variety of operations on the workflow (see Managing Workflows), or 
manually submit a job if the workflow is activated.

Controlling Workflow Status
This topic describes the four workflow status commands and how and when to change 
a workflow’s status. You change the workflow status via menu items or by using the 
buttons at the bottom of the main window.

At the bottom of the Vantage Workflow Designer window are status buttons that you 
use to control the status of the workflow.

Figure 81. Changing a Workflow’s Status

Edit—Select File > Edit Workflow or click the Edit button to modify the selected 
workflow. If the workflow is currently active (a Watch or Receive action is running and 
the workflow can process jobs), Vantage displays a warning dialog that it is about to 
deactivate the workflow. Click OK to continue.

The Actions toolbar displays at the top of the panel when in design mode, so that you 
can add new actions to the workflow.

When you are editing a workflow, other Vantage Workflow Designer users can view the 
workflow, but cannot edit or activate it.
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Release—When you’re done editing a workflow, Select File > Release Workflow or click 
the Release button. Released workflows can be activated, and can also be edited by 
others.

Activate—Select File > Activate Workflow or click the Activate button on a deactivated 
workflow to start a Watch or Receive action so that jobs can be submitted and 
processed by this workflow.

Deactivate—Select File > Deactivate Workflow or click the Deactivate button to 
deactivate the workflow. New jobs cannot be submitted and media cannot be 
processed by the workflow in this state. Existing jobs using this workflow continue 
executing to completion.

Managing Workflow Categories
Vantage provides Workflow Categories so that you can organize your workflows by 
categories that you design, and so that you can isolate and control workflows by 
Vantage user accounts (which is done in the Management Console).

The following topics describe how to manage workflow categories:

 Creating a Workflow Category

 Renaming a Workflow Category

 Deleting a Workflow Category

Creating a Workflow Category
All workflows are stored in categories, and you must have at least one category created 
before you can create a workflow.

To create a new category, do the following:

1. Select File > Create New Category, or right-click in the Workflows panel (on the left 
side of the main window) away from any categories or workflows, and select Create 
New Category. Vantage Workflow Designer displays the Create New Category 
dialog shown in Figure 82.

Figure 82. Create New Category Dialog

2. Enter the name of the category you want to create, and click OK.

Workflow Designer creates the category in the database, and displays it in the list.
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Renaming a Workflow Category
To change the name of a category, right-click on the category name in the Workflows 
Panel and select Rename or press F2. Vantage Workflow Designer makes the text 
editable so you can change it. Press Enter or just click away from the field when you’re 
done.

Deleting a Workflow Category
To delete a category, right-click on the category name in the Workflows panel and 
select Delete. Vantage Workflow Designer displays a warning that you are about to 
delete the category and all workflows stored in this category. Click OK to delete the 
category and its workflows.

CAUTION: This action deletes all workflows in the category, and cannot be undone.

Managing Workflows
This topic describes how to add, rename, move, and delete workflows, and perform 
batch operations and other workflow-related operations.

Note: Whenever you are performing a workflow operation, you can either select the 
workflow directly from the Workflow panel, or if it is a workflow you’ve used recently, 
select File > Recent Workflows, and select the workflow from the list.

 Creating a Workflow

 Renaming a Workflow

 Deleting a Workflow

 Moving Workflows Between Categories

 Duplicating a Workflow

 Importing Workflows

 Workflow Designer creates a folder for each category in the domain, then exports 
each workflow in each category, as an XML file.

 Printing Workflows

 Performing Batch Workflow Operations
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Creating a Workflow
To create a new workflow, select File > Create New Workflow, or right-click in the 
Workflows panel (on the left side of the main window) away from any category or 
workflow and select Create New Workflow. Vantage Workflow Designer displays the 
Create New Workflow dialog:

Figure 83. Create New Workflow Dialog

Category—Select the category for this workflow from the list at the top.

Name and Description—Enter the name of the workflow you want to create and an 
optional description in the Name and Description fields.

Expiration Policy—If checked, specifies (in hours) the time that elapses before job 
records for jobs submitted by this workflow are deleted from the database. The time for 
expiration is based on the last updated time in the job record—not the job submission 
time. Once the expiration period has elapsed, the jobs are subject to automatic 
deletion by the system.

OK | Cancel—Click OK to create the new workflow. Vantage Workflow Designer creates 
the workflow in the database, adds it to the specified category, and displays it in the 
Workflow Design tab in edit mode—that is, deactivated and editable.

Renaming a Workflow
To change the name of a workflow, right-click on the workflow name in the Workflows 
panel and select Rename. Vantage Workflow Designer makes the text editable so you 
can change it. Press Enter or just click away from the field when you’re done.

Note: You can only rename a workflow when it is in edit mode.

Select the category where 
you want to save the 
workflow.

Enter the name of the new 
workflow and click OK.
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Deleting a Workflow
To delete a workflow, select File >Delete Workflow or right-click on the workflow name 
in the Workflows Panel and select Delete. Vantage Workflow Designer displays a 
warning that you are about to delete the workflow and all job history for this workflow. 
Click OK to delete the workflow and its history.

CAUTION: This action deletes the workflow and its job history, and cannot be 
undone.

Moving Workflows Between Categories
To move a workflow from one category to another, select File > Move Workflow or 
right-click on the workflow you want to move and select Move. Vantage Workflow 
Designer displays a Category dialog. Select the category you want to move the 
workflow to, and click OK.

Duplicating a Workflow
To duplicate a workflow, select File > Duplicate Workflow or right-click on the workflow 
and select Duplicate. Vantage Workflow Designer displays a Category dialog. Select the 
category you want to create the new workflow in, enter a name, and click OK.

Exporting Workflows
Exporting a Single Workflow—To export the selected workflow, select File > Export 
Workflow or right-click on the workflow and select Export Workflow. Vantage Workflow 
Designer displays a File System dialog. Navigate and select the location where you 
want to save the workflow XML file, and click Save. Workflow Designer exports the 
workflow as an XML file.

Exporting All Workflows in the Domain—To export all workflows in the domain, select 
File > Export All Workflows. Workflow Designer displays a File System dialog. Navigate 
and select the location where you want to save the workflows. Optionally, create a new 
folder, and click OK. 

Workflow Designer creates a folder for each category in the domain, then exports each 
workflow in each category, as an XML file.
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Importing Workflows
To import a workflow, do the following:

1. Select File > Import Workflow or right-click on the workflow and select Import 
Workflow.

Vantage Workflow Designer displays a File System dialog.

2. Navigate and select the workflow XML file previously exported from Vantage, and 
click Open.

3. Select the category where you want the imported workflow placed, or create a new 
one.

Vantage Workflow Designer imports the workflow into the selected category. You can 
now rename and edit the workflow as appropriate.

Printing Workflows
Select File > Print Workflow to print the selected workflow using the current workflow 
settings. The workflow is scaled to fit on a single page (with landscape or portrait mode 
preset based on workflow shape), unless the workflow is sufficiently large to make it 
difficult to read when scaled to a single page. Then, Vantage Workflow Designer 
provides you the option of printing across multiple pages.

Performing Batch Workflow Operations
Use this feature to select multiple workflows and initiate one of the following actions 
on the selected workflows: edit, release, activate, deactivate, delete or move.

Note: This feature is enabled only when a Vantage user with Administrator privileges 
is logged in.

To change the status of multiple workflows simultaneously, do the following:

1. Select File > Batch Workflow Operations.

Vantage Workflow Designer displays the Batch Workflow Operations dialog, which 
lists every workflow in the domain.

2. Select one or more workflows (using shift and control keys).

3. Click one of the buttons at the bottom of the dialog to apply a task to the selected 
workflows.

4. When you are done, click Close.
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Constructing Workflows
The following topics describe the operations you’ll use to construct workflows, which is 
done by adding actions, arranging them in order of execution, and connecting them 
together.

Note: Before you can edit a workflow (work with actions or change configuration), it 
must be deactivated and editable. When you first create a new workflow, Vantage 
Workflow Designer places it in edit mode automatically.

 Adding Actions

 Copying Actions

 Deleting Actions

 Controlling the Order of Execution

 Removing Line Crossings

 Re-ordering Actions

Adding Actions
To add actions to a workflow, you open the appropriate action category in the Actions 
toolbar and drag the desired action onto the design area. When you drag an action 
onto the design area, it has no configuration set, and must be configured before you 
can use the workflow.

Many actions have action templates—pre-configured actions that make it easier to 
assemble workflows. Vantage provides many built-in action templates, and you can 
also make and use your own. For details, see Creating Action Templates.

To select an action template, click on the action in the action group, and select an 
action template from the list. The configuration of a template may be exactly what you 
need, or you may need to make minor configuration changes.

Figure 84. Open an Action Category to Add an Action to your Workflow

You can also copy and paste actions in your workflow. Right-click an action in the 
workflow and select Copy to put the action on the clipboard. Next, right-click on the 
design area, and select Paste to add the copied action to the workflow. Or, right-click on 
another action of the same type, and select Paste to configure the action identically 
with the copied action.
Vantage User’s Guide



Constructing and Configuring Workflows
Constructing Workflows

112
Note: An origin action (Watch or Receive action) is required as the first action in a 
workflow, even if you plan to manually submit jobs to this workflow.

When you drag an action onto the design area, Vantage may automatically align it near 
where you dropped it (unless auto-arrange is off; see Automatically Arranging 
Workflow Actions). Until you connect an action to other actions, you can move it 
anywhere you want on the work area. If you bump the action you’re adding right next 
to an existing action, Vantage Workflow Designer will automatically connect the two.

Generally, its easiest to drag and drop actions in a pattern similar to the desired 
workflow, working from left to right (on each branch, if more than one). However, you 
can drag actions anywhere, and connect them as desired later.

Vantage will tidy up actions—moving them and organizing them by column. Once an 
action is connected, you can move it vertically (up or down) but it cannot be moved 
from its column. Alternatively, Vantage can also attempt to optimize the workflow, 
removing as many line crossings as possible. 

Copying Actions
To copy an action, right-click the action and select Copy. 

To select multiple actions to copy, control-click multiple actions, right-click one of the 
selected actions, and select Copy.

Deleting Actions
To delete an action, select it and press Delete or right-click the action and select Delete. 
When you delete an action, Vantage Workflow Designer connects the preceding and 
succeeding actions, unless you uncheck Fill connections after delete in the Delete 
confirmation dialog.

To select multiple actions to delete, control-click multiple actions. When the 
appropriate actions are selected, delete them using one of the following options:

• Press Delete.

• Right-click one of the selected actions, and select Delete.

Controlling the Order of Execution
You connect actions together in a workflow to control the order of execution relative to 
other actions, and to control the flow of variables and files from one action to another.

Task execution proceeds action by action, from left to right: when a workflow executes; 
actions at the far left execute first, and actions following the lines execute next.

To connect actions, click and drag a line from the output pin of one action to the input 
pin of the action you want to execute next in the workflow, or vice-versa. Or, when 
dropping an action onto a workflow or dragging an unconnected action around, 
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position it so that your mouse is directly on the edge of the action you want it 
connected to.

Conversely, to disconnect an action, hover over the center of the connecting line until a 
red X displays; click the red X to delete the line.

Actions can only be connected from an output pin (on the right side of the action) to an 
input pin (on the left side of the action), and control (file or logic) flows from output to 
input—from left to right.

Certain connections are not permitted:

• You cannot form recursive loops, by connecting actions to themselves or to the 
input of preceding actions in the workflow.

• You cannot connect one input (left) pin to another input pin, or one output pin 
(right) to another output pin.

Note: When you connect actions, Vantage Workflow Designer can display a popup 
message that provides connection details. To enable or disable this feature, select 
Options > Show Connection Helper.

You can connect an action to multiple succeeding actions, creating logical branches, as 
shown following. When you do, none of the actions you connect can execute before 
the preceding action upon which they depend completes. 

When you have branches in a workflow, you can optionally, use a Synchronize action as 
a visual connector at either end of the branches, to better organize them. Synchronize 
does not perform any special task, it merely aids in design. In this example, three Copy 
actions execute in parallel after the Watch action completes.

Figure 85. Multiple Actions Can Branch From a Common Action
Vantage User’s Guide



Constructing and Configuring Workflows
Constructing Workflows

114
These three Copy actions execute independently of each other, and their start time and 
completion time relative to each other is non-determinant. They execute in parallel 
from the perspective of the actions which precede and follow these actions.

You can also connect multiple actions (branches) back to a single succeeding action, as 
shown in the following figure. When you do, each of the actions you connect must 
execute before the succeeding common action can execute. 

Figure 86. Multiple Action Branches Precede a Common Action

In this example, all three Copy actions must execute before the Message action 
executes.

You can also create multiple, independent action branches–each branch starting with 
an origin action. Each branch operates independently. Each origin action creates its 
own jobs. Although this is not generally recommended, you may have situations where 
it is the best solution.
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Figure 87. Multiple Independent Branches in a Workflow

In this example, two independent sets of actions are in this workflow. As each origin 
action detects new files to process, a separate job is initiated.

Removing Line Crossings
On occasion, you might connect two actions on rows in the layout that are more than 
one row apart—resulting in an unintended line crossing. To manually optimize the 
workflow layout, select View > Remove Line Crossings or right-click and select Remove 
Line Crossings. Vantage Workflow Designer reformats the workflow and optimizes the 
layout of the actions in a grid.

Re-ordering Actions
To re-order actions vertically, drag one of the actions up or down in the design area to 
the location where you want it. Vantage Workflow Designer adjusts the other actions to 
accommodate the manual placement of the other action.

 Creating Action Templates
Vantage provides many actions with a variety of action templates, which you can use 
(along with your own) to make workflow construction easier. 

To make your own action template, follow these steps.

1. Add an action to a workflow. 

2. Configure it as appropriate.

3. Edit the description (at the bottom of the action), which is used to name the action 
template.
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4. Right-click and select Create Template to save the selected action as a template.

Figure 88. Create Template Dialog

5. Enter a description (this is optional).

6. Add or select a group, or select None and click OK.

Grouping allows you to organize your action templates. If you want more than one 
level of grouping, separate each group with a vertical bar (|)—for example, Broadcast 
Servers | Grass Valley. The description of the action displays as the name of the action 
template.

The action template is added to the template list, and can be selected by clicking on 
the action.

Configuring Actions
The following topics describe how to configure the actions in a workflow:

 Using the Action Inspector

 Changing Action Descriptions

 Setting Conditional Task Execution

 Understanding Variables

 Adding Variables to an Action

 Creating New Variables

 Binding Settings to a Variable

 Specifying Retry Rule Settings

 Modifying Resource Costs for Cost-Based Load Balancing

 Using the Filename Pattern Editor

 Action States

 Implementing Logic and Conditional Execution in Workflows
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Using the Action Inspector
Each action has an action inspector—a series of one or more dialogs—which you use to 
configure the action to perform its task in a particular way. To access the action 
inspector, click the inspector button (round i button) in the upper left corner of the 
action, or right-click the action and select Configure.

Figure 89. Action Inspector Button

Until an action has been configured, the inspector button displays yellow; a workflow 
cannot be activated until all actions have been configured. If you hover directly over 
the button, a summary of the action displays. 

The inspector dialog or dialogs vary, depending on the type of action, and the 
configuration choices you make. For example, to configure a Copy action, you make all 
changes in one dialog (see Figure 90).

Figure 90. Typical Action Inspector Dialog

However, the inspector for a Watch action typically consists of about 7 or more dialogs, 
depending on the file system you configure it to monitor.

When you’re viewing an inspector of an action in a workflow that is activated or 
someone else is editing it, the term Read Only displays in the inspector’s title bar. Also, if 
you have changed the configuration, an asterisk (*) displays immediately after the 
action name: for example, Watch *.

Detailed help is available on each panel in the inspector: Click the M button to display 
its man page or click the ? button to display this topic in the Vantage User’s Guide.

Unconfigured actions display 
their inspector button in yellow 
to alert you to a problem.
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Changing Action Descriptions
You can change an action description by directly clicking on the description text field at 
the bottom of the action, or right-click and select Description. Enter the new text and 
click away.

Setting Conditional Task Execution
You can configure some actions to only execute when the upstream action or actions 
pass a specific action state to the downstream action. Not all actions allow you to set 
condition execution. For example, you cannot test action states in origin actions—
Watch and Receive. You also cannot set conditional execution for Flip and Agility 
actions, and others.

To set the state under which an action will execute, right-click and select Perform On > 
Success | Failure | Ignore | Any. The Any option is not a state—it is a selection to indicate 
this action should execute regardless of the state passed to it.

By default, actions only execute when the action state (as set by upstream actions) is 
Success. Success means that the upstream actions have completed normally and the 
incoming state is Success. 

The Fail state indicates that at least one action has executed and failed to complete 
normally or completed normally, but was explicitly set to Fail. If you have an action 
configured to execute on Fail, it only executes if at least one upstream action has 
reported a failure.

You can also configure an action to execute on the Ignore state by selecting Ignore.

Understanding Variables
A variable is container for temporary job metadata. Each variable has a name (such as 
Number of Audio Channels) a type (such as Integer Number) and a default value, all of 
which are defined when the variable is created. You can change variable values in a 
variety of ways. For example, a variable value can be changed in actions that are 
designed to use variables, such as the Analysis, Populate, Watch and Associate actions. 
Variable values can also be changed when adding a variable to an action in a workflow 
or when manually submitting a job.

Variables are passed from action to action according to the action connections. When 
an action utilizes a given variable, all downstream actions that use variables can access 
the variable and its value.

Note: Not all actions are designed to use variables—for example, the Register action 
does not utilize variables.

Variables are used by some actions to control their functionality and execution—and 
thus, implement workflow logic. (Variables are also used by Vantage services as defined 
by the Vantage domain administrator.)
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Many parameters in Vantage can be bound to a variable, allowing the workflow to 
dynamically update parameters on a job-by-job basis. For details on binding 
parameters to variables, see Binding Settings to a Variable.

When a variable is set to a specific value, that variable value is only available to actions 
within the same branch as the one that set the variable and actions in downstream 
branches.

Note: If two branches merge to a common action, and both have specified a value for 
the same variable, then the behavior is indeterminate.

Adding Variables to an Action
Sometimes, you need to provide information to one or more actions (or directly to a 
job, when you’re manually submitting it) that is independent of the functionality of the 
actions. To do so, you can manually add a variable and set a static value. These variables 
can be used by downstream actions or by other Vantage components such as services, 
to execute the workflow appropriately.

For example, you can add a variable to set the execution priority of one workflow 
branch to high, and another to low.

To manually add a variable to an action, right-click and select Add Variables. Vantage 
Workflow Designer displays the Add Variables window.

Figure 91. Add Variables Window

In the Add Variables window, you can add variables to the action prior to execution. 
Values set in this window are available to this action, and all downstream actions 
(including actions in connected workflows).

Click the Add Variables button in the toolbar to display a list of variables.

Add Variable & Delete Variable toolbar buttons.
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Figure 92. Select Variables Window

Select the variable to add and click OK.

Note: Click Create New Variable to create a variable if you need a new one. For details, 
see Creating New Variables.

Next, with the variable selected, modify its default static value if necessary, and click OK 
to add it to the variable for use in the workflow.

Note: It is important not to use the same variable in two actions if the branches 
merge, because the behavior is indeterminate.

Creating New Variables
Vantage includes some default variables, and you can create variables directly in 
Vantage Workflow Designer. Vantage domain administrators can also create variables 
using the Vantage Management Console (Workflow Design Items > Variables).

On variable selection windows in Workflow Designer, click the Create New Variable 
button. Workflow Designer displays the Create New Variable dialog (Figure 93).

Figure 93. Create New Variables Dialog
Vantage User’s Guide



Constructing and Configuring Workflows
Configuring Actions

121
Configure the new variable as follows:

1. Enter an appropriate name for the variable in the Name text box.

2. Enter a description in the Description text box. (This is optional.) 

3. Select a variable type from the Value Type dropdown list.

4. Enter a value for this variable in the Default Value text box.

5. Click OK to save the variable.

Binding Settings to a Variable
Most settings in an action are configured with a static value—one that does not 
change from job to job. For example, you configure a Watch action to poll a specific 
directory—and job after job, this directory never changes—that is, it is a static value.

However, many actions also have settings whose values change from job to job—and 
thus, must be assigned a value when the job runs—typically, based on the media being 
processed. 

For example, you may have a Message action that generates an email—and the To 
address in the email should be the address of the associate producer of the show, 
which is provided in metadata, and assigned to a variable prior to the Message action. 
Or, a variable may be assigned a value by an Analysis action to determine how many 
lines of black are at the top of a video frame; a crop filter later in the workflow can bind 
to that variable, ensuring that every crop in every job is appropriate to the workflow.

To support unique values for a job, Vantage enables many settings to be bound to a 
variable, allowing the workflow to dynamically update the value on a job-by-job basis.

Settings that can be bound to a variable display a green bind variable button.

Figure 94. Message Action Inspector—Bindable Parameters

Click the bind variable button to display the Select Variable dialog (Figure 95).

Parameters that can be bound to a 
variable display a green bind variable 
button.
Click it to select a variable, which will 
supply its current value as the value for 
the parameter.
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Figure 95. Select Variable Dialog

The list of variables includes those variables that are present in the domain, and are of 
the correct type for the parameter. For example, the subject line only accepts text 
variables; the email address can only accept email address variables.

Select the variable to bind to this parameter, and click OK.

Note: Click Create New Variable to create a variable if you need a new one. For details, 
see Creating New Variables.

Figure 96. Message Action Inspector with a Bound Parameter

Now, the setting displays with a green border, indicating its value is derived directly 
from the current value of a variable, not the manually entered value.

Settings bound to a variable display a 
green border.
Click the green bind variable button 
again to unbind a variable, or change 
which variable you want to use.
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Configuring an Action’s Run On Rules
Most actions (except the Common actions—Compute, Construct, Decide, Forward, 
Receive, and Synchronize) have a set of rules called run on rules, which can be 
configured to determine if a given Vantage service has the features which enable it to 
execute a given action. Unlike qualification rules, which are service-centric, run on rules 
are action-centric.

Note: In addition to setting up specific rules on an action, Vantage domain 
administrators can set up service-based qualification rules using the Vantage 
Management Console.

Run on rules provide you explicit control over which service can execute a particular 
action in a given workflow.

As you design a workflow, you can indicate that you need to have a particular action 
execute on a particular service (or set of services). To implement this, you define a True/
False variable and provide it a value of TRUE to indicate that this instance of the service 
can satisfy the requirement. Next, you assign this variable to the service or services that 
qualify, in the Vantage Management Console > Services > Variables.

For example, you are designing an HD transcoding workflow, and the Flip action must 
be executed by a Transcode service deemed HD-capable—that is, it is running on a 
server with a processor set capable of adequately handling HD media transcoding. For 
this example, its a server named Vantage_HD_Transcoder.

In Vantage Workflow Designer, open your HD workflow, right-click on your Flip action 
and select Run On Rules to display the Run On Rules dialog.

Figure 97. Creating Run On Rules for an Action

Click the Add Run On Rules button in the toolbar at the top, and create an HD_Capable 
variable and set its value to TRUE, as shown below. 
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Figure 98. Creating a Variable for use with Run On Rules

Next, click OK to create this variable, and click OK to save the Run On Rule.

In the Vantage Management Console, select Services > Variables and add the 
HD_Capable variable to the Transcoder service running on the Vantage_HD_Transoder 
server.

Note: When a variable is added to a service, that variable is added to the job if the 
service executes it. Be careful about which variables you use for run on rules, and 
which are used for decision-making; generally you will want to use different variables.
Run on rules only analyze variables explicitly set by a service. They do not analyze 
variables already set in a job. This ensures that run on rules only execute actions on a 
service that explicitly sets them.

Now, return to Vantage Workflow Designer and open your HD workflow again. Right-
click on your Transcode action and select Run On Rules to display the Run On Rules 
dialog.

Click Check Services to verify that the Vantage_HD_Transcoder now responds correctly 
to queries about being HD-capable.

Figure 99. Check Services Dialog

Specifying Retry Rule Settings
Certain actions (typically, those that deal directly with files or other network-accessible 
computer systems) which fail during the execution of a workflow attempt to retry 
according to user-specified rules called retry rules.
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Default retry rules are set for each action type by the Vantage domain administrator. For 
example, the Vantage domain administrator might specify a default retry rule (in the 
Vantage Management Console) so that all Flip actions retry one time after five minutes.

The default retry rules can be modified for each action in Vantage Workflow Designer, 
and the action retry rules override the default rules. For example, you might specify 
that a specific Copy action in a workflow should retry three times: once after five 
minutes (in case of a SAN blip), once after four hours (in case of Internet congestion), 
and once after two days (in case of complete Internet failure). The configuration of the 
specific Copy action overrides the default configuration.

It is important to keep in mind that individual action retry rules specified in Workflow 
Designer override the default retry rules specified in the Vantage Management 
Console. If an action does not have override retry rules, the default retry rule for the 
action type is used instead. If there are no override rules specified for an action, and no 
default rules for its action type, then a failed action is not retried.

When an action re-executes, it is again processed for execution. It is handled according 
to load balancing rules, and it may be assigned to a different service for execution.

If you restart a job that is in the Stopped by User or Failed state, the actions execute as a 
first-time execution. For example, you have an action with Retry after 4 hours. 
Restarting this job results in immediate execution, because the action is executing on 
its first try.

Overriding Retry Rules
To view or modify retry rules on an action, right-click and select Retry Settings. Vantage 
Workflow Designer displays the Automated Retry Settings dialog.

Table 4. Actions with Retry Rules

Archive Examine Message

Associate Flip Multiscreen Flip

Compare Gather Notify

Copy Identify Process MMF
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Figure 100. Automated Retry Settings Dialog

The dialog in Figure 100 supports the following options:

• No Retry—Select No Retry to override any default retry settings, and not retry exe-
cution on failure. 

• Default—Select Default to utilize the default retry settings specified by the Vantage 
domain administrator. 

• Custom Limited Retry—Configure up to three retry settings. 

• Custom Recurring Retry—Configure the time and priority (which is optional) 
between retries.

Modifying Resource Costs for Cost-Based Load Balancing

Vantage supports two types of load balancing: cost-based load balancing and session-
based load balancing. Cost-based load balancing is available with the Vantage Master 
Control and Enterprise Control licenses and is disabled by default. To determine if cost-
based load balancing is enabled, contact your Vantage domain administrator.

Note: When cost-based load balancing is disabled (which is the default setting), 
Vantage uses session-based load balancing and resource cost settings are ignored. For 
information on configuring load balancing, see the Vantage Domain Management 
Guide.

When cost-based load balancing is enabled, each action has a default cost and a 
custom cost. The default cost is defined by the Vantage domain administrator, and the 
custom cost is defined by the workflow designer in the workflow. When you define a 
custom cost in a workflow, that cost applies to action processing instead of the default 
value.

Cost-based load balancing provides a way to control how action processing is 
distributed among multiple services. During workflow processing, the action cost 
defines the relative resources that must be available on a Vantage service to process 
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the action. If there are multiple services that can process an action, and if one service 
does not currently have the resources to process that action, another service with 
available resources will process the action.

The resource cost is an integer value that has an ordinal relationship to the other action 
costs and to a target resource usage value defined by the Vantage domain administrator. 
A higher resource cost in a workflow action means that fewer actions can run 
simultaneously on the same service. A lower resource cost allows more actions to run 
simultaneously. The actual values you enter for a workflow action must conform to the 
service settings defined by the Vantage domain administrator. To determine the range 
of resource cost settings available to you, consult with your Vantage domain 
administrator.

To view or set a resource cost on a given action, do the following:

1. Right-click on the action and select Resource Cost.

Vantage Workflow Designer displays the Resource Cost Settings dialog shown in 
Figure 101.

Figure 101. Resource Cost Settings Dialog

2. Select Default, or select Custom and enter an integer value.

3. Click OK to save.

Using the Filename Pattern Editor
Some action inspectors utilize a filename pattern editor, so that you can customize the 
pattern for filename generation, based on the task and the workflow requirements. The 
filename pattern editor is implemented in the Flip, Copy, Move, Agility Job Profile, and 
Transform actions.
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To display the editor, click the filename pattern editor button in the inspector:

Figure 102. Filename Pattern Editor Dialog

Use the editor to implement a filename generator pattern for your workflow. To 
produce the name generator pattern you require, you can include raw text (for 
example, .xml) and any combination of the following elements: base name (which 
includes the full file name including the extension, variable (select your variable), date, 
and time.

Note: In Metadata and Flip actions, the basename element is the base name of the 
source file without the extension (for example, myfile for a file named myfile.mpg). In 
Copy, Move, and Agility Job Profile (Enterprise Master Control) actions, the basename 
is the full name of the file, including the extension. For example, myfile.mpg.

Action States
The action state describes the condition of an action during execution or after 
completion.

During execution, an action s tate may be Queued | Paused | In Process | Waiting. These 
keywords display in the Job Status tab.

After execution, an action’s final state is assigned: Success | Ignore | Fail. These keywords 
may be tested by actions immediately following the target action, to determine 
whether or not the action should execute. Each action’s state is passed to the next 
action or actions in the workflow.

If an action fails, the next action inherits the Fail action state and (in most cases) will not 
execute—unless its Perform On state is set to Fail.

Some, but not all actions can be configured to set the Ignore state. The next action 
inherits the Ignore state and will likely not execute (unless it has been explicitly set to 
execute on Fail). Most actions, such as Message, can be configured to perform on 
certain states—this allows workflows to send an email if they detect a failure.
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If an action receives states from two incoming actions (such as a merge of two 
branches), then states are given the following priority:

• If at least one incoming state is Fail, regardless of other incoming states, the action 
will inherit the Fail state—Fail has precedence over all action states.

• If there is no Fail state, but at least one Success state, then the action will inherit the 
Success state—Success has precedence over Ignore states.

• Only if all incoming states are Ignore, will the action will inherit the Ignore state. 

Ignore has lowest precedence of the three states.

Implementing Logic and Conditional Execution in 
Workflows

Many workflows consist of several actions connected in a single line—thus, each action 
is executed, in turn, for the entire workflow.

However, you may want to create workflows that are intelligent and flexible, so that 
they can successfully process media files with complex output requirements 
automatically, workflows that can collect information about the media or the file itself 
at runtime, and store that information in variables. Then, you can add a Decide action 
to examine the values in the variable or variables, and pass control to one branch or the 
other, based on the value.

Generally, controlling the logical flow of media in a workflow is achieved by three 
things: adding variables and assigning them values, using a Decide action to evaluate 
variables, then setting an action state for each branch that follows the Decide action, so 
that only the appropriate branch executes for each job.

Branching workflows are scalable; you can add as many decide actions and branches as 
you need, to further refine your execution choices.

Figure 103. Use Decide Actions to Implement Execution Branching Logic

In this example, some metrics about the input file are being examined by the Watch 
action—file modification date, for example. The Decide action determines if the date is 
prior to or later than a given date, and sets Success or Fail, based on the answer. 
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The top branch’s Flip action only executes on Success (processing those files whose 
modification date is prior to the test date), and the lower branch’s Flip action only 
executes on Fail (processing those files whose modification date is later than the test 
date).

Managing Vantage Folders
Vantage folders are aliases or alternate names for actual file system folders. You create 
(and name) Vantage folders to identify specific paths you use frequently. Vantage 
folders simplify directory referencing by allowing you to specify a short, descriptive 
folder name instead of a long, complex path and file name. Vantage folders also allow 
you to update a path or credentials once, and automatically update all actions using 
that Vantage folder.

For example, you might have a folder on a given server for HD MPEG2 content: 
\\voyager\SunupCampaign\Darwin\WaitingApproval\HDMPEG2. You can create a 
Vantage folder in the Vantage folder address book for this path, and name it 
SunupHDWaitingApproval.   If you need to change the path or any password associated 
with the address later, you can simply change it in the address book and all actions will 
automatically update.

Telestream recommends using UNC paths instead of drive letter paths, and it is 
required in distributed domains. For a detailed discussion, see Understanding Path 
Specifications for Vantage Storage.

Now when you create a workflow that generates media you want saved in this folder 
path, you simply select SunupHDWaitingApproval in the Flip action’s inspector.

You can create Vantage folders in both the Vantage Management Console and in 
Vantage Workflow Designer.

To manage Vantage folders in Workflow Designer, do the following:

1. Click on the browse  button to the right of any location field that accepts Vantage 
folders.

For example, open a Flip action and select Vantage Store/Folder to see a Browse 
button. Vantage displays the Vantage Folder Address Book (see Figure 104).
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Figure 104. Vantage Folder Address Book

2. Click the Add Folder toolbar button (the new folder button at far left).

Figure 105. Add New Folder Dialog

3. Name—Enter the Vantage folder name.

4. Location—Click Modify to display the Folder Location Editor.

5. Select a file system and click Next.

6. Click Browse to navigate and select the directory that this Vantage folder address 
should reference. Or, enter the fully-qualified path manually, preferably in UNC 
form (be sure to only use drive letters when the domain is a single machine.). When 
manually entering a fully-qualified path, the text displays in red if it does not 
conform to the proper convention for the supported file system.
For a detailed discussion, see Understanding Path Specifications for Vantage Storage.

7. Click Finish to close the Folder Location Editor dialog. (You may have to click OK on 
the local folder warning dialog.)

8. Click OK to add this new Vantage folder address to the domain and close the Add 
New Folder dialog.
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9. Collision Resolution—Select Create Unique Name | Overwrite | Set Failure State to 
specify what Vantage Workflow Designer should do when a file of the same name 
already exists in this location.

– Create Unique Name—Workflow Designer adds a suffix to the filename, making it 
unique, then saves the file in the location.

– OverWrite—Workflow Designer deletes the current file and saves the new file in 
the location.

– Set Failure State —Workflow Designer does not save the file; it sets the action 
state to Fail so that downstream actions may detect the error and perform a 
specified task under this condition.

10. Click Select to close the dialog and use the currently-selected folder address, then 
press OK to save changes. Click Close to simply close the Vantage Folder Address 
Book dialog with changes.

Vantage Workflow Actions
Vantage Workflow Designer groups workflow actions according to the service that 
executes each action, with one exception. The Common actions group is not a service; 
it contains the actions that are common to all services and can be executed by any 
service. The following topics describe the actions for each action group in Vantage 
Workflow Designer:

 Agility Actions

 Analysis Actions

 Catalog Actions

 Common Actions

 Communicate Actions

 MediaMate Action

 Metadata Actions

 Monitor Actions

 Multiscreen Actions

 Staging Actions

 Transcode Actions

 Transport Actions

Agility Actions

Use Agility actions in workflows where you have an Agility ECS system and you want to 
submit jobs to it for processing. You can use Agility actions to create workflows, submit 
and monitor jobs, process MMF files, and control jobs during execution in Agility.
Vantage User’s Guide



Constructing and Configuring Workflows
Vantage Workflow Actions

133
Note: Before you can use Agility actions, the Agility ECS must be identified in the 
Management Console: Settings & Options > Agility ECS.

Agility actions are executed by the Agility service and are described in the following 
topics:

 Job Profile Action

 Job XML Action

 Process MMF Action

Job Profile Action
Use the Agility Job Profile action to obtain and display a list of Agility profiles from an 
Agility ECS (which must be configured in the Vantage Management Console and 
available at design time), from which you can select and configure, to submit jobs.

Job XML Action
Use the Job XML action to submit the job described in the specified XML to the Agility 
system for processing. This is an alternative to Vantage-based configuration using the 
Job Profile action, and is intended for use primarily by Agility users with SDK 
implementations to generate XML-based job profiles for Agility execution.

Process MMF Action
Use the Process MMF action to process an attached MMF file in Agility, and generate 
variables from it.

Analysis Actions
Use these actions (executed by the Telestream Transcode & Analysis Engine on behalf 
of the Analysis service) in workflows when you want to perform measurements on 
media files, compare media files, or identify the characteristics of media files, and 
publish the results as variables or metadata labels, or set the state of the workflow 
based on the results.

You can publish analysis results in a metadata label within the binder, or you can 
publish results as variables so that they can be used for decision-making, or to feed 
parameters in other actions. In some cases, you can also set the action state of the 
action based on the results of the measurement.

The following topics describe the actions executed by the Analysis service:

 Examine Action

 Compare Action

 Identify Action
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Examine Action
Use the Examine action to analyze the video and audio of a media file, by selecting a 
given analyzer (black detection, macroblocking analysis, slate detection, etc.).

Compare Action
Use the Compare action to examine two media files and determine their differences.

Identify Action
Use the Identify action to extract the properties of a media or attachment file (for 
example, file name, extension, size, or path) or to generate an MD5 hash of a media or 
attachment file, which you can use to compare two files downstream, or in other 
workflows.

You can also extract metadata (such as Author or Title) from media files.

In addition, you can extract a comprehensive set of properties from media files (for 
example, frame size, frame rate, codec, bitrate, number of audio channels, etc.). 

Extracted values are assigned to variables (which you create in Vantage Management 
Console or directly in Vantage Workflow Designer), for use later in a workflow. You can 
also set the workflow state as a result of execution conditions.

Aurora Action
The Aurora  action uses the Aurora service to utilize and interact with various QC tests 
provided by the Digimetrics Aurora software. The tests provide the ability to determine 
whether a particular input media (specified by nickname) either passes or fails a 
particular QC check. Each test also generates a report file that may be utilized during 
later stages of the workflow.

Catalog Actions
The following topics describe the actions executed by the Catalog service:

 Register Action

 Exist Action

Register Action
The Register action registers the workflow binder in a Vantage catalog. This allows 
Vantage to preserve the binder—and all files referenced by it—even after a job expires. 
This is also how binders become accessible to operators in Vantage Workflow Portal. 
For more information about configuring the Vantage Workflow Portal, see Using 
Workflow Portal.
Vantage User’s Guide



Constructing and Configuring Workflows
Vantage Workflow Actions

135
Exist Action
Use the exist action to determine if a binder of the same name already exists, thus 
indicating that a job has already run on the same media file.

Common Actions
Common actions do not have a dedicated Vantage service to execute them. Instead, 
these actions are implemented in every Vantage service, so that any service available 
can execute them efficiently and instantaneously.

The following topics describe the actions that can be executed by all services:

 Compute Action

 Construct Action

 Decide Action

 Forward Action

 Receive Action

 Synchronize Action

Compute Action
A Compute action uses variables to set other variables. For example, you can use 
Compute to add two numbers and assign the result to the selected variable. Compute 
can perform mathematical operations such as addition, subtraction, division and 
multiplication. It can also convert variables between types (such as converting a time 
code to a string), string manipulation, such as appending strings together into an 
output variable, and comparison functions.

Construct Action
A Construct action is an action which enables you to construct complex strings, paths, 
and math expressions from literals, variables, and tokens, for use in downstream 
actions.

Decide Action
A Decide action is an action which sets the action state based upon variables. It is 
commonly used to determine whether or not a branch in a workflow should execute (it 
sets the Success state) or not (it sets the Ignore state).
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Figure 106. Decide Actions Enable You to Branch Media Processing

For example, if one branch is for HD, it will start with a Decide action that will set the 
state to Success for HD content, ignore otherwise; if another branch is for everything 
else, it will start with a Decide action that performs the opposite behavior.

Forward Action
A Forward action forwards a binder and all current variables to another workflow, 
which starts a new job for the target workflow. A Forward action may be added to the 
end of a workflow, and requires that the target workflow has a Receive action as its first 
action.

The Forward action is the only terminating action in Vantage—it does not have a 
connecting pin on the right side. Thus, once you add a Forward action to a workflow (or 
branch in a workflow), you cannot add any more actions, because control has passed to 
another workflow with a Receive action as its origin action.

Typically, workflows are created with a Receive action when they are intended for 
execution by another workflow that immediately precedes this one. This ability to chain 
workflows enables you to create run-time customizable workflows consisting of smaller 
workflow building blocks.

Receive Action
A Receive action is a special origin action that is designed to accept the output of 
another workflow. A workflow can use a Forward action to directly submit media to a 
workflow with a Receive action. Another way to submit media to a workflow with a 
Receive action is to manually submit with Vantage Workflow Portal (see Using Workflow 
Portal). 

The ability to chain workflows enables you to create run-time, customizable workflows 
consisting of smaller workflow building blocks. When you chain workflows, you can 
pass binders and variables between them.

The Receive action is an optional, licensed feature for use with SDK-based applications 
and Workflow Portal applications.
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Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

Synchronize Action
The Synchronize action is used in workflows where multiple actions connect to 
multiple subsequent actions. Synchronize provides a common connection point, where 
all upstream actions need to be connected to all downstream actions.

Communicate Actions
Communicate actions are used to communicate with external systems. The following 
actions are executed by the Communicate service:

 Message Action

 Notify Action

Message Action
A Message action is an action which enables you to generate and transmit an electronic 
message—an email, for example. You must configure Vantage to use an SMTP server 
before email can be utilized; this can be done in the Vantage Management Console.

Notify Action
A Notify action is an action which saves job information to an XML file, invokes a 
command shell and passes data, or interfaces with an external system via Web Services.

MediaMate Action
The MediaMate action enables you to implement screen subtitling. This is an optional, 
licensed feature.

The MediaMate action is used to provide screen subtitling, by utilizing various 
subtitling systems from Screen.

Metadata Actions
Metadata actions are an optional, licensed feature available in certain Vantage editions. 
They are used to convert between attachment files, metadata labels, and variables. The 
following topics describe the actions executed by the Metadata service:

 Populate Action

 Transform Action
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Populate Action
Populate actions transform data between variables, attachments, and metadata labels. 
Populate can also be used to obtain certain system-level information related to the 
current job and assign it to variables.

Transform Action
A transform action transforms data between XML files (attachments) and labels. XSL 
style sheets are used to perform these transformations.

Note: The Transform action is available in Transcode Connect licenses and above. 

You can only use style sheets that have been implemented in the Vantage domain 
database; you cannot select an XSL style sheet from a file system. The Vantage 
administrator manages your XSL style sheets using the Vantage Management Console 
(Vantage Domain > Workflow Design Items > Style Sheets).

Monitor Actions
Monitor actions are used to identify new files to be processed, and in the case of the 
Watch action (an origin action), start jobs for this workflow. The following topics 
describe the actions executed by the Monitor service:

 Watch Action

 Associate Action

Watch Action
A Watch action is a special origin action, which uses the Monitor service to continually 
(and at regular periods) poll a target location (a directory, for example) on a device or 
file system (FTP, network folder, etc.) to discover new files. 

When a new file is discovered, the Watch action submits a job to the workflow which it 
is part of, for processing the file, typically a media file.

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

Associate Action
An Associate action uses the Monitor service to continually (and at regular periods) poll 
a target location (a directory, for example) on a device or file system (FTP, network 
folder, etc.) to discover new files.   

Generally, the Associate action uses the file name of an existing media file or 
attachment as the basis for discovering new files; for example, if media file 
Vantage User’s Guide



Constructing and Configuring Workflows
Vantage Workflow Actions

139
Vantage.mpg is currently in the workflow, then the Associate action may look for 
Vantage.scc. This behavior can be defined in the Associate action's inspector dialog.

Associate actions execute until the new file is discovered; subsequent actions do not 
execute until the file is found. When the new file is discovered, the Associate action 
makes the file available to other actions in the workflow.

Note: An origin action is required as the first action in a workflow, even if you plan to 
manually submit jobs to this workflow.

Multiscreen Action
The Multiscreen Flip action requires a Vantage Lightspeed server to execute and is 
executed by the Multiscreen service. Multiscreen Flip actions enable you to identify 
(and map) input tracks, perform optional transcoding, and package the output in 
industry-standard adaptive rate formats such as Adobe HDS, Apple HLS, and Microsoft 
HSS.

Staging Actions
The actions in the Staging service are responsible for file operations in preparation for 
moving files to other systems with special packaging requirements. The following 
topics describe the actions executed by the Staging service:

 Archive Action

 Gather Action

Archive Action
Use the Archive action to convert the selected input file to another format, usually in 
preparation for copying, moving, or deploying a file to a given system that has special 
file format requirements.

Gather Action
Use the Gather action to collect one or more files from a specified server and directory 
(and optionally, its subfolders), and bring them into the workflow as attachments. Use 
of a file matching pattern allows you to select only certain types of files.

Transcode Actions
The Flip action is executed by the Transcode service (which in turn utilizes the 
Telestream Transcode & Analysis Engine).

Use the Flip action to create media of a new format, and save it as a file, using a 
prescribed codec profile. How you configure the encoder depends on the encoder you 
choose.
Vantage User’s Guide



Constructing and Configuring Workflows
Vantage Workflow Actions

140
Transport Actions
The following transport actions are executed by the Transport service and perform file 
operations on selected files:

 Copy Action

 Move Action

 Delete Action

 Deploy Action

Copy Action
Use the Copy action to duplicate a file from one directory to another directory on a 
given file system. The new file can be tracked by the workflow—that is, referenced in 
the binder. As a result, the new file must be given a nickname.

Move Action
Use the Move action to remove a file from one directory and place it in another. You can 
optionally specify a different destination nickname during the move.

Delete Action
Use the Delete action to delete a file on the specified file system. This action also 
removes the file reference from the binder.

Deploy Action
The Deploy action copies one or more files to a destination in a single step, and may 
perform additional custom steps depending upon the type of deployment.

Deployed files are not referenced in the binder, and are not tracked after the action 
completes.
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Use this chapter to learn how to manage jobs with Vantage Workflow Designer.

 Using the Monitor Status Tab

 Using the Toolbar

 Viewing Origin Action Details

Note: Features in editions for which you do not have a license are disabled, and 
indicate that you need a license to use them.

Using the Monitor Status Tab
Click the Monitor Status tab (or click File > Monitor Status) to review the status of Watch 
and Receive actions for the workflow you selected in the Workflows panel.

Figure 107. Monitor Status Displays Watch & Other Origin Actions

The Monitor Status tab displays information about origin action execution for the 
workflow you select in the Workflows panel. 

Each row is an active origin action, indicating status and other details.

Monitor Status toolbar
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Click any column to make it the primary column and sort it in ascending or descending 
order.

Using the Toolbar
The Monitor Status tab provides the following buttons in the toolbar:

• Show in groups button —Click to organize actions by group, based on the pri-
mary column—the one you have selected. Click again to turn grouping off. For 
example, if you select State as the primary field in the table and display Groups, 
Vantage Workflow Designer sorts the entries by state: In Process and Complete. 

When displayed in groups, click the Down arrow on the table entry to display the 
origin action rows in this group (In Process, or Complete, for example).

• Delete button —Click to delete the selected historical origin action row(s). Or, 
right-click on the row, and select Delete. You can only delete rows whose origin 
actions are complete—that is, the session has ended because the workflow was 
deactivated.

• Status button —Click to display the selected workflow’s origin action details. Or, 
right-click and select View Status.

Viewing Origin Action Details
To display details about the origin action for the selected workflow, double-click the 
row (or select a row and click the Status button ).

The Status/History dialog (Figure 108 and Figure 109) provides details about the status 
of an origin action.

Figure 108. Status/History Dialog, Showing Completed Action Status
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When an action is complete, the Status/History dialog displays information on each 
aspect of the action’s execution. You can use this information to gather details about its 
execution, and when an action fails, you can use this information to determine why and 
correct the problem.

Each line in the upper panel of the Status/History dialog provides a summary of some 
aspect of action execution. To display more information related to a line in the upper 
panel, click on the line. The detailed information appears in the lower panel. 

The symbol to the left of the summary lines in the upper panel allow you to hide or 
expose subordinate summary lines. Click a symbol to hide or display subordinate 
summary lines.

When an action is still In Process, (Queued, Paused, In Process, or Waiting states), the 
Status/History dialog displays a progress bar, the path of the target directory, and the 
status.

Figure 109. Status/History Dialog, Showing In-Process Action Status

For jobs in the Success, Ignore, and Failure states, the Status History dialog displays the 
following buttons:

• Export—Click Export to display a File System dialog, and save the status/history 
information as an XML file. You can send these files to Telestream for support issues, 
or export them for processing in other systems.

• Session Log—To display a session log, select a session in the upper panel and click 
Session Log.
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Figure 110. Session Log Dialog

The session log displays session activity entries, if any, including which variables have 
been provided to each action. This information can be helpful when debugging the use 
of variable, or when working on an issue with Telestream Customer Service.

Click Done to close the window.
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Use this topic to learn how to monitor jobs and manage them using Vantage Workflow 
Designer.

 Using the Job Status & Domain Job Status Tabs

 Submitting Jobs Manually

 Creating Job Reports

 Viewing Binders

 Pausing and Resuming Flip Actions

 Setting an Action’s Execution Priority

 Viewing Action Status

Note: Features in editions for which you do not have a license are disabled, and 
indicate that you need a license to use them.

Using the Job Status & Domain Job Status Tabs
The Job Status and Domain Job Status tabs each display a list of jobs and provide job 
details. 

The Job Status tab displays all the jobs currently executing for the selected workflow. 
Use this tab to set priorities, view binders and associated files, and to pause and resume 
jobs in progress. To select this tab, click the Job Status tab (or click File > Job Status).

The Domain Job Status tab displays all the jobs currently executing in the domain and 
all jobs that are complete but failed in the domain. Use this tab to set priorities, view 
binders and associated files, and to pause and resume jobs in progress. To select this 
tab, click the Domain Job Status tab (or click File > Domain Job Status).
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Figure 111. Job Status Tab

If your workflow is deactivated, the table displays the jobs that are still executing or 
which completed prior to deactivating the workflow.

When an action is executing (displays a green border), a progress bar displays at the 
bottom of the action, indicating execution progress.

Figure 112. During Execution, each Action Displays a Progress Bar

Each row is a job processed by the selected workflow, indicating 
status and other details.

Job Status toolbar

Real-time view of transaction processing.

The progress bar indicates progress for this action.
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The following topics provide additional information on using the Job Status tabs:

 Viewing the Detailed Action View

 Using the Jobs Table Toolbar

 Using the Jobs Table

Viewing the Detailed Action View
To view actions in detailed action view, select View > Detailed Action View. In this view, 
each action displays its state, creation and update dates, and resource costs directly on 
the action.

Using the Jobs Table
Click any column title in the Jobs table to make it the primary column and sort it in 
ascending or descending order.

Jobs display a color to indicate their state:

• Yellow—State: Idle, Pending, or Interrupted. An action is waiting to execute.

• Green—State: In Process. An action is currently executing.

• Blue—State: Complete. An action executed successfully.

• Red—State: Failed. This action has failed or an upstream action failed.

• Black—State: Ignored. This action was not executed due to Perform On state mis-
match.

• Light Gray—State: Paused or Suspended. An action is paused or suspended.

• Magenta—State: Stopped by User. An action was stopped by a user.

• Orange—State: Waiting to Retry. An action failed and is waiting to retry.

Using the Jobs Table Toolbar
The toolbar for the Jobs table displays buttons for the following commands:

• Show in groups button —Click to organize the jobs by group, based on the pri-
mary column—the one you have selected. Click again to turn grouping off.

• Stop button —When processing, click to halt processing on this job. When you 
stop a job in process, each action for that job is notified to stop its own transaction. 
When all actions have been stopped, the job is considered complete, in a user-
stopped state.

• Restart button —If a job was stopped or it failed, it can be re-started and will con-
tinue processing where it stopped. Actions that fail or are stopped by a user are re-
executed. When you restart a job, it is started as a first-time job again. This affects 
the execution of retry rules.
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• Set job expiration button —Click to modify the default expiration time for this 
job. Vantage Workflow Designer displays the Set Job Expiration dialog—specify a 
new expiration date and click OK.

• Delete button —Click to delete the selected job row(s). Or, right-click and select 
Delete.

• Binder button —Click to display the selected job’s binder. Or, right-click an 
action or the job row in the table, and select View Binder. For details, see Viewing 
Binders.

• Job errors button —To create a job report, select one or more jobs in the table, 
and click on the Job Report button in the toolbar. For details, see Creating Job 
Reports.

• Filter button —Click to display only jobs that contain specific text in the job 
name. Enter the text to begin filtering displayed jobs. Delete the text (or just close 
the filter by clicking the filter button) to display all jobs again.

Note: When you stop, restart, or delete a job with Agility actions in the workflow, 
Agility transactions and tasks are also stopped, restarted, or deleted.

Submitting Jobs Manually
To submit a job to any active workflow directly from Vantage Workflow Designer, do the 
following:

1. Select the target workflow and click Submit Job.

Figure 113. Vantage Workflow Designer Window, Showing Submit Job Button
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Note: You can only submit jobs to active workflows.

Vantage Workflow Designer displays the Submit Job window shown in Figure 114.

Figure 114. Submit Job Dialog

2. Select the type of file system where the input file is stored, and click Next.

Figure 115. Submit Job Window, Selecting the Media File
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3. Click Browse to navigate to the directory and select the file you want to submit, 
then click Next.

Figure 116. Submit Job Dialog, Showing Variables and Submit Buttons

4. Optionally, click Variables to manually add a variable with a static value to this job. 
For details, see Adding Variables to an Action.

Variables can be used by actions to control their behavior and workflow logic. (Vari-
ables are also used by services when configured with processing rules, to control 
which actions can be executed by a given service instance.) 

For example, you might be submitted an extremely long movie file for encoding—
and you have a Transcode service on a dedicated server specifically for processing 
long jobs. You add the appropriate variable and enter the predetermined value to 
route this action to this service.

5. Click Submit to submit the job for processing.

When you have submitted the job, you can view its progress in the Job Status tab (see 
Using the Job Status & Domain Job Status Tabs).

Creating Job Reports

Vantage Workflow Designer creates Job Reports for the selected job or jobs as comma-
separated value (CSV) files. You can open these reports in spreadsheet programs and 
other programs that can display CSV files, or you can use the CSV files in other systems, 
such as databases or media asset management systems. 

Each job report is based on a job report format you select.
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Note: If no job report formats exist in the domain, Workflow Designer displays a 
dialog indicating that you need to create one. Click OK to display the Job Report 
Manager, and create a job report format (Managing Job Report Formats).

Creating a Job Report
To create a comma-separated values job report, select one or more jobs in the table, 
then click on the Job Report button in the toolbar. Vantage Workflow Designer displays 
the Create Job Report dialog.

Figure 117. Create Job Report Dialog

Select a job report format from the list and click OK to continue.

Note: To manage job report formats, click the browse  button to display the Job 
Report Manager dialog. For details, see Managing Job Report Formats. You can also 
manage job reports in the Vantage Management Console.

Vantage displays the File System dialog, which you can use to select the server and 
directory where you want the CSV report file for the selected job or jobs stored, as 
shown in the following figure.

Figure 118. Selecting a Folder and Naming a Job Report Format File
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Optionally, enter a new name for the job report file (or append a date or other 
significant qualifier) and click Save to process the report and save the file with a .csv file 
extension. When the report file has been generated, Vantage displays a dialog to 
indicate where the file was saved. Click OK to close the dialog.

Managing Job Report Formats
Use the Job Report Manager dialog to create a new job report format, or to edit or 
delete an existing job report format. 

The following sections describe these tasks:

 Displaying the Job Report Manager Dialog

 Creating a New Job Report Format

 Including and Excluding the Header Row

 Choosing the Report Columns

 Duplicating a Job Report

 Deleting a Job Report

Displaying the Job Report Manager Dialog
To view the Job Report Manager dialog, follow these steps.

1. Display the Job Status or Domain Job Status tab.

2. Click the Job Report button in the toolbar to display the Job Reports dialog.

3. Click the browse  button to the right of the popup menu.

Vantage Workflow Designer displays the Create Job Report Manager dialog, shown 
below.
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Figure 119. Using the Job Report Manager to Configure Templates

Creating a New Job Report Format
You can create job report formats in Vantage Workflow Designer.

Note: Vantage domain administrators can also create report formats with the 
Vantage Management Console.

To create a new report format, do the following:

1. Click the Create report button .

Workflow Designer adds a new report to the report list and selects it.

2. Enter a new name in the Name field.

3. Optionally, enter a report description in the Description field.

4. Click the Save button .

Toolbar buttons:
Create | Delete | Save | Duplicate
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Including and Excluding the Header Row
To include or exclude a header row in the job report, select the report and do the 
following:

1. Check the Add Header Row check box to include the header row, or clear the 
checkbox to exclude the header row.

2. Click the Save button .

Choosing the Report Columns
You can configure reports to include or exclude the following columns:

• Job ID

• Job Name

• State

• Progress

• Started

• Updated

• Expires

• Workflow Name

• Additional columns for metadata label parameters

When you choose to display a column for a metadata label, the column displays the 
label value.

To define which columns appear in a report, select the report, and do the following:

1. Under Columns, check (display) or clear (hide) the checkboxes for the columns you 
want to display.

2. To add or delete columns for metadata labels, do the following:

a. Click the Add Column button  to display the Select Label Parameters for 
Columns dialog.

b. In the Labels pane, select a label for which you want to display parameters.
c. In the Parameters pane, check the checkbox for any parameter you want to 

display, and clear the checkbox for any parameter you do not want to display.
To toggle the display of parameter by category, click the Category button . 
One display state displays parameters with category headings; the other displays 
them without category headings.

d. Repeat parameter label selection until all labels are properly selected.
e. Click OK.
Vantage User’s Guide



Managing Jobs with Vantage Workflow Designer
Viewing Binders

155
3. To change the displayed order of parameter labels, select a label in the list and use 
the green up  and down arrow  buttons to move the label in the list.

The top item in the list appears to the right of the columns listed in the Columns 
row, and to the left of all the other label columns. The last item in the list becomes 
the last column on the right.

4. Click the Save button .

Duplicating a Job Report
When you duplicate a job report, a new report is created with a modified report name. 
All other configuration settings in the duplicate report match those in the original 
report.

To duplicate a job report, do the following:

1. Select the report to duplicate.

2. Click the Duplicate button .

3. In the Name text box, enter a name for the duplicate report.

4. In the Description text box, optionally enter a description for the duplicate report.

5. Click the Save button .

Deleting a Job Report
To delete a job report, select the report and do the following:

1. Click the Delete button .

2. When the confirmation dialog displays, click OK.

Viewing Binders
The Binder window displays information about all files in a job, organized by media file 
name, metadata label name, and attachment name, each in its own tab.

To view the binder for the selected job, click the binder button  in the toolbar or 
right-click any action or the job row in the table, and select View Binder. Or, double-
click the job row in the table.
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Figure 120. Viewing Binder and Assets for the Selected Job

Media Files tab—Displays a list of files, including the file’s path, nickname, and filename. 
To the right is a WMV player control, where you can preview the selected content 
provided that it is in WMV format. For other media, press Play to attempt to play the file 
in an external viewer such as QuickTime Player, if one is available for the selected file’s 
format.

Metadata Labels tab—Displays metadata labels in the binder, their parameters and 
values. You cannot edit values in this viewer.

Attachments tab—Displays a list of attachment files, including each file’s path, 
nickname, and filename.

Click Done to close the Details window.

Pausing and Resuming Flip Actions
You can pause and resume Flip actions in a job in progress.

To pause an action, right-click on the action and select Pause from the context menu. To 
resume a paused action, right-click on the job and select Resume from the context 
menu.

You cannot pause actions in certain states or in certain workflows. For example, you 
cannot pause an action that is already paused, or an action that has failed. Also, you 
cannot resume an action downstream of another failed action, without restarting the 
first failed action, etc.
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Pause for Priority in Flip Actions
Pause for Priority feature is an automatic feature of Flip actions.

If a given Transcode service is saturated (that is, it is performing a number of jobs equal 
to the number of configured sessions); then normally, Vantage will queue up the 
incoming job and wait for a slot to become available. For example, a Transcode service 
is configured to run 2 simultaneous jobs; it receives three jobs (A, B and C); jobs A and B 
begin execution (the service was idle prior to this) and job C is queued until either job A 
or B completes (at which point C will execute).

Pause for Priority comes into play if job C has a higher priority than job A or B. When job 
C has a higher priority that job A, then job A is paused and job C begins processing 
immediately. When Job C or Job B completes; then job A (which was previously paused) 
returns to processing.

Setting an Action’s Execution Priority
You can modify the execution priority of actions that are in the Wait, Pause, or Running 
states. You cannot set an action priority for a completed action.

To change the priority of an action that has not completed, do the following:

1. Right-click the action and select Priority.

Vantage Workflow Designer displays the Action Priority dialog.

Figure 121. Action Priority Dialog

2. Change the priority value, and click OK to modify the priority of this action in this 
job.

Viewing Action Status
To view details about the status of any action in a job, select the job in the jobs list, 
right-click the target action in the workflow, and select Status.

The Status/History dialog (Figure 122) provides details about each aspect of the action’s 
execution. You can use this information to gather details about its execution, and when 
an action fails, you can use this information to determine why and correct the problem.
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Figure 122. Status/History Dialog

Each line in the upper panel of the Status/History dialog provides a summary of some 
aspect of action execution. To display more information related to a line in the upper 
panel, click on the line. The detailed information appears in the lower panel. 

The symbol to the left of the summary lines in the upper panel allow you to hide or 
expose subordinate summary lines. Click a symbol to hide or display subordinate 
summary lines.

Export—Click Export to display a File System dialog, and save the status/history 
information as an XML file. You can send these files to Telestream for support issues, or 
export them for processing in other systems.

Session Log—To display a session log, select a session in the upper panel and click 
Session Log.

Click Done to dismiss the Status/History window.
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Using Workflow
Analytics
Use this chapter to learn how to analyze workflows and job history to identify problems 
and improve overall system performance.

 Understanding Workflow Analytics

 Using the Workflow Analytics Panel

 Performing Bottleneck Analysis

 Performing Execution Analysis

Note: Features in editions for which you do not have a license are disabled, and 
indicate that you need a license to use them.

Understanding Workflow Analytics

Workflow analytics is enabled in Vantage Enterprise Control and Master Control 
licenses.

Workflow analytics enables you to visually analyze workflows and job history to identify 
problems and improve overall system performance.

In Vantage Workflow Designer, workflow analytics enables you to view jobs (based on 
the job history currently in the domain database) on a case-by-case basis to:

• Identify performance bottlenecks by action in a workflow

• Analyze workflow execution as a result of decisions in a workflow

• Visualize the progress of multiple jobs submitted to a single workflow

• Rank workflows and actions, based on processing time consumption.

Note: Because workflows may be modified over time, jobs run in the selected 
workflow prior to the last change are ignored.
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Vantage administrators and personnel responsible for designing and implementing 
workflows can use this information to modify workflow design and improve Vantage 
domain performance and efficiency.

Note: In the Management Console, workflow analytics enables you to analyze 
workflows at the domain level. For details on using workflow analytics in the Vantage 
Management Console, click the Help button in the toolbar to display the Vantage 
Domain Management Guide.

Workflow analytics automatically includes new jobs that are submitted, as appropriate, 
displaying them in the Jobs table and recalculating metrics.

Using the Workflow Analytics Panel
Click the Workflow Analytics tab (or click File > Workflow Analytics), and select the 
workflow in the Workflows panel to view job history information, which helps you 
identify performance bottlenecks and collect workflow processing statistics.

Figure 123. Workflow Analytics Panel Displays Workflow Execution History

To select a workflow to view, use the Workflows list to the left of the Workflow Analytics 
tab. Open the appropriate workflow category and click on any workflow to select it. You 
can then view all of the job history records for the selected workflow in the Workflow 
Analytics tab.

After making your job selection (see below), click the Run Analysis button to begin near 
real-time display of the analytics data. To stop calculating and updating the data (or to 
change the jobs you want to analyze), click Stop Analysis.

Actions display the average execution time, and stack rank time 
relatively by color—green (fastest) through red (slowest).

Jobs Table with toolbar Analysis Options
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The following topics provide additional information:

 Using the Jobs Table Toolbar

 Using the Jobs Table

Using the Jobs Table Toolbar
The toolbar for the Jobs table displays buttons for the following commands:

Groups—Click to organize the jobs by group, based on the primary column—the one 
you have selected. Click again to turn grouping off.

Filter—Click to display (and thus determine the set) only jobs that contain specific text 
in the job name. Enter the text to begin filtering displayed jobs. Delete the text to 
display all jobs again.

Using the Jobs Table
Click any column in the Jobs table to make it the primary column and sort it in 
ascending or descending order.

When you first select a workflow, no jobs are selected, so all jobs are considered in 
calculating the metrics. Select any job or jobs (shift-click or control-click) to view the 
selected set’s analytic details.

To deselect all jobs and return the table to its original state, select one record, then 
control-click to deselect it.

Performing Bottleneck Analysis
Select Bottleneck Analysis from the popup menu on the far right. Vantage Workflow 
Designer displays elapsed time for the selected records in the job history set.

In bottleneck analysis (which is enabled by default), you can identify the longest 
running actions in a workflow, based on color and time values.

Color values are applied to each action from green to red on a sliding scale, based on a 
comparison of the average of all selected job records. The shortest average execution 
time displays the darkest shade of green; the longest displays red. Those in between 
display color values through yellow-green, yellow (average), and orange.

Numeric values on each action display the average execution time of the actions which 
ran, based on the selected job records.

When performing bottleneck analysis, choose:

• Include Waiting Time—Check to add wait time to execution time and display the 
combined total time for each action. Wait time includes time spent in a Waiting 
state and a Paused state. Uncheck to display only execution time.

• Count Non-running Actions—Check to include the execution time (0 seconds) of 
actions that did not run, thus providing a weighted bottleneck analysis based on 
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which branches in a workflow executed, based on decision actions. This allows you 
to focus upon the actions which are bottlenecks in real-world operations. 

Uncheck to disregard non-running actions when calculating the execution time. This 
allows you to find the most expensive actions, regardless of whether or not they are 
commonly run.

Performing Execution Analysis
Select Execution Analysis from the popup menu on the far right. Vantage Workflow 
Designer displays percentile and numeric values for the selected records in the job 
history set.

In execution analysis, you can determine which percentage and number of actions 
executed, based on the selected job history set, based on color and percentile values.

Color values are applied to each action from black to green on a sliding scale. The 
lowest average execution displays the darkest shade of black; the highest displays 
green.

Darker actions are those that have not executed yet (near zero percent). Dark green 
actions are average (near 50 percent), and the highest percentile executing actions are 
bright green (approaching 100 percent). 

For each action, the percent of executions completed is calculated against the total 
number of jobs, based on your selected job criteria.

When using execution analysis, choose your job criteria:

All Jobs | Only Completed Jobs | Only Successful Jobs—Select to include all selected jobs 
regardless of their status, only completed jobs (thus excluding running or partially 
completed jobs), or only successful jobs in the calculations.
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Using Workflow Portal
This chapter describes how to use the Vantage Workflow Portal. Workflow Portal is 
designed for workflow management and provides features that are not available in 
Vantage Workflow Designer. 

Vantage Workflow Portal features are provided in two programs, a Windows program 
and a Web application. The Workflow Portal Windows program, which is called the 
Workflow Portal Windows client, provides optimum performance and a larger feature 
set. The Workflow Portal Web application, which is called the Workflow Portal Web client, 
provides most of the same features as the Windows client and enables platform-
independent operation from any computer with a Web browser and a network or 
Internet connection to a Vantage domain.

The following topics introduce and describe Vantage Workflow Portal:

 Vantage Workflow Portal Overview

 Understanding Workflow Portal Configurations

 Workflow Design Guidelines

 Starting a Workflow Portal Session

 Using Vantage Workflow Portal Controls

 Managing Jobs with Workflow Portal

 Changing or Reloading a Configuration

 Deleting Binders from a Catalog

 Troubleshooting Workflow Portal

Most of the Vantage Workflow Portal topics apply to both the Workflow Portal clients. 
When a topic applies to only one client, it is noted in that topic.

Note: For information on starting and stopping Workflow Portal, Vantage Web client 
requirements, starting and stopping Web clients, changing domains, user names and 
passwords, and other basic topics, see Vantage Program Management.

Note: When using Workflow Portal on Windows Server 2008, you might have 
problems minimizing windows you have maximized by dragging them to the top of 
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your monitor. To disable the AeroSnap feature, open Control Panel > Ease of Access 
Center > Change how your mouse works, and check Prevent windows from being 
automatically arranged when moved to the edge of the screen.

Vantage Workflow Portal Overview
Video operations frequently require some form of operator interaction as media is 
processed. An operator might initiate processing, evaluate preprocessing results, add 
data to the workflow process, and select from alternative paths for further processing. A 
single workflow is not the answer to all media processing projects. 

Figure 124 shows how Vantage Workflow Portal operates in a Vantage domain.

Figure 124. How Vantage Workflow Portal is Implemented

Workflow Portal provides multiple features that help the operator oversee media 
processing. These features allow operators to:

• Browse the results (binders) of completed workflow jobs and do the following:

– Review media produced

– Locate associated files

– Review associated metadata labels

Workflow designers design 
workflows and Vantage 
administrators create Workflow 
Portal configurations to support 
Workflow Portal operators.

Operators use Vantage Workflow Portal to submit 
media to workflows, to evaluate workflow results, and 
customize workflow output.
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• Submit job results to another workflow and do the following:

– Enter or edit metadata

– Configure variables for use in the next workflow

– Select assets to forward to the next workflow

– Mark in/out points on an asset’s timeline

– Mark the media as approved or rejected

– Create an Edit Decision List (EDL) of assets to stitch together in the next workflow 
(Windows client only)

• Browse a Windows file system, manually submit media to a workflow, and add 
metadata and variables during submission (Windows client only)

• Delete job data (binders)

Operator access to job metadata is a powerful feature that enables operators to control 
the operation of the next workflow. For example, operators can edit metadata labels to 
add tags to media, control content routing, or select other processing options in the 
next workflow.

Some applications of Workflow Portal features include:

• Highlight Extraction From Archive Files—The operator marks in and out timecodes 
and chooses the timecode for a thumbnail.

• Promo Preparation—The operator marks the voice-over and graphics entry points 
on the timeline. A subsequent workflow reprocesses the promo for multiple mar-
kets, days, and languages based upon this input.

• VOD Distribution—The operator creates a playlist of clips and enters metadata. A sub-
sequent workflow merges the clips into a single media file and transforms metadata 
for distribution.

To support Vantage Workflow Portal, a Vantage domain administrator must use the 
Vantage Management Console to do the following:

• Enable support for Workflow Portal.

• Configure one or more Workflow Portal configurations, which define the Workflow 
Portal feature set for specific applications and the resources available to operators.

Note: Administrators who are setting up a Workflow Portal configuration should refer 
to the Vantage Domain Management Guide.

Many Workflow Portal applications require support from the workflow designer. For 
example, if a Workflow Portal configuration allows an operator to add metadata to a 
workflow, the operator can add metadata. However, it is the workflow that uses the 
metadata to tag media or determine where output media is delivered. 

Preparation for Workflow Portal usage requires planning by the Vantage administrator 
and workflow designer, and implementation by the Workflow Portal operator. This 
guide provides general information on using Workflow Portal. The exact procedures for 
your application should be documented by the those who design it.
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Understanding Workflow Portal Configurations
When you start a Workflow Portal session, you must select a configuration before you 
can manage media with Workflow Portal. A Workflow Portal configuration is a specific 
configuration that defines how a Workflow Portal session operates. These 
configurations are defined by the Vantage domain administrator.

Within a Vantage domain, there can be many Workflow Portal configurations, each with 
a unique purpose and an application-specific name. However, each configuration 
belongs to one of the following types:

• Browse Catalogs (copy binder)—Copy Binder

• Browse Catalogs (forward binder)—Forward Binder

• Browse Windows Network (create binder)—Browse Network

• Create EDL from Catalogs (create binder)—Create EDL

The names before the dash in the list above match the names a Vantage domain 
administrator sees when creating a Workflow Portal configuration. The names that 
appear after the dash are the abbreviated names used in this guide.

The four types of Workflow Portal configurations can be classified as either workflow-
based or file-based. The Copy Binder, Forward Binder, and Create EDL configurations 
are all designed to open the results of a Vantage workflow and allow you to optionally 
submit the results to another workflow. The Browse Network configuration allows you 
to browse a Windows network, select a media file, and submit that file to a workflow.

The following topics provide more information on the Workflow Portal configuration 
types:

 Understanding Workflow-Based Configurations

 Understanding the Browse Network Configuration

Understanding Workflow-Based Configurations
Workflow-based configurations are designed to open the results from a completed job 
so that you can respond to those results. The following topics describe workflow-based 
configuration concepts:

 Understanding Binders and Catalogs

 Understanding the Copy Binder and Forward Binder Configurations

 Understanding the Create EDL Configuration

Understanding Binders and Catalogs
Each workflow execution is a job, and information related to each job is recorded in a 
binder. A binder is a Vantage container that contains media file references and 
metadata labels for a specific job. The binder does not contain media files or 
attachments; it contains the paths to those files. The binder also contains the media 
and attachment nicknames that map to each referenced file. When you manage a job in 
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Workflow Portal with a workflow-based configuration, you access the binder, which 
provides you access to the job data you can manage. 

Similar in concept to the folders in a file system, a Vantage catalog is a container that 
stores binders. Catalog folders are subcontainers that organize binders. When you use 
Workflow Portal to access a binder, you search through the visible catalogs and folders, 
just as you would sort through folders in a file system, to locate the binder you want to 
manage.

As a Vantage operator, you can view only those catalogs, catalog folders, and binders 
that the workflow designer and the Vantage domain administrator permit you to see. 
The following are some of the controls that determine which catalogs and binders you 
can view:

• Vantage administrators define which Workflow Portal configurations you can 
access and which catalogs you can view in each configuration.

• Workflow designers and Vantage domain administrators create catalogs and cata-
log folders.

• Workflow designers specify the catalog to which each binder is assigned in the 
workflow (using the Register action).

• Workflow Portal gives you access to only those binders that have been stored in a 
Vantage catalog to which you have access.

Note: The important concept here is that not all binders are visible to Workflow Portal 
operators. A binder is visible in Workflow Portal only when the workflow designer and 
Vantage administrator have configured the workflow, a Workflow Portal configuration, 
and Vantage to support Workflow Portal management.

Understanding the Copy Binder and Forward Binder 
Configurations
In the Copy Binder and Forward Binder configurations, you can open and view binders 
for completed workflows. The difference between these two configuration types is how 
the binder is treated when you submit the binder to another workflow.

In Copy Binder mode, Workflow Portal makes a copy of the binder and submits the 
copy without modifying the original binder. In Forward Binder mode, Workflow Portal 
submits the binder you selected, without making a copy, optionally removing it from 
the catalog.

There are several differences in the user interface between Copy Binder and Forward 
Binder modes:

• When forwarding, you can multi-select binders and submit them at the same time 
(Windows client only) 

• When creating a copy, any edits are only performed on the new, copied binder and 
will only be used during submission.
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If the Workflow Portal client displays a Catalogs list, you know you are viewing a 
workflow-based configuration. If no Create EDL tab displays (see Figure 126), you are 
viewing either a Copy Binder or a Forward Binder configuration. One way to determine 
if you are viewing a Copy Binder or a Forward Binder configuration is to try to select 
multiple binders as shown in Figure 125. If you can select multiple binders, you are 
using a Forward Binder configuration.

Figure 125. Vantage Workflow Portal Window, Showing Selection of Multiple Binders

Understanding the Create EDL Configuration

Note: This configuration is not available in the Workflow Portal Web client.

As with the Copy Binder and Forward Binder configurations, you can use the Create EDL 
configuration to open and view binders for completed workflows. The Create EDL 
configuration is different because it is designed to allow you to create an Edit Decision 
List (EDL) to submit to a workflow that can process that list. With an EDL, you can mark 
start and end points to clip one or more media files, and you can stitch the clips 
together. 

When you are using a Create EDL configuration, the Create EDL tab appears in the 
Workflow Portal window as shown in Figure 126.
Vantage User’s Guide



Using Workflow Portal
Understanding Workflow Portal Configurations

169
Figure 126. Vantage Workflow Portal Window, Showing Create EDL Tab

For details on using the Create EDL configuration, see Creating an EDL.

Understanding the Browse Network Configuration

Note: This configuration is not available in the Workflow Portal Web client.

The Browse Network configuration allows you to select one or more media files from 
any location on the Windows network and submit them to one or more workflows, 
depending on how the configuration is set up. If the configuration permits, you can 
also specify metadata labels and variables to be submitted with the media.

When you are viewing a Browse Network configuration, Workflow Portal displays a 
Select media files list instead of a Catalog list as shown in Figure 127.
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Figure 127. Vantage Workflow Portal Window, Browse Network Configuration

For details on using this configuration, see Initiating Windows File Submission with the 
Windows Client.

Workflow Design Guidelines
This topic provides workflow design guidelines for workflow designers. While you can 
use a single workflow to produce and distribute media, there are some significant 
advantages to dividing the media processing into multiple workflows. For example, an 
ingest workflow can automatically analyze source media and detect media attributes 
and characteristics such as frame rate, dimensions, letterboxing, and macroblocking. 
The ingest workflow can do this while you are performing other tasks, which improves 
efficiency.

Ingest workflows can also produce proxy media that you can view with the Workflow 
Portal media viewer to evaluate quality issues and quickly define timecodes for trim 
points or commercial insertion. Using one tool (Workflow Portal) for media evaluation 
and submission also improves efficiency.

A target workflow is a workflow designed to process media submitted by Workflow 
Portal operators. When your application calls for an ingest workflow, you use Workflow 
Portal to evaluate the ingest workflow results, take any action required, and then 
submit the job to a target workflow. 

If your process does not require an ingest workflow, you might use Workflow Portal to 
submit jobs to a target workflow, rather than just placing media files in a watch file for 
automated processing. The advantage to operator submission is that you can set 
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metadata labels and variables during submission, providing more control over target 
workflow processing.

The following topics provide guidelines for creating workflows for use with Workflow 
Portal:

 Ingest Workflow Guidelines

 Target Workflow Guidelines

Ingest Workflow Guidelines
When you use an ingest workflow, the results of that workflow are stored in the binder, 
along with the paths of the source media and all attachments. When you view job 
status in Workflow Portal, the jobs are listed as binders, giving the you access to all 
resources defined in the binder.

When building ingest workflows, consider the following guidelines:

• To make a binder available to Workflow Portal operators, use a Register action to 
associate the binder with the appropriate catalog.

• The preferred format for the Workflow Portal media viewer is QuickTime media. To 
support operator preview of media, use a Flip action and specify the QuickTime 
encoder with H.264 video.

• To cause a media file to automatically appear in the Workflow Portal media viewer 
when a binder is opened, assign the Vantage Proxy file nickname to the media file. 
Vantage Workflow Designer does not allow you to assign the nickname Vantage 
Proxy if you select an incompatible encoder. 

• To support the Use Clip Start Time feature, create media using the QuickTime 
encoder and configure the encoder container settings to generate a Timecode 
Track.

• The Vantage Workflow Portal Web client can also display WMV movies, but Quick-
Time movies are preferred.

• To support operator viewing of binders by thumbnail (instead of by name), config-
ure a Flip action with the Keyframes encoder to create a thumbnail that uses the 
Vantage Thumbnail file nickname.

• If you want the workflow to make media information available to operators, config-
ure Identify and Examine actions to collect that information, and use metadata 
labels to store that information in the binder.

Note: Telestream strongly recommends that you use QuickTime H.264 MOV as the 
proxy format in both Workflow Portal clients. Telestream does not recommend the use 
of WMV files as proxies; but for those users who have an archive of WMV proxy files; 
the Web client does provide the ability to view/playback these proxy files.
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Note: If you are using the Safari 5 browser, the Silverlight viewer in the Vantage 
Workflow Portal Web client is supported only on Mac OS X. For more information on 
supported browsers, see Vantage Web Applications Browser Requirements.

Target Workflow Guidelines
When you configure target workflows, consider the following guidelines:

• If the operator will be submitting a job after evaluating an ingest workflow, the tar-
get workflow must have a Receive action to receive the ingest workflow binder.

• To support operator control of target workflow processing, the target workflow 
must be configured to accept and process any metadata labels and variables that 
an operator enters.

Starting a Workflow Portal Session
The following topics describe how to start sessions with the Workflow Portal clients:

 Starting a Session with the Windows Client

 Starting a Session with the Web Client

Starting a Session with the Windows Client
To start a session with the Workflow Portal Windows client, do the following:

1. Start the Windows client as described in Starting Workflow Portal.

2. If you are prompted to select a Vantage domain, select a domain as described in 
Selecting the Domain.

If you do not know the Vantage domain name, contact your Vantage domain 
administrator.

3. If you are prompted to enter a Vantage user name, log in as described in Changing 
Vantage Users in Windows Client Programs.

If you do not know your Vantage user log in information, contact your Vantage 
domain administrator.

4. If you are prompted to select a Workflow Portal configuration, enter the 
configuration specified by your Vantage domain administrator.

5. If you need to change the Workflow Portal configuration, see Changing or Reloading 
a Configuration.
Vantage User’s Guide



Using Workflow Portal
Using Vantage Workflow Portal Controls

173
Starting a Session with the Web Client
To start a session with the Workflow Portal Web client, do the following:

1. Start the Web client as described in Starting & Stopping Vantage Web Apps.

2. If you are prompted to select a Vantage domain, select a domain as described in 
Logging into or Changing Domains from Web Apps.

If you do not know the Vantage domain name, contact your Vantage domain 
administrator.

3. If you are prompted to enter a Vantage user name, log in as described in Changing 
Vantage Users in Web Apps.

If you do not know your Vantage user log in information, contact your Vantage 
domain administrator.

4. If you are prompted to select a Workflow Portal configuration, enter the 
configuration specified by your Vantage domain administrator.

5. If you need to change the Workflow Portal configuration, see Changing or Reloading 
a Configuration.

Using Vantage Workflow Portal Controls
The following topics describe Vantage Workflow Portal controls:

 Using Workflow Portal Windows Client Controls

 Using Vantage Workflow Web Client Controls
Vantage User’s Guide



Using Workflow Portal
Using Vantage Workflow Portal Controls

174
Using Workflow Portal Windows Client Controls
Figure 128 shows the Workflow Portal Windows client controls.

Figure 128. Vantage Workflow Portal Window, Controls

You can navigate through all the fields and controls by repeatedly pressing the Tab key. 
Use the Shift + Tab key combination to move through the fields in reverse order.

The following topics describe how to use the components shown in Figure 128:

• Catalog list—see Opening a Binder in the Windows Client

• Binder list—see Controlling the Binder Display

• Program menus—see Windows Client Menus

• Metadata Labels tab—see Reviewing Metadata Labels

• Create EDL tab—see Creating an EDL

• Forward to Workflows tab—see Submitting Media to Workflows

• Media viewer—see Reviewing Proxy Media Files

• Nicknames list—see Reviewing Nonproxy Media

Catalog List Binder or Thumbnail List

Nickname List

Media Viewer

Feature Tabs
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Controlling the Binder Display
Workflow Portal allows you to view binders in the catalog in two different ways:

• Thumbnail view displays an image thumbnail for each binder. 

• Details view display a list of binders, including columns containing binder meta-
data and controls.

Use the dropdown list in the binder list title bar to select Details to display binder 
names or Thumbnails to display thumbnails.

To select a binder to manage, click on the binder. In Forward binder mode, you can use 
Shift-click and Ctrl-click to select multiple binders.

To filter the binders in the binder list, click the filter button  and type characters that 
are in the binder names you want to display. Click the filter button again to display all 
binders. Workflow Portal remembers the filter names you enter, so you can click the 
filter button and select a previously entered name from the list.

Windows Client Menus
Table 5 describes the menu selections in the Vantage Workflow Portal Window client.

Table 5. Vantage Workflow Portal Windows Client Menus

Menu Selection Description

File Change Vantage Domain See Logging into or Changing Vantage 
Domains in Windows Client Programs.

Change Vantage User See Changing Vantage Users in Windows 
Client Programs.

Change Password See Changing Passwords in Windows Client 
Programs.

Change/Reload 
Application Configuration

See Changing or Reloading a Configuration.

Exit Closes the Vantage Workflow Portal 
program.
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Options Restore Tips & Warnings Select to restore the display of Workflow 
Portal tips and warnings after the feature 
has been disabled.

Hide Tips & Warnings Select to hid Workflow Portal tips and 
warnings.

Use Clip Start Time Select this option to toggle this feature. 
When a check appears to the left of this 
option, the preview window uses the start 
time defined in the proxy media. When no 
check appears, the clip start time begins at 
zero.

Help Contents Select to display a Windows help version of 
this user guide.

Index Select to display the index feature of the 
Windows help version of this user guide.

Search Select to display the search feature of the 
Windows help version of this user guide.

Online Help Select to display the Vantage product 
guides available on the Telestream, Inc. 
Web site.

About Select to display Vantage Workflow Portal 
product version information.

Table 5. Vantage Workflow Portal Windows Client Menus (Continued)

Menu Selection Description
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Using Vantage Workflow Web Client Controls
Figure 129 shows the Workflow Portal Web client controls.

Figure 129. Vantage Workflow Portal Web Page, Controls

Note: The Workflow Portal Web client does not automatically update the assets list as 
new assets arrive in catalogs. Depending upon your task, you may need to periodically 
use the refresh button to view new assets as they arrive.

The following topics describe how to use the components shown in Figure 128:

• Catalog list—see Opening a Binder in the Web Client

• Binder list—see Opening a Binder in the Web Client

• Title bar options—see Web Client Menus

• Help menu—see Web Client Menus

• Forward to Workflows tab—see Submitting Media to Workflows

• Media viewer—see Reviewing Proxy Media Files

• Nicknames list—see Reviewing Proxy Media Files

Catalog List Binder List

Nickname List

Media Viewer

Feature Tabs

Configuration List
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Web Client Menus
Table 5 describes the menu selections and title bar options in the Vantage Workflow 
Portal Window client.

Managing Jobs with Workflow Portal
When managing jobs with Workflow Portal, your first step is to determine if you are 
opening a binder or a file. 

If you are opening a binder, the typical order of tasks is as follows:

1.  Open the binder you want to manage.

2. Preview the media and metadata referenced by the binder.

3. Create an EDL (if the selected configuration supports this).

If you are opening a file, or if you have completed the above steps for a binder, the final 
step is to submit the media to a workflow. When you submit, configuration options can 
allow you to configure one or more of the following:

• Target workflow list

• Metadata labels

• Variables

Table 6. Vantage Workflow Portal Windows Client Menus

Menu Selection Description

Title bar 
options

Change Password See Changing Passwords in Windows Client 
Programs.

Logout Log out the current Vantage user.

Change Domain See Logging into or Changing Vantage 
Domains in Windows Client Programs.

Catalogs 
menu

Refresh Catalog Listings Click to refresh the display of catalogs.

Help 
menu

About Select to display Vantage Workflow Portal 
product version information.

Help Documentation Click this entry to toggle the display of the 
submenu.

User Guide Click to display the PDF version of this 
guide in a separate browser window.

Web Help Click to display the HTML version of this 
guide in a separate browser window.
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The following topics describe the typical Workflow Portal management tasks:

 Opening Binders In Workflow Portal

 Reviewing Binder Assets

 Creating an EDL

 Submitting Media to Workflows

Opening Binders In Workflow Portal
You can open binders using the Copy Binder, Forward Binder, and Create EDL 
configurations. The following topics describe how to open a binder in the two Vantage 
Workflow Portal programs:

 Opening a Binder in the Windows Client

 Opening a Binder in the Web Client

Opening a Binder in the Windows Client
To open a binder in the Workflow Portal Window client, do the following:

1. Start Vantage Workflow Portal and select a Workflow Portal configuration that 
supports opening binders as described in Starting a Workflow Portal Session.

2. In the Catalogs Panel (see Figure 130), select the catalog or catalog folder that 
contains the binder you want to open.

For information on which catalog contains the workflow you want, see your work-
flow designer. The workflow Register action defines which catalog contains the 
binder.

Note: Vantage administrators control which catalogs you can browse. You can only 
select binders in catalogs you are permitted to browse.
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Figure 130. Vantage Workflow Portal Window, Showing the Catalogs Panel

3. In the panel to the right of the Catalogs panel, select the binder that you want to 
view.

This panel displays the name of the catalog you selected. The panels below the Cat-
alogs panel display information related to the binder you selected. For more infor-
mation, see Reviewing Binder Assets.

Opening a Binder in the Web Client
To open a binder in the Workflow Portal Web client, do the following:

1. Start the Workflow Portal Web client and select a Workflow Portal configuration 
that supports opening binders as described in Starting a Workflow Portal Session.

2. In the Catalogs list (see Figure 131), select the catalog or catalog folder that 
contains the binder you want to open.

For information on which catalog contains the workflow you want, see your work-
flow designer. The workflow Register action defines which catalog contains the 
binder.

Note: Vantage administrators control which catalogs you can browse. You can only 
select binders in catalogs you are permitted to browse.
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Figure 131. Vantage Workflow Portal Web Page, Showing the Catalogs List

3. In the binders list, select the binder that you want to view.

This panel displays the name of the catalog you selected. The panels below the 
binder list display information related to the binder you selected. For more informa-
tion, see Reviewing Binder Assets.

Reviewing Binder Assets
When you open workflow media with the Copy Binder, Forward Binder, or Create EDL 
configurations, the Vantage Workflow Portal window displays all the binder assets that 
you are permitted to see. The following topics describe how to review those binder 
assets:

 Reviewing Proxy Media Files

 Reviewing Nonproxy Media

 Reviewing Metadata Labels

Reviewing Proxy Media Files
A proxy media file is a file that has been prepared by Vantage to be previewed with the 
Workflow Portal media viewer. Workflow designers can create a proxy file within a 
workflow by using a Flip action to create a QuickTime H.264 MOV file. If the workflow 
designer uses the Vantage Proxy nickname for the proxy file, the file automatically 
appears in the Workflow Portal media viewer when you open the binder.
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The following topics describe how to review proxy media in the two versions of 
Workflow Portal:

 Reviewing Proxy Media with the Windows Client

 Reviewing Proxy Media with the Web Client

Reviewing Proxy Media with the Windows Client

When you preview proxy files in the Workflow Portal Window client, you are utilizing 
the QuickTime Player to preview QuickTime H.264 MOV files. If you do not have a 
QuickTime Player installed, you will have to download and install the player before you 
can review proxy files. 

Select a binder list to specify the binder for which you want to view media. When media 
appears in the Workflow Portal preview window, you can use the window, keyboard, 
and mouse controls listed in Table 7 to control playback. You can also select media in 
the nicknames list.

Table 7. Playback Controls for Windows Client Media Viewer

Function Controls

Play/Pause  ,  (appears in binder list when visible)

Ctrl+P or Ctrl+Space

Stop Ctrl+S

Forward Frame

Ctrl+F

Ctrl + Mouse Wheel, one frame per wheel click

Forward/Reverse One 
Second

Mouse Wheel (no modifier keys)—one second per wheel 
click

Forward/Reverse One 
Minute

Shift + Mouse Wheel—one minute per wheel click

Forward/Reverse One 
Hour

Ctrl + Shift + Mouse Wheel—one hour per wheel click

Reverse Frame

Ctrl+R

Ctrl + Mouse Wheel, one frame per wheel click

Go to start

Ctrl+Home

Go to mark in frame

Click in the EDL Mark In time, then press Ctrl+G

Applies only to Create EDL configurations.
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Reviewing Proxy Media with the Web Client

When you preview proxy files in the Workflow Portal Web client, you are utilizing the 
Microsoft Silverlight Player to preview QuickTime H.264 MOV files. If you do not have a 
Microsoft Silverlight Player installed, you will have to download and install the player 
before you can review proxy files. 

Select a binder in the binder list. When media appears in the Workflow Portal media 
player, you can use the Web page and keyboard controls listed in Table 8 to control 
playback. You can also select media in the nicknames list.

Note: The Silverlight player, which is utilized in the Workflow Portal Web client, has a 
known issue related to playback behavior when attempting to jog/shuttle/seek to the 
end of a media file.
The issue manifests itself as the inability to scrub or mark at the very end of the proxy 
file being manipulated. The effects can be mitigated by scrubbing to a point just 
before the end (not less than 1% or 1 second from the end) and then playing the video 
for the remainder of the sequence. Play-to-the-end functionality works correctly.
For reference, see the Web page: https://connect.microsoft.com/VisualStudio/
feedback/details/714100/mediaelement-stops-playing-before-end.

Go to mark out frame

Click in the EDL Mark Out time, then press Ctrl+G

Applies only to Create EDL configurations.

Go to end

Ctrl+End

Adjust Volume

Scroll media

Table 8. Playback Controls for Web Client Media Viewer

Function Controls

Play/Pause  /  ,  (appears in binder list)

P

Stop

Forward Frame

I. (Arrows work, but skip several frames at a time)

Reverse Frame

O. (Arrows work, but skip several frames at a time)

Table 7. Playback Controls for Windows Client Media Viewer (Continued)

Function Controls
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Reviewing Nonproxy Media

Note: This feature is not supported in the Web client.

If the selected Workflow Portal configuration permits it, Workflow Portal displays the 
nonproxy media assets for the selected binder in the nickname list above the media 
viewer in the Vantage Workflow Portal window. If you are using the Workflow Portal 
Window client and you have a program on your computer that can open a media asset, 
you can open it as follows:

1. Right-click on the media asset in the list.

2. Select Open Containing Folder.

3. In the dialog that appears, double-click the media file you want to open.

Reviewing Metadata Labels
When the selected configuration permits it, you can view the metadata labels 
produced in the previous workflow in the Vantage Workflow Portal window. To view 
the labels that you are allowed to see, click the Metadata Labels tab. The metadata 
labels that display represent the values from the previous workflow and cannot be 
edited.

Note: When the selected configuration permits it, the Workflow Portal Window client 
displays two Metadata Labels tabs. The first Metadata Labels tab appears when you 
open a binder and displays until you submit the binder to another workflow. After you 

Go to start

Home

Go to end

End

Adjust Volume

J and K

Mute audio

M

Scroll media

Toggle full screen

F

Table 8. Playback Controls for Web Client Media Viewer (Continued)

Function Controls
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submit the binder, a second Metadata Labels tab appears that enables you to edit the 
metadata labels that will be submitted to the next workflow.

Creating an EDL

Note: Only the Create EDL configuration supports the creation of EDLs. EDLs are not 
supported in the Workflow Portal Web client.

When you are using a Create EDL configuration, the Create EDL tab displays as shown in 
Figure 132.

Figure 132. Vantage Workflow Portal Window, Showing the Create EDL Tab

To create an EDL, do the following:

1. Add clips to the EDL list.

2. Set the start and end times for each clip in the list.

3. Submit the EDL as described in Submitting Media to Workflows.

Note: The Microsoft User Account Control feature denies access to the default 
Vantage store for submitted stitched assets (EDLs). If you receive an error message that 

Open Containing 
Folder button 

Open With Default 
Program button

Mark buttons

Go to buttons
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access to the Vantage store is denied, contact your Vantage administrator. Additional 
information on this issue is provided in the Vantage Domain Management Guide.

The following topics describe how to manage the EDL:

 Adding Clips to an EDL

 Evaluating Clip Content

 Editing the Clip Start and End Times

 Deleting Clips from the EDL

 Reordering Clips in the EDL

Adding Clips to an EDL
You can add multiple clips to an EDL, and you can add the same clip multiple times. 
When submitted, the clip files are clipped to the EDL settings and merged together into 
a single output file by the target Vantage workflow.

Note: If you do not want to combine clips in one file, you can clip the same file 
multiple times. For example, if you are extracting multiple highlights from a single 
media file, you can mark a highlight, select Submit, and then mark a new highlight 
without affecting the first one.

To add a clip to an EDL, select the clip in the Binder list or the Nickname list and click the 
Add button  below the Create EDL tab.

Note: An EDL must be comprised of media file clips that have the same frame size 
and frame rate.

When you add the first clip to the EDL, the frame size and rate of the EDL are set to the 
metrics of that clip. Once the frame size and rate are set for an EDL, Workflow Portal 
does not allow you to add an incompatible clip. If you select a clip that is incompatible, 
the Add button is disabled to indicate that the clip cannot be added.

Evaluating Clip Content
After you select the first clip for an EDL, Workflow Portal displays the clip information in 
the EDL Configuration portion of the window. The EDL configuration information 
includes the frame size and the frame rate, as well as other information about the 
selected clip. The frame rate also appears in the Selected Clip portion of the window.

When multiple clips are present in the EDL, click on any clip to display the clip 
information in the EDL Configuration area.
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Editing the Clip Start and End Times
The default clip start and end times are the start and end times defined in the source 
media file. To display an entire clip, no change is necessary. To display a portion of a clip, 
edit the start and end times to define the clip you want in your EDL.

To change the clip start time do any of the following:

• Use the media viewer to select the start time and frame, then click the Mark button 
for the Mark In time.

• Click in the Mark In time setting and press CTRL-M.

• Type time or frame values in the Mark In time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark In time setting, click one of the numbers and use the up and down con-
trols to change the value.

To change the clip end time do any of the following:

• Use the media viewer to select the end time and frame, then click the Mark button 
for the Mark Out time.

• Click in the Mark Out time setting and press CTRL-M.

• Type time or frame values in the Mark Out time setting. The displayed format is: 
HH:MM:SS;FF, where HH indicates hours, MM indicates minutes, SS indicates sec-
onds, and FF indicates frames.

• In the Mark Out time setting, click one of the numbers and use the up and down 
controls to change the value.

• Adjust the duration timecode, which adjusts the mark out point relative to the mark 
in point. This field indicates the duration of the media between the mark in/out 
points of the currently selected clip.

If you specify a mark in, mark out, or duration timecode that makes one or more of the 
timecodes invalid, the affected timecodes display a red background. For example if you 
select a Mark In timecode that starts after the Mark Out timecode, the Mark In and 
Duration timecodes display red. Also, if the duration timecode moves the mark out 
timecode beyond the end of the clip timeline, both the Duration and Mark Out fields 
display red to indicate the error.

Deleting Clips from the EDL
To delete a clip in an EDL, click on the clip and click the Delete button .

Reordering Clips in the EDL
To change the order of a clip in an EDL list, click on the clip and click the up  and 
down  buttons to change the clip position.
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Submitting Media to Workflows
 Initiating Binder Submission with the Windows Client

 Initiating Binder Submission with the Web Client

 Initiating Windows File Submission with the Windows Client

 Configuring Metadata Labels

 Configuring Variables

Initiating Binder Submission with the Windows Client
When you initiate the submission of a binder, the Workflow Portal view and mode 
change from displaying media information to submitting information. In the submit 
mode, the selected configuration might allow you to select the media files to submit, 
create an EDL, configure metadata labels, configure variables, and select target 
workflows. Some of these options are limited to a particular configuration, and some of 
them can be disabled. The options that apply to your environment are defined by the 
Vantage domain administrator and the workflow designer.

The Workflow Portal configuration you have selected can be configured to support 
submission to one workflow or to multiple workflows. The selected configuration can 
also be configured to specify one or more required workflows, or you might be allowed 
to select one or more workflows from a list of workflows. 

If the selected configuration allows you to view the workflows to which you can submit, 
Workflow Portal displays a Forward to Workflows tab. If the configuration does not 
support operator viewing of the workflow list, there is a Submit button at the bottom of 
the Vantage Workflow Portal window.

The Copy Binder and Forward Binder configurations allow you to select or exclude each 
of the media files referenced in the binder. You can also submit each media file with the 
nickname from the previous workflow, or you can select a replacement nickname.

To initiate submit mode, do the following:

1. If the Vantage Workflow Portal window displays a Forward to Workflows tab, do the 
following:

– Select the Forward to Workflows tab.

– Check or clear each workflow checkbox to specify which target workflows should 
process the job.

– Click Submit to enter submit mode.

2. If Workflow Portal does not display a Forward to Workflows tab, do one of the 
following to initiate submit mode:

– Click the Submit button at the bottom of the window.

– If the binder list is in Details mode, click the Submit button to the right of the 
binder name in the binder list. (This button is not displayed in Thumbnails 
mode.)
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3. If the Media Files tab is present, select the media files to submit as follows:

a. Select the Media Files tab.
b. Check or clear the checkbox to the left of each media file name. 

A check mark causes the media to be submitted.

c. In the Change nicknames during submit list, check the box to the left of any media 
file you want to rename.

d. For each media file that you rename, select a new nickname in the dropdown list 
to the right of the media name.

4. If other configuration settings are available, Workflow Portal displays a dialog in 
which you can configure those options. For more information, refer to Configuring 
Metadata Labels and Configuring Variables.

5. When you are done preparing for submission, click Submit.

Initiating Binder Submission with the Web Client
When you initiate the submission of a binder, the Workflow Portal view and mode 
changes from displaying media information to submitting information. In the submit 
mode, the selected configuration might allow you to configure metadata labels, 
configure variables, and select target workflows. Some of these options are limited to a 
particular configuration, and some of them can be disabled. The options that apply to 
your environment are defined by the Vantage domain administrator and the workflow 
designer.

The Workflow Portal configuration you have selected can be configured to support 
submission to one workflow or to multiple workflows. The selected configuration can 
also be configured to specify one or more required workflows, or you might be allowed 
to select one or more workflows from a list of workflows. 

If the selected configuration allows you to view the workflows to which you can submit, 
Workflow Portal displays a Forward to Workflow tab. If the configuration does not 
support operator viewing of the workflow list, Workflow Portal displays a Submit 
button.

To initiate submit mode, do the following:

1. If the Vantage Workflow Portal window displays a Forward to Workflows tab, do the 
following:

a. Select the Forward to Workflow tab.
b. Check or clear each workflow checkbox to specify which target workflows should 

process the job.
c. Click Submit to enter submit mode.
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2. If Workflow Portal does not display a Forward to Workflows tab, do one of the 
following to initiate submit mode:

– Click the Submit button.

– Click the submit button  to the right of the binder name in the binder list.

If no other configuration options are available, the binder is submitted to the 
selected workflows.

3. If other configuration settings are available, Workflow Portal displays a dialog in 
which you can configure those options. For more information, refer to Configuring 
Metadata Labels and Configuring Variables.

4. When you are done preparing for submission, click Submit.

Initiating Windows File Submission with the Windows Client

Note: This feature is not available in the Workflow Portal Web client.

When you initiate the submission of one or more media files, Workflow Portal either 
immediately submits the files or it enters submit mode. In submit mode, the Browse 
Network configuration might allow you to configure metadata labels or variables. The 
options that apply to your environment are defined by the Vantage domain 
administrator and the workflow designer.

The Workflow Portal configuration you have selected can be configured to support 
submission to one workflow or to multiple workflows. The selected configuration can 
also be configured to specify one or more required workflows, or you might be allowed 
to select one or more workflows from a list of workflows. 

If the selected configuration allows you to select the workflows to which you can 
submit, Workflow Portal enables checkboxes in the Submit to workflows list. If the 
configuration does not support operator selection of workflows, the checkboxes are 
disabled in the Submit to workflows list.

To initiate submit mode, do the following:

1. Start Vantage Workflow Portal and select a Workflow Portal configuration that 
supports Browse Windows mode as described in Starting a Workflow Portal Session.

Workflow Portal displays the Vantage Workflow Portal window shown in 
Figure 133.
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Figure 133. Vantage Workflow Portal Window for Windows File Submission

2. Click the Browse button.

Workflow Portal displays the Select media file(s) to submit dialog shown in 
Figure 134.

Figure 134. Select Media Files to Submit Dialog
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3. Use the Select media file(s) to submit dialog to select files from Windows directories.

To select multiple files in a given directory, Shift-click and Control-click as needed 
to select files.

4. Click Open.

Each file that you open appears in the Select media file(s) list as shown in Figure 133.

You can repeat the selection process to select files from multiple directories. The 
Browse button is additive—that is, each time you repeat the process of navigating 
to a location and choosing a file or files to submit, they are added to the Files list. 

If the file list is not correct, you can edit the list manually. For example, you can 
select a given file path and delete it. Or, you can edit a path or filename, copy and 
paste file paths, or add new ones. To delete the list entirely, click Clear.

5. If any checkboxes are enabled in the Target Workflows list, check the checkbox for 
any target workflow to which you want to submit.

If a checkbox is checked and not editable, this workflow is required by this configu-
ration.

6. Click Submit.

If the selected configuration does not provide any additional configuration options, 
Workflow Portal submits the selected media files to each of the selected Target 
Workflows.

7. If the selected configuration supports either the metadata labels or the variables 
option, Workflow Portal displays the Submit Jobs dialog with tabs for the enabled 
options. For information on configuring these options, refer to Configuring 
Metadata Labels and Configuring Variables.

8. If you are done preparing for submission, click Submit.

Configuring Metadata Labels
If you are submitting media from a previous workflow, any metadata labels in that 
previous workflow are included when you submit. If the selected configuration 
supports metadata label entry and editing, you can configure metadata labels before 
you submit. All metadata labels are applied to all media files that are being submitted.

The following topics describe how to configure metadata labels:

 Configuring Metadata Labels with the Windows Client

 Configuring Metadata Labels with the Web Client

Configuring Metadata Labels with the Windows Client

If the selected configuration supports metadata label entry, you can configure 
metadata labels as follows:

1. Initiate submit mode as described in the appropriate one of the following topics:

–  Initiating Binder Submission with the Windows Client

– Initiating Windows File Submission with the Windows Client

2. Select the Metadata Labels tab.
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Figure 135. Submit Jobs Window, Browse Network Configuration

3. If the Metadata Label you want to configure appears in the Metadata Label list, 
select that label.

4. In the Parameter list to the right of the Metadata Label list, configure the metadata 
label parameters.

5. If the metadata label you want to configure does not appear in the Metadata Label 
list, click the new label button, select a label to add, and click OK.

Note: This option is not available when submitting files in a Browse Network 
configuration.

6. Repeat metadata label selection and parameter configuration until all required 
metadata labels are configured.

7. If you need to configure variables, see Configuring Variables.

8. When you are done preparing for submission, click Submit.
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Configuring Metadata Labels with the Web Client

If the selected configuration supports metadata label entry, you can configure 
metadata labels as follows:

1. Initiate submit mode as described in Initiating Binder Submission with the Web Client.

Figure 136. Vantage Workflow Portal Window, Metadata Labels in Web Client

2. To add a metadata label to configure, do the following:

a. Click Add Label.
b. Select a label to add from the Add Metadata Labels dialog.
c. Click Add.

3. To configure metadata label parameters, locate the tab for the label, select the tab, 
and configure the label parameters.

4. To remove a metadata label configuration, locate the tab for the label, select the 
tab, and click Remove Label.

5. Repeat metadata label selection and parameter configuration until all required 
metadata labels are configured.

6. If you need to configure variables, see Configuring Variables.

7. When you are done preparing for submission, click Submit.

Configuring Variables
Variables are not forwarded from one workflow to another, but the selected 
configuration can allow you to add variable values for a target workflow before you 
submit. If the selected configuration supports variable entry, all variables that you 
define are applied to all media files that are being submitted.
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If the selected configuration supports variable label entry, configure variables as 
follows:

1. Initiate submit mode as described in the appropriate one of the following topics:

–  Initiating Binder Submission with the Windows Client

– Initiating Binder Submission with the Web Client

– Initiating Windows File Submission with the Windows Client

2. Select the Variables tab.

Figure 137. Variables Tab, Browse Network Configuration, Windows Client

3. Scroll through the list of variables and set each one as needed.

4. If you need to configure metadata labels, see Configuring Metadata Labels.

5. When you are done preparing for submission, click Submit.

For each media file in the list, a job is submitted.

Changing or Reloading a Configuration
If the Vantage domain administrator updates a Workflow Portal configuration while 
you are using it, the program continues to use the configuration as it was when you 
selected it. 

To change or reload a configuration in the Windows client, do the following:

1. Select File > Change/Reload Application Configuration.

2. When the Select Configuration dialog appears, select a configuration to use and 
click OK.

To change or reload a configuration in the Web client, do the following:

1. Select Portals.

2. Select the configuration to which you want to change.

3. When the confirmation dialog appears, click OK.
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Deleting Binders from a Catalog
If your Workflow Portal configuration permits it, you can delete binders from the 
catalog. You might want to delete a binder because it is no longer needed or because 
the job quality did not meet standards.

Note: Binder deletion can be controlled by workflow designers and the Vantage 
domain administrator. For example, workflow designers and Vantage administrators 
can set a job expiration time, which results in a scheduled deletion of the binder.

Binder removal removes all temporary job data and related media files in the Vantage 
store that was used for the job. Binder removal does not remove input or output 
media files that are stored outside the Vantage store.

To delete a binder, do the following:

1. Open the catalog where the binder is located.

2. Select the binder name from the binder detail list or the binder thumbnail from the 
thumbnails view (see Figure 138).

Figure 138. Binder Detail List, Windows Client

 

3. Click the Delete  button at the top of the list to permanently remove the binder 
from the catalog.

Troubleshooting Workflow Portal
When opening Workflow Portal for the first time, depending on the design of your 
network and the location of your workstation and Vantage server, the Domain login 
dialog may not display the domain. If this is the case, you can log in by using the name 
or IP address of the server.

When you change domains or configurations, you may also encounter these problems:

• No Configurations Available...

Workflow Portal displays this error when you log onto a domain where no Workflow 
Portal configurations are defined or where you do not have access to any of the 
defined configurations.

Contact your Vantage domain administrator.
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• No session licenses available for this application...

The domain you logged on to is not licensed for running Workflow Portal or all 
available licenses are in use. Workflow Portal will operate in unlicensed/demo 
mode and will not allow you to submit jobs or edit metadata labels until a Work-
flow Portal license becomes available.

Contact your Vantage domain administrator.

Note: An administrator can release a license in the Vantage Management Console.

• Problem communicating with database—could not find stored procedure Select-
SessionsByExecution...

This error displays when Workflow Portal is attempting to display a list of configura-
tions from the selected domain, but the version of the domain is not compatible 
with your client. Contact your Vantage domain administrator to upgrade your 
Workflow Portal software.

• The requested workflows are either not running or no longer exist...

This error displays when you submit an asset or media file to a workflow that has 
been deleted, or is not activated. Contact your Vantage domain administrator, who 
can activate the Vantage workflow or edit the configuration to correct the problem.
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Using the Job Status
Views Web

Application

Job Status Views is a Web application that enables basic Vantage job management via a 
Web browser. You can use Job Status Views to access job information and manage jobs 
in your Vantage domain from anywhere on the LAN, or via the Internet when you 
establish an internet connection.

Note: For information about Vantage Web application requirements, starting and 
stopping Web applications, and other basic topics, see Vantage Program Management.

This chapter presents the following topics:

 About the Job Status Views Web Application

 Job Status Views Web Application Overview

 Displaying and Hiding the Title Panel and View Panels

 Using Public and Private Views

 Sorting Jobs by Column

 Paging Through Job Tables & Setting Page Size

 Filtering the Job Table

 Highlighting Job States Row by Row

 Managing Jobs

 Troubleshooting

About the Job Status Views Web Application
You can use Job Status Views to do the following:

• Display information about submitted jobs

• Sort and filter job entries

• Highlight and identify jobs in different states

• Stop, restart, and delete jobs

• Troubleshoot job processing issues.



Using the Job Status Views Web Application
Job Status Views Web Application Overview

200
The views that you see in Job Status Views are defined by Vantage administrators, who 
control which job information displays and which job control functions (such as the 
ability to delete a job) are allowed. Views may be public or private. Public views are 
available to everyone, and private views are for use by specified Vantage users.

Job Status Views Web Application Overview
After logging in, the Job Status Views Web application displays the jobs table, as shown 
in Figure 139.

Figure 139. Job Status Views Job List

The Job Status Views display is presented in three panels:

• Title panel—Displays the home button, Vantage domain and user name, and con-
trols to manage the user password, change domains, and to log out of the domain.

• View panel—Displays views, which define which jobs are listed in the job list. This 
panel also includes controls to display product version information and this user 
guide.

• Job list panel—Displays the job list in table format, along with the program’s tool-
bar, which contains command buttons and menus.

Title 
panel

Views 
panel

Job list 
panel

User & domain 
info, controls.

Home menu 
button.

Page buttons and page size

Show/
Hide panel 
controls.

Currently selected 
view.

Toolbar
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Note: If you do not log in with a Vantage username, private views display None 
Available.

The following sections describe how to manage the program display:

 Displaying and Hiding the Title Panel and View Panels

 Using Public and Private Views

 Sorting Jobs by Column

 Paging Through Job Tables & Setting Page Size

 Filtering the Job Table

 Highlighting Job States Row by Row

Displaying and Hiding the Title Panel and View 
Panels

To display or hide the title or view panels, click the show/hide controls, as shown in 
Figure 139.

Using Public and Private Views
All views are defined either as public or private, and are created and configured in the 
Management Console. Click on the view to select it, and display jobs for this workflow. 
Only private views that are enabled for your Vantage user name are listed.

The default view is the All Workflows public view, which displays jobs for all workflows. 
The information that All Workflows displays depends on how it is configured in the 
Management Console, and whether it is enabled or not. If no private views have been 
defined, or if you log in as Public, the Private Views list displays None Available. 

The following topics provide more information on views:

 About Public and Private Views

 About View Definitions

About Public and Private Views
Public views are views that the Vantage administrator has made available to all Vantage 
users. Anyone who connects to the Vantage domain can display public views in the Job 
Status Views Web application.

Private views are views that are available only to those Vantage users for which the 
Vantage administrator has enabled access. The administrator might configure custom 
views for different departments, users by role, or customers, and limit access to those 
views to the appropriate users.
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About View Definitions
All views that you create are based on a specific workflow. In addition to being public or 
private, views limit the information that is displayed and specify which job control 
features (if any) the user has to use. If no controls are enabled, the view is considered a 
read-only view. You cannot create or configure views directly in Job Status Views; views 
are created by the Vantage administrator, via the Vantage Management Console, and 
specified as public or private; enforced by which user logs in.

There are many options for views, and displaying all options usually provides too much 
information for most applications. For example, it might be more convenient to display 
fewer columns. This view might only display active jobs, and it might disable controls 
that allow jobs to be restarted, stopped, or deleted.

The following topics provide information on what can be customized (and thus, may or 
may not be present) in views

 Displaying Items in Views

 Controls in Views

Note: Administrators should refer to the Vantage Domain Management Guide for 
information on how to set up custom views.

Displaying Items in Views
Two items of information are always displayed as columns in a view:

• Job—The name of the workflow for each job.

• State—The current state of the job, which can be:

– Complete

– Failed

– In Process

– Paused

– Stopped by User

– Waiting

– Waiting to Retry

Four optional items of information can be added as columns in a view:

• Total Progress—The progress of the job (in percent) if still running.

• Started—The date and time the job was started.

• Updated—The date and time the job was last updated.

• Expires—The date and time when the job expires and will be deleted.
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Controls in Views
An administrator can configure the following controls in a view:

• Enable—Enables or disables use of the view.

• Show Only Active Jobs—Displays only active jobs.

• Read Only Access—Disables the use of the stop, restart, and delete controls for 
managing jobs.

Sorting Jobs by Column
To sort the displayed job list according to the entries in any column, click that column 
label. Each time you click the column label, the sort changes in the following sequence: 
ascending order, descending order, and default sort order.

Paging Through Job Tables & Setting Page Size
A job table may span multiple pages. Use the page size control at the bottom center of 
the job list to specify the number of jobs to display on a page.

The page controls on the bottom left allow you to change pages and jump to the first 
or last page of a job list. Figure 140 shows where the page controls appear in the job 
panel.

Figure 140. Job List, Showing Page Controls

Filtering the Job Table
Job filters allow you dynamically control which jobs display in the job table. The default 
configuration displays all jobs specified in the view for the workflow. However, during 
troubleshooting, you might want to display only those jobs that are in a failure state. 
Other times, you might want to display only those jobs that are in progress.

Page controls Page size
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To display the Job List filters, click Show Filters in the toolbar. The filters are displayed 
directly below the column titles in the job list table, as shown in Figure 141.

Figure 141. Job List, Showing Job Filters

To hide filters, click Show Filters again.

Which jobs display in the job list is determined by all the filters working together to 
filter the list. If multiple filters are configured, the job list includes all jobs that meet the 
criteria of all configured filters.

 Setting the Job Name Filter

 Setting the Job State Filter

 Setting the Total Progress Filter

 Setting the Date and Time Filters

Setting the Job Name Filter
You can use the job name filter to limit the job list display to only those jobs with a 
name that meet criteria you specify. The following sections describe how to set and 
clear the job name filter:

 Specifying a Job Name Filter

 Clearing the Job Name Filter

Specifying a Job Name Filter
To specify a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box above the job names, enter text that is part of job names that you 
want to include or exclude from the list.
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3. Click the control to the right of the filter text box and select one of the following 
filters:

– Contains. Displays all jobs that have a name that contains the text you specified.

– DoesNotContain. Displays all jobs except those that have a name that contains 
the text you specified.

– EqualTo. Displays only those jobs that have names that exactly match the text 
you specified.

– NotEqualTo. Displays all jobs except those that have a name that exactly matches 
the text you specified.

Clearing the Job Name Filter
To clear a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter text box and select No Filter.

Setting the Job State Filter
The job state filter allows you to selectively exclude jobs from the job list based on the 
job state. The default configuration displays jobs for all of the following job states:

• Complete

• Failed

• In Process

• Stopped By User

• Waiting

• Waiting to Retry

When the job state filter is set to display jobs in all states, the filter name for the State 
column is All States. When the job state filters disable the display for jobs in one or more 
states, the filter name for the State column changes to Custom.

To specify a state filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control below the State column head and check and clear the checkboxes 
to define the states for which you want to display jobs.

Setting the Total Progress Filter
You can use the total progress filter to limit the job list display to only those jobs that 
meet progress criteria that you specify. The following topics describe how to set and 
clear the total progress filter:

 Specifying a Total Progress Filter

 Clearing the Total Progress Filter
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Specifying a Total Progress Filter
To specify a total progress filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box below the Total Progress column name, enter the progress level you 
want to include or exclude from the list. The range is 0% to 100%. 

3. Click the control to the right of the total progress text box and select one of the 
following filters:

– Contains. Displays all jobs for which the total progress includes the value you 
specified.

– DoesNotContain. Displays all jobs except those for which the total progress 
includes the value you specified.

– EqualTo. Displays only those jobs for which the total progress matches the value 
you specified.

– NotEqualTo. Displays all jobs except those for which the total progress matches 
the value you specified.

Clearing the Total Progress Filter
To clear a job name filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the Total Progress text box and select NoFilter.

Setting the Date and Time Filters
The date and time filters allow you to limit the job display list to jobs that started, 
updated, or will expire within a specified time period. There are three separate date and 
time filters for:

• Started

• Updated

• Expires

The following topics describe how to set and clear the date and time filters:

 Specifying a Date and Time Filter

 Clearing a Date and Time Filter

Specifying a Date and Time Filter
To set any of the date and time filters, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter label box in the appropriate column.

If the filter label box is empty, no filter is defined. If a filter is defined, the filter label 
box displays Custom.
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3. In the panel that appears, click on the calendar and clock buttons to set the date 
and time for the period start and period end.

If you omit the period From date and time, the program displays all jobs up to the 
To date and time. If you omit the period To date and time, the program displays all 
jobs after the From date and time.

4. When the period is defined, click Apply.

Clearing a Date and Time Filter
To clear a date and time filter, do the following:

1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control to the right of the filter label box.

3. Click Clear.

Highlighting Job States Row by Row
Job state highlighting allows you to use colors to make the different job states more 
visible. Or, you can use the same color for all job states to draw less attention to the job 
states.

To toggle job state highlighting, click the Highlight State Rows button in the toolbar. 
Each time you click the button, the job state highlighting changes from the current 
state to the opposite state.

Managing Jobs
Job management, when enabled in a view, enables you to stop, restart, and delete jobs.

The following topics describe how to stop, restart, and delete jobs:

 Stopping Jobs

 Restarting Jobs

 Deleting Jobs

Stopping Jobs
You might want to stop a job to make Vantage resources available for another job, or 
you might stop a job in preparation for system maintenance. 

To stop a job, do one of the following:

• Right-click on a job in the job list, and select Stop.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Stop.
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Restarting Jobs
Jobs can be stopped by service or network interruptions, or an operator might stop a 
job to give another job priority. To restart a job, do one of the following:

• Right-click on a job in the job list, and select Restart.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Restart.

Deleting Jobs
You might want to delete a job because the job has failed, or because the output file is 
no longer needed, for example.

To delete a job, do either of the following:

• Right-click on a job in the job list and select Delete.

• Select a job in the job list, then click the Options menu in the toolbar, and select 
Delete.

Troubleshooting
Job Status Views enables troubleshooting and correction at the job level. For more 
comprehensive troubleshooting, use the Vantage Web Dashboard.

The first step in Vantage troubleshooting with Job Status Views is to identify the jobs 
that are having problems. There are several ways to do this:

• Enable Highlight State Rows to indicate job status with colors. Failed jobs are high-
lighted in red, and other states have distinct colors. (See Highlighting Job States Row 
by Row for more information.)

• Click the State column head to sort the jobs by the current state, then locate the 
group of jobs you want to investigate.

• Use filters to display only the jobs in the state you are investigating. (See Filtering 
the Job Table for more information.)

After you locate the jobs with issues, look for common traits among those jobs. The 
following are some possible issues and suggestions for resolution:

• All jobs are failed or waiting. Look for network, database, or service issues. If all jobs 
within a certain time period had problems, there might have been a temporary 
issue that has since been corrected. Restart failed jobs as described in Restarting 
Jobs.

• All jobs for a specific workflow have failed or are waiting. Look for issues with the 
workflow. Has the workflow ever worked? Are all resources used by that workflow 
available?
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• All jobs for a particular watch folder or destination have failed or are waiting. If you 
know that all the troubled jobs use the same watch folder or destination, it could 
be that the location is not available. 

After you resolve a problem, some jobs might restart on their own, and others might 
require further action from you. If your view is so enabled, you can take the following 
actions on jobs in the job list:

• Restart—Restart stopped jobs as described in Restarting Jobs.

• Delete—Delete jobs as described in Deleting Jobs.

• Stop—If a job seems unlikely to complete or stop, you can stop the job as 
described in Stopping Jobs. Once a job is stopped, you can try to restart the job or 
delete it.
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An action is the smallest unit of work that can be specified in a Vantage workflow. 
Actions are connected together in a workflow to perform a useful task. Each action 
must be configured to perform its task in the context of the workflow, using an action 
inspector. Action inspectors are specific to each type of action.

Actions are grouped by functional categories: communication, transcoding, file 
operations, metadata processing, etc. Each action is defined by the specific task it 
performs. For example, an email action, or a metadata label/file transformation action.

Actions have limited interdependency, and so, are very flexible. You may impose 
limitations on actions in a workflow. For example, you might require action B to depend 
on action A in a Vantage workflow.

Actions—during execution—operate on binders, variables, and states, and they 
generate an action state when they complete. Actions are executed by Vantage 
services, which perform the requirements of the action.

action state

The action state describes the condition of an action execution in process and after 
completion.

During execution, an action may be Queued | Paused | In Process | Waiting. After 
execution, an action's final state may be Success | Ignore | Fail. Certain actions (Decide/
Examine/Compare/Identify, for example) allow the use to specify the post-execution 
state, including Ignore. For all other actions, the post-execution state is set by the 
service, and is either Success or Fail. These states display in the Vantage Workflow 
Designer Job Status tab.

Action states are always passed to subsequent actions. The incoming state is tested by 
the next actions to determine whether or not following actions should execute.

Some actions allow you to specify that an action should execute on a specific state 
(right-click the action, and select Perform On > Success | Fail | Ignore | Any).

If an action fails, then the next action will inherit the Fail state and (in most cases) will 
not execute. If one action fails, the entire job fails.

Similarly, if you specify an action to set the Ignore state, the next action will inherit the 
Ignore state and will also likely not execute. Certain special actions, such as Message, 
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can be configured to perform on any state (Fail, for example)—this allows workflows to 
send an email if they detect a failure.

Action states have precedence when an action receives states from multiple incoming 
actions (a merge of multiple branches):

• If at least one incoming state is Fail, regardless of other incoming states, the action 
will inherit the Fail state. Fail has precedence over all action states.

• If there is no Fail state, but at least one Success state, then the action will inherit the 
Success state. Success has precedence over Ignore states.

• If all incoming states are Ignore, the action will inherit the Ignore state. Ignore has 
lowest precedence of the three states. If an action receives an Ignore state and does 
not explicitly fail, then it emits a Success state. Otherwise, it emits a Fail state unless 
it is an action which can emit Ignore, and you have configured it to do so.

Agility service

The Agility service is the Vantage component which executes the actions relating to 
Agility job submission and interaction with Agility: Job Profile, and Job XML. Agility 
features are enabled in Vantage Enterprise Master Control.

All-in-one domain

An all-in-one (single-server) Vantage domain is one in which all server components of 
Vantage—the Microsoft SQL Server database, all Vantage services, and the optional 
Vantage Web Applications—are installed and operate on a single computer.

Analysis service

The Analysis service is the Vantage component which executes the actions relating to 
the analysis of content: Examine, Compare, and Identify.

Archive action

An Archive action, which is executed by the Staging service, uses the selected archiver 
(TAR, for example) to convert the selected input file to another format, usually in 
preparation for copying, moving, or deploying a file to a given system that has special 
file format requirements.

Associate action

An Associate action uses the Monitor service to continually (and at regular periods) poll 
a target location (a directory, for example) on a device or file system (FTP, network 
folder, etc.) to discover new files, based on some permutation of the name of the file 
being processed.

Associate actions can be executed on any action state.

Generally, the Associate action uses the file name of an existing media file or 
attachment as the basis for discovering new files. For example, if media file 
Vantage.mpg is currently in the workflow, then the Associate action may look for 
Vantage.scc. This behavior can be configured in the Associate action's inspector.

Associate actions begin executing when a job is submitted, and execute until a new file 
is discovered—subsequent actions do not execute until the file is found. When the new 
file is discovered, the Associate action makes the file available to the other actions in 
the workflow.
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Configuration is accomplished in the inspector, and is based on the target device/file 
system being monitored and other requirements.

attachment

An attachment is a non-media file that is associated with media during execution of a 
workflow. For example, an attachment may be an XML file that contains metadata, an 
SCC caption file, or an STL or PAC subtitle file. An attachment may also be a PDF file, 
Excel spreadsheet, or Word document, for example. Attachments are identified and 
processed using nicknames for simplicity. Processing is optional—attachments may be 
simply passed through a workflow for storage with the processed media and registered 
in a Vantage catalog.

attachment nickname

An attachment nickname is an alias or alternate name that is assigned to an attachment 
file during Vantage workflow execution. When an attachment file is submitted to a 
workflow, the actual file name and location is stored in a Vantage binder along with a 
nickname as defined in the workflow. Within the workflow, all references to a file are by 
nickname. However, when Vantage needs to access a file, Vantage uses the actual file 
name and location stored in the binder.

See media nickname and nickname.

Aurora action

An Aurora action uses the Aurora service to enable Vantage workflows to utilize and 
interact with various QC tests provided by the Digimetrics Aurora software. The tests 
provide the ability to determine whether a particular input media (specified by 
nickname) either passes or fails a particular QC check. Each test also generates a report 
file that may be utilized during later stages of the workflow.

binder

A Vantage binder is serves as a scratch pad where all important information for a job is 
stored. A binder is a Vantage container that contains media file references and 
metadata labels for a specific job. The binder does not contain media files or 
attachments; it contains the paths to those files. The binder also contains the media 
and attachment nicknames that map to each referenced file. The binder tracks all 
relevant job data until deleted manually or by job expiration policies.

catalog

See Vantage catalog.

Catalog service

The Catalog service is the Vantage component that executes the Register and Exist 
actions.

See Register action and Exist action.

common actions

Common actions are actions that are implemented in, and executed by, every Vantage 
service; they are not restricted to a single service.

See Receive action, Forward action, Decide action, Compute action, Construct action, 
Synchronize action.
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Communicate service

The Communicate service is the Vantage component that executes the actions relating 
to electronic messaging.

See Message action, Notify action.

Compare action

A Compare action uses the Analysis service to compare media files based on certain 
metrics (for example, PSNR). These metrics can generally be published as variables or as 
metadata labels.

Compute action

A Compute action, which is implemented in every service, performs various arithmetic 
and string manipulation functions, permitting you to create and modify values in 
variables, for use in downstream actions.

Construct action

A Construct action, which is implemented in every service, enables you to construct 
complex strings, paths, and math expressions from literals, variables, and tokens, for 
use in downstream actions.

Copy action

A Copy action is executed by the Transport service and is used to replicate a file from a 
source target (file system/device and directory) to a destination target (file system/
device and directory). It typically performs this task by copying the file to the 
destination.

Copy actions can be executed on any action state.

database

The term database is the common term used to refer to the Vantage domain database, 
where all specifications for the domain are stored, along with workflows and job 
history.

Decide action

A Decide action, which is implemented in every service, is an action which allows you to 
explicitly set the action state based upon analysis of variable values at runtime. It is 
most commonly used to determine whether or not subsequent actions (or actions in a 
given branch) in a workflow should execute.

When the Decide action is used, the state set by the Decide action is passed to the next 
action. Typically, more than one Decide action is required to support decision branches. 
For example, if one branch is for HD media, it will start with a Decide action that will set 
the state to Success for HD content, or set it to Ignore otherwise; if another branch is for 
all other media, it will start with a Decide action that performs the opposite behavior.

See variable, action state.

Delete action

A Delete action is executed by the Transport service, and is used to permanently remove 
a file from a source target (file system/device and directory). Delete actions can be 
executed on any action state.
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Deploy action

A Deploy action is executed by the Transport service, and is used to save the specified 
files to a destination outside the Vantage domain. Unlike Delete, Move, or Copy actions, 
Deploy actions allow multiple files to be operated on simultaneously, and do not 
maintain a reference to those files in the binder after completion.

Edit Decision List

A Vantage edit decision list (EDL) is a list of clips that will be merged together in a target 
clip. The list entries specify the start and stop of the clip, and Vantage supports list 
entries from multiple media files. Vantage operators use Vantage Workflow Portal 
(VWP) to create EDLs.

Examine action

An Examine action uses the Analysis service to evaluate the video and audio of a media 
file to measure certain characteristics, such as audio loudness, or to detect 
characteristics, such as the presence and size of curtains. You can configure it to publish 
metadata or variables containing the results of analysis.

Exist action

An Exist action uses the Catalog service, and allows you to determine if a binder of a 
given name (or name fragment) is present in a specified catalog.

Flip action

A Flip action is executed by the Transcode service, and implements the specified codec, 
which is used to transcode decoded digital baseband media into another media 
encoding format. The Telestream Media Transcode and Analysis engine performs the 
transcode on behalf of Vantage.

Forward action

A Forward action, which is implemented in every service, forwards a binder and all 
current variables to another workflow, starting a new job with the target workflow. A 
Forward action may be added to the end of a workflow, and requires that the target 
workflow have a Receive action as its first action.

Typically, workflows are created with a Receive action when they are intended for 
execution by another workflow that immediately precedes this one. This ability to chain 
workflows enables you to create comprehensive, intelligent run-time switching 
workflows consisting of smaller workflows used as building blocks.

See Receive action.

Gather action

A Gather action is implemented by the Staging service, and collects one or more files 
from a specified server and directory (and optionally, its subfolders), and brings them 
into the workflow as attachments. Use of a file matching pattern allows you to select 
only certain types of files.
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hot folder

A hot folder is a directory on a server that has been identified as a directory for storing 
media to be processed by a workflow in Vantage. When the workflow monitor identifies 
new media in this folder, it is submitted for processing.

inspector

An inspector is a series of one or more panels in Vantage Workflow Designer that 
facilitate the setup and configuration of a given action. Inspectors are unique to each 
action—for example, configuring a Watch action is very different than configuring a 
Flip action.

Identify action

An Identify action uses the Analysis service to determine certain properties of a media 
file, such as codec type, video bit rate, or file size. This information can then be 
published as a metadata labels or variables.

job

A job is an execution of a Vantage workflow. Jobs have a state (separate from action 
states), and jobs are comprised of actions that are executing. Jobs, like actions, may be 
in-process or they may be complete. 

As a job executes, each action may be performed by any service (on any computer) in 
the Vantage domain that is capable of performing it. The capability of a service to 
perform a specific job depends on its current operating state, its workload, and its 
suitability, defined by a qualification rule.

Jobs for a given workflow can be viewed in the Vantage Workflow Designer by 
selecting the workflow in the Workflow Designer panel and displaying the Job Status 
tab. Alternatively, all in-process and failed jobs within a Vantage Domain may be 
viewed in the Status details panel of the Management Console.

Job Profile action

Use the Job Profile action (which is executed by the Agility service) to submit jobs to 
Agility for processing; definition of the job is provided directly in Vantage by 
configuring the action.

Job XML action

Use the Job XML action (which is executed by the Agility service) to submit jobs to 
Agility for processing; definition of the job is provided in an XML file.

job routing

See qualification rule and run on rules.

job state

A job state is the current condition of a job. Keyword values are Start | Pause | Success | 
Fail | In Process.

Job Status Views Web Application

The Vantage Job Status Views Web Application enables you to view real-time information 
about jobs in the domain from anywhere on your network with a Web browser. Job 
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Status Views is installed on a Vantage Web server and is available with the Enterprise 
Control and Master Control licenses.

label

A label or metadata label defines a set of metadata by use of name/value pairs 
associated with content. For example, a spot label may contain Agency, Author, ISCI, 
and other metadata values; this set of metadata is collectively called a Spot metadata 
label. Metadata labels are stored in binders with the associated media and attachment 
files.

Vantage supplies a set of default metadata labels for use in workflows. In addition, you 
can create and modify labels for your use using the Management Console (Workflow 
Design Items > Metadata Labels).

license

A Vantage license is stored in the Vantage domain database and enables one or more 
Vantage features within a Vantage domain. Generally, licenses are imported as XML 
files into the database through the Vantage Management Console.

MediaMate action

A MediaMate action is used to provide screen subtitling, by utilizing various subtitling 
systems from Screen.

media nickname

A media nickname is an alias or alternate name that is assigned to a media file during 
Vantage workflow execution. When a media file is submitted to a workflow, the actual 
file name and location is stored in a Vantage binder along with a media nickname as 
defined in the workflow. Within the workflow, all references to a file are by media 
nickname. However, when Vantage needs to access a file, Vantage uses the actual file 
name and location stored in the binder.

See attachment nickname and nickname.

MediaMate action

An MediaMate action uses the MediaMate service to enable Vantage workflows to 
utilize and interact with the Subtitling capabilities of Screen MediaMate. Each subtitling 
option provides different capabilities that relate to the subtitle process.

Message action

A Message action is implemented in the Communicate service and enables you to 
generate and transmit an electronic Message—an email, for example. A Vantage 
administrator must configure Vantage to use an SMTP server (Vantage Management 
Console: Settings & Options > Email) before email can be utilized.

Metadata service

The Metadata service is the Vantage component that executes the actions relating to 
the transformation of metadata between labels, variables, and XML files.

See also Populate action, Transform action.
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Monitor service

The Monitor service is the Vantage component that executes the actions relating to the 
discovery of files and starting jobs.

See also Watch action, Associate action.

Move action

A Move action is executed by the Transport service, and is used to move a file from a 
source target (file system/device and directory) to a destination target (file system/
device and directory). It typically performs this task by copying the file to the 
destination, then deleting the source.

Move actions can be executed on any action state.

Multiscreen Flip action

Multiscreen Flip actions are an optional, license feature. Multiscreen Flip actions are 
executed by the Multiscreen service which only runs on a Lightspeed sever, and 
implement the specified codec, which is used to encode and package decoded digital 
baseband media into adaptive rate streaming formats, including Adobe HDS, Apple 
HLS, Microsoft HSS, and others. Transcoding is performed by the Telestream Media 
Transcode and Analysis engine on behalf of Vantage.

nickname

A nickname is an alias or alternate name that is assigned to a media or attachment file 
during Vantage workflow execution. When a media or attachment file is submitted to a 
workflow, the actual file name and location is stored in a Vantage binder along with a 
nickname as defined in the workflow. Within the workflow, all references to a file are by 
nickname. However, when Vantage needs to access a file, Vantage uses the actual file 
name and location stored in the binder.

Nicknames may refer to either media files or attachment files. Certain actions only allow 
the use of certain nickname types. For example, a Flip action only allows media file 
nicknames to be used as the inputs and outputs. However, other actions (such as the 
Move and Copy actions) operate on any type of file and allow the use of any nickname.

See attachment nickname and media nickname.

Notify action

A Notify action is implemented in the Communicate service, and is an action which 
saves job information to a file, or which interfaces with an external system. You can 
configure a Notify action to produce an XML file, and you can also use it to invoke a 
Web service.

origin action

An origin action is a specific type of action, which must be used to start a workflow. A 
workflow without an origin action as its first action is not properly designed, and 
cannot be activated. The origin actions are Watch and Receive.

Original nickname

The media nickname Original is a reserved nickname that is typically assigned to media 
files in a workflow by the origin action.
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See media nickname.

Populate action

A Populate action uses the Metadata service to transform data between variables and 
metadata labels, and publish variable values from the label for use in downstream 
actions.

Process MMF action

A Process MMF action (which is executed by the Agility service) processes an 
attachment as an MMF file and generates variables from it.

qualification rule

A qualification rule influences or controls the routing and execution of actions among 
Vantage services of the same type in a distributed Vantage domain. Qualification rules 
can be used to ensure that jobs are routed to services that are best suited for the task. 
Vantage uses values contained in variables to determine the suitability of a given 
service to execute the action.

Qualification rules are exclusively based on variables; they are not based on any actual 
machine analysis. As a result, it is up to the system administrator to correctly set up 
variables and qualification rules, and apply variables to the appropriate actions to 
ensure that jobs are routed correctly.

Qualification rules are created and managed in the Vantage Management Console: 
Services.

See also run on rules.

Receive action

A Receive action is an origin action which is implemented in every service. Receive 
actions are designed to receive output from other workflows. This output can be 
automatically submitted from a previous workflow using the Forward action. Output 
can also be manually submitted by an operator using VWP.

See Forward action.

Register action

A Register action uses the Catalog service to place a binder into a Vantage catalog. 
Register actions can be executed on any action state.

See also Vantage catalog.

resource cost

A resource cost is an integer value, implemented in the Vantage Management Console 
on each action type to specify a relative computer resource consumption value in 
relation to all other action types. This value enables Vantage to maximize resources and 
optimize transactions, so that you can tune your Vantage system for the highest 
possible throughput on your particular hardware.

run on rules

Run on rules are rules that you specify on a given action, to qualify which services have 
the characteristics that enable them to execute this action. Rules are set up by 
specifying variables which have been bound to a given Vantage service and values set. 
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After configuration, the action can test each rule by comparing its run time value to the 
value in the service’s copy and determine if there is a match before attempting to 
execute it. 

See also qualification rule.

Staging service

The Staging service is the Vantage component which executes Archive actions and 
Gather actions.

service

See Vantage service.

Synchronize action

A Synchronize action, which is implemented in every service, is a connector action, for 
the sole purpose of uncluttering workflow connectors. In workflows where there is a 
many-to-many relationship (for example, 6 Flip actions connect to 6 Deploy actions, 
which connect to 6 deletes), instead of drawing all six connects from each action, you 
can simply connect them to a common Synchronize action. There is no inspector for 
the Synchronize action, because no configuration is required.

Team Management

Team Management is a licensed feature that enables Vantage user access control. By 
creating specific Vantage users (and optional passwords) in the Vantage Management 
Console, Vantage administrators can control access to workflows in Vantage Workflow 
Designer and VWP. The Vantage administrator can also control access to the Vantage 
Management Console, thus limiting who can configure and control the Vantage 
domain.

transcode 

Transcode means the process of decoding media in one format (MPEG2, for example) 
down to digital baseband and then encoding it in another media format (MPEG4, for 
example). 

Transcode service

The Transcode service is the Vantage component that executes Flip actions—
transforming media from one format to another. 

See Flip action.

Transform action

A Transform action uses the Metadata service to transform metadata between XML files 
(attachments) and labels. XSL style sheets are used to perform these transformations; 
style sheets can be managed in the Vantage Management Console: Workflow Design 
Items > Style Sheets.

Transport service

The Transport service is the Vantage component that executes the actions relating to file 
operations.

See also Move action, Delete action, Copy action, and Deploy action.
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Vantage catalog

Similar in concept to the folders in a file system, a Vantage catalog is a container that 
stores binders. Catalog folders are subcontainers that organize binders. To access a 
binder, VWP operators search through the visible catalogs and folders, just as they 
might sort through folders in a file system.

Vantage domain database

A Vantage domain database is a Microsoft SQL Server database which contains all 
workflows, actions, jobs, binders, licenses, and configuration information for a Vantage 
domain.

Vantage domain

A Vantage domain is a collection of computers, Vantage workflows, actions, Vantage 
services, jobs, binders, and configuration settings, all known to and interacting with 
each other, stored in a Vantage domain database. This collection constitutes a Vantage 
domain. Vantage domains may exist on a single computer or they may be distributed 
across many computers for durability and scalability.

The name of a Vantage domain is the same as the name of the server that hosts the 
Vantage domain database.

Multiple Vantage domains may exist on a network, but they are independent entities 
that do not communicate with each other. They are not bound together and do not 
share resources or work. The purpose of storing an entire domain in a database is to 
provide an easy way to create and manage the domain and to provide access to all the 
details about each resource in the domain to any other resource that needs it.

Vantage EDL nickname

The media nickname Vantage EDL is a reserved nickname that is typically assigned to 
output media files that are created to support the addition of an Edit Decision List in 
VWP.

See media nickname.

Vantage folder address

A Vantage folder address is an alias to a local or remote file folder. You can create and 
manage Vantage folder addresses in the Vantage Folder Address Book dialog, in Copy 
and Move actions in Vantage Workflow Designer, and in the Vantage Management 
Console.

After you create a Vantage folder address, you can specify the destination directory in 
any workflow simply by selecting the Vantage folder address. Changes to a Vantage 
folder address—such as updating an IP address or a password—immediately affect all 
workflows that use that Vantage folder.

Unlike Vantage stores, temporary files that are created during workflow execution are 
not automatically deleted from Vantage folders according to job expiration settings. 

Vantage Management Console

The Vantage Management Console enables Vantage system administrators to effectively 
configure Vantage domains, and scale domains across multiple servers to meet their 
operating requirements and perform effectively in their environment.
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Vantage Proxy nickname

The media nickname Vantage Proxy is a reserved nickname that is typically assigned to 
output media files that are intended for viewing with the media viewers provided in 
Vantage programs such as VWP and Vantage Management Console.

See media nickname.

Vantage service

The term Vantage service refers to the collection of software components in a Vantage 
domain that implement and execute the actions in a workflow as it executes.

Vantage store

A Vantage store is a directory on a Windows file system that stores temporary files. 
Stores are managed by the Vantage domain for the purpose of centralizing large 
directories for reading and writing files. Unlike a Vantage folder, temporary files placed 
in a Vantage store are deleted when the binder is deleted. Vantage stores are generally 
used to hold temporary files for the duration that a job is executing.

Vantage stores are managed in the Vantage Management Console: Storage. Services 
that create temporary files, such as the Transcode service, can be configured to use 
specific stores.

Vantage Thumbnail nickname

The media nickname Vantage Thumbnail is a reserved nickname that is typically 
assigned to output media files that are created to display thumbnail images instead of 
binder names in Vantage programs such as VWP.

See media nickname.

Vantage Workflow Designer

Vantage Workflow Designer is a client program that enables you to create and edit 
workflows, activate and deactivate workflows, monitor job status, and review and 
delete jobs that have completed.

Vantage Workflow Portal

VWP is a client program that features a customizable set of functionality to support 
various operator-related tasks: selecting media and submitting jobs, updating variables 
and metadata, forwarding jobs, creating EDL-based jobs, etc.

Customization is implemented in the Vantage Management Console, when Vantage 
administrators construct the user interface and functionality they want for a given task, 
then save it. When operators launch VWP, they select the configuration appropriate to 
the task at hand, and VWP dynamically implements the appropriate user interface from 
the configuration file.

variable

A variable identifies temporary job metadata. Variables have a name (such as Number of 
Audio Channels), a type (such as Integer Number) and a default value. Variables values 
can be set inside a job in a variety of ways: through analysis, through metadata 
population, in the Watch and Associate actions, as a property of an action, or by a 
service as it executes an action.
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Variables are used by Vantage services and actions to control workflow execution. The 
majority of parameters in Vantage can be bound (or attached) to variables, allowing the 
workflow to dynamically update on a job-by-job basis. 

For example, a variable may be assigned a value by an Analysis action to determine 
how many lines of black are at the top of a video frame; a crop filter later in the 
workflow can bind to that variable, ensuring that every crop in every job is appropriate 
to the workflow requirements.

Variables in services may be also be used for job routing. For example, an action with a 
FibreRequired=TRUE variable must pass this condition to a service which evaluates the 
condition to determine if it can successfully perform the action.

Variables can be created in Vantage Management Console (Workflow Design Items > 
Variables) or in Vantage Workflow Designer, and assigned for use in workflows and 
services.

Watch action

A Watch action is an origin action; it uses the Monitor service to regularly poll a target 
location (a directory, for example) on a device or file system (FTP, Windows network 
folder, etc.) to discover new files.

When a new file is discovered, the Watch action submits a job for the workflow which it 
is part of, for processing the file—typically, a media file.

Web Dashboard

The Web Dashboard displays important domain information from anywhere on your 
network in a Web browser. The Web Dashboard is installed on the IIS server on your 
Vantage domain database server. The Web Dashboard is enabled by the Enterprise 
Control and Master Control licenses.

workflow

A workflow in Vantage is a set of actions designed to perform an automated process. 
Vantage workflows are created using the Vantage Workflow Designer by adding and 
configuring actions and connecting them together. Workflows are stored in the 
Vantage domain database, and executed by Vantage services.

Workflow Portal

Short for Vantage Workflow Portal.

Workflow Designer

Short for Vantage Workflow Designer.
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Index
A
actions

adding to a workflow 111
binding settings to a variable 121
changing description of 118
configuring, generally 116
connecting together 112
copying 112
deleting 112
invalid connections 113
re-ordering 115
setting conditional execution 118
specifying resource cost for 126
state colors on Job Status tab 147
states of 128
templates 111
templates for, creating 115
toolbar display options 104
uncrossing connection lines 115
using variables with 118
viewing status 157

Agility actions 132
starting and stopping 148

Analysis service actions 133
Archive action 139
assets

forwarding to a workflow 188
previewing 181
searching and selecting 177
stitching 185

Associate action 138
auto-arrange, disabling temporarily 104

B
batch operations, performing on 

workflows 110
binders, viewing 155
binding settings to variables 121
bottleneck analysis, performing 161
browsers, supported by Job Status 

Views 40
Browsing Windows Assets mode 169
browsing Windows folders/shares 190

C
catalog

browsing 179
selecting 179, 180

Catalog service actions 134
category

creating new 106
deleting 107
renaming 107

color of jobs 147
common actions 134
Communicate service actions 136
Compare action 134
Compute action 135
conditional execution of actions, 

setting 118
connecting to a Vantage domain

client applications 32, 43
unlisted domains 33, 43
using Workflow Designer 53

connection lines, uncrossing 115
context menu, for Action toolbar 104
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Copy action 139
copyright notice 3
CSV file job reports 150

D
Decide action 135
default

user name 45
default password 45
Delete action 140
Deploy action 140
Domain Job Status tab, Workflow Design-

er, generally 145
domain. See Vantage domain

E
EDL, adding assets to 186
Encode action 139
errors 196
Examine action 134
execution analysis, performing 162
Exist action 134
exporting

job reports 150
workflows 109

F
Flip action

pause for priority 157
pausing and resuming 156

Folder Address Book 130
Forward action 136

G
Gather action 139
grid lines, showing/hiding 102

I
Identify action 134
importing workflows 110
inspectors, using, generally 116

J
job reports

creating 151
exporting 150
generally 150

job state, colors to indicate 147
Job Status tab, Workflow Designer

generally 145
Job Status Views

described, generally
logging in 41
starting 41
URL for 42
version info 48
Web browsers used for 40

job submitting, manually 148

L
license, changing / updating in Workflow 

Designer 37
logging in to a Vantage Domain in Work-

flow Designer 31
logging in to Job Status 41

M
manual job submission 148
manually connecting to a domain 32, 33, 

43, 53
mark in/mark out points, setting 187
media, previewing 181
MediaMate actions 137
Message action 137
Metadata service actions 137
metadata, editing in submit jobs 

window 188
modes in Workflow Portal 166
Monitor service actions 138
monitor status tab, generally 141
Move action 140
MPEG disclaimers 4
Multiscreen Flip action 138
Multiscreen service actions 138

N
nickname view 100
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Notify action 137

O
opening binders from a Vantage 

catalog 179

P
password, default 45
pause for priority, in Flip actions 157
pausing Flip actions 156
Populate action 137
previewing assets 181
public and private views 201

R
Receive action 136
Register action 134
resource costs, specifying 126
resuming Flip actions 156

S
settings, binding to variable 121
specifying resource costs 126
Staging service actions 139
starting and stopping Workflow 

Designer 30
starting Job Status 41
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creating an EDL 185
mode 168

submit jobs window, editing metadata 
in 188

support, obtaining 17
synchronize action 136

T
tech support, obtaining 17
Telestream

contacting 7, 17
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International 17
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technical support 17
Web site 17
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Transcode service actions 139
Transform action 137
Transport service actions 139
troubleshooting 196

U
uncrossing connection lines 115
URL for Job Status Web app 42
URL for Job Status Web application 42
user access

default user name 45
entering username and password 53
Vantage domains 31

V
Vantage

account 53
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Job Status Views Web application. See  
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flow Designer 37
user password, changing in Web 

applications 47
user password, changing in Workflow 

Designer 37
user, changing in Workflow 

Designer 31
Web site for 17
Windows programs, starting and 

stopping 30
Workflow Portal Web application. See 

Workflow Portal
Vantage domain

changing 31
connection settings 34, 44
manually connecting 32, 33, 43, 53
select using computer name or IP 

address 33, 43
selecting, in Workflow Designer 31

variables
adding to a workflow 119
binding to settings 121
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using for decision making 129
view 100

version information 48
views, public and private 201
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W
warranty 5
Warranty and Disclaimers 5
Watch action 138
Web

browsers, supported by Job Status 
Views 40

Job Status Views application. See Job 
Status Views

Vantage Web site 17
Workflow Portal application. See  

Workflow Portal
Windows folders/shares, browsing 190
workflow

activating 106
adding actions 111
batch operations 110
category. See category
centering 103
centering in workspace 102
creating new 108
deactivating 106
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design techniques, generally 97
details panel, using 99
duplicating 109
editing 106
exporting 109
forwarding to 188
importing 110
moving in workspace 102
moving to another category 109
printing 110
releasing 106
renaming 108
status buttons 105
zooming in and out 102, 103

workflow analytics
configuration panel 159
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performing bottleneck analysis 

with 161
performing execution analysis 

with 162

Workflow Designer
changing / updating license via 37
logging in to a domain 31
starting and stopping 30
submitting jobs manually 148

Workflow Portal
described, generally 164
desktop shortcut 31
launching first time 30, 31
modes of 166

Z
zooming a workflow 102
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